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Preface

1. Give us Feedback

If you find a typographical error, or know how this guide can be improved, we would love to hear
from you. Submit a report in JIRA against eXo Content. The following link will take you to bug report
for eXo Content http://jira.exoplatform.org [http://jira.exoplatform.org/secure/Dashboard.jspa].

Select the document name and version number relevant to the document you found the error in
from the available lists then complete the description with as much detail as you can provide.

Be sure to give us your name so that you can receive full credit for reporting the issue.



http://jira.exoplatform.org/secure/Dashboard.jspa
http://jira.exoplatform.org/secure/Dashboard.jspa
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Chapter 1.

Overall Introduction

1.1. Overview

Beginning as an Open Source project in the year 2002, eXo is well-known as the industry's first
Java portlet container. With the aim of dominating the potential portal market through robust and
easy-to-use applications, eXo Project has succeeded in attracting consumers in the whole world.
eXo has actually opened the floodgates to various options in many markets, and customers have
been choosing eXo as the best method for their success.

The eXo Platform™ software is a powerful Open Source that corporates portal and content
management system. Users of the platform have a customized single point of access to the
company's information system and resources.

eXo Platform 3.0

v | s |

eXo Extended Services

The foundation for eXo Platform 3.0 is eXo Core Services, a powerful set of REST-based
services for rapid website development, content management and gadget-based development.
eXo Extended Services are also a part of the eXo Platform 3.0, running on the top of eXo Core
Services to enable easy development of rich, user-centric web applications.

eXo Content is one of eXo Core services. It provides a set of services to extend portal-based
applications with Enterprise Content Management (ECM) capabilities. Document Management
System (DMS) features make it easy to catalog and organize enterprise content and with powerful
Web Content Management (WCM) services to quickly build dynamic, content-rich websites.

1.2. Why Use eXo Content

If you are looking for a powerful tool and strategies in managing website and contents, eXo Content
is what you need. eXo Content is designed to provide webmasters who manage websites the
way to maintain, control, modify and reassemble the content of a web-page easily and effectively.
All components of your website can be organized, reconstructed easily, which helps you keep
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your website under the control. eXo Content really brings interesting experience for all users and
changes their way of thinking about website. The followings are key features of eXo Content:

Website Creation

Fast Setup:
Set up a new site in just a few clicks with an intuitive user interface and template features.

Navigate, Preview and Publish Content:
Navigate through page content in either a single content viewer or the list content display,
quickly preview page content or work on new content in draft mode and publish at anytime.

Templates:
Create websites from existing templates and themes, or create new templates with a
consistent look-and-feel across a single site.

In-Site Edition
The integrated rich text editor enables non-technical users to edit the pages they are in charge
of in an intuitive way.

Web Content Organization

Web-Based Administration:
Use a web browser to manage sites remotely, no local administration software is required.

Manage Multiple Websites:
Manage and control every site in one place.

Media Library:
Upload media to the library, publish, reuse and update all available media content across
multiple websites.

Content Search:
Search content and documents using categorization and tag features.

Broken Link Detection:
Know how many broken links are present and how many are functional with ease.

Versioning and Rollback:
Easily rollback a website's content with automatic versioning.

SEO and Friendly URLSs:
Search Engine Optimization (SEO) is simplified for editing meta tags and more. Content has
its own specific URL for easier bookmarking and improved SEO.

Configuration for Deployment on Web Farms:
Advanced deployment rule for scalable, three-tier web application architecture with partitioned
replicated deployment.
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Capture and Manage Documents

Kofax Plugin:
Collect paper documents, forms, invoices and other unstructured documents and convert into
accurate and retrievable information, stored in the eXo JCR.

Access Control List:
Access Control List: Validate the current session's permissions to add nodes, set properties,
remove or retrieve items. Define actions to launch the next step in a process, or to invoke
any "coded" action required.

Workflow:
Specify processes for document collaboration and validation.

Record Management:
Track the status of content completion and control document storage life-cycles.

Store and Access Documents

JCR:
eXo JCR allows applications to access or manage files independent of their location, and also
provides advanced features such as unified access control, versioning, indexing and more.

Automatic Backup:
Define and automate tasks to save documents as required.

Web Interface:
Access documents in an intuitive and user-friendly web interface.

Microsoft and OpenOffice Plug-ins:
Microsoft and OpenOffice plug-ins give users the freedom to work on documents in their
preferred document editing program.

And More... eXo Content also provides other powerful tools to manage an build content-rich
websites such as CSS, Java Script and RSS support, advanced document management tool,
collaboration tools, etc. All features is to meet your requirements for the purpose of easy site
management, cost reduction in managing multiple sites in only one place.

1.3. About This Document

The intended reader of this user guide are users using eXo Content. This guide will explain all the
basic and advanced features that eXo Content provides in managing websites and site content.
It gives in-depth examples and easy explanations of the technology that allows the webmasters
to create and manage a very fast and powerful website.

With this guide you will:
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« learn the basic terminologies used in eXo Content.
« know how to create, manage and publish Site content.
« know how to manage Web pages, set up a website, etc.

In this guide, we will use the following accounts (username/ password) throughout the guide:

e root/ gtn: This account is for users as Administrators who have the highest right on the platform.

e mary/ gtn: This account is for a publisher who can write contents but also can create new pages
or edit them in the current site.

1.4. References and Related Sources

Information

« eXo Home Page [http://www.exoplatform.com/]

» eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/]

Support

» Forums [http://forums.exoplatform.org/]

* FAQs [http://fag.exoplatform.org/index.html]

Downloads

» eXo Content [http://www.exoplatform.com/company/public/website/platform/exo-core-services/
exo-content]

» eXo Development Tools [http://www.exoplatform.com/company/public/website/platform/exo-
core-services/exo-development-tools]

e Gatein Portal Framework [http://www.exoplatform.com/company/en/platform/exo-core-
services/gatein-portal-framework]

» eXo Collaboration [http://vww.exoplatform.com/company/public/website/platform/exo-
extended-services/exo-collaboration]

« eXo Knowledge [http://www.exoplatform.com/company/public/website/platform/exo-extended-
services/exo-knowledge]

e eXo Social [http://www.exoplatform.com/company/public/website/platform/exo-extended-
services/exo-social]
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References and Related Sources

Resource Center

« Video demos, tutorials, webinar archives, features and benefits tables and more [http:/
www.exoplatform.com/company/public/website/resource-center]
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Chapter 2.

Product Introduction

2.1. eXo Content

eXo Content is the technologies used to Capture, Manage, Store, Preserve, and Deliver
content and documents. It especially concerns content imported into or generated from within an
organization in the course of its operation, and includes the control of access to this content from
outside the organization's processes.

The eXo Content users can manage both structured and unstructured content, so that an
organization, such as a business or a governmental agency, can more effectively meet business
goals (increasing the profits or improving the organizational process with efficient use of budgets),
serve its customers (as a competitive advantage, or to improve responsiveness), and protect
itself (against non-compliance, law-suits, uncoordinated departments or turnover within the
organization).

eXo Content improves your operational productivity and efficiency. It enables you to transform
unstructured content into structured content through the process of capturing, storing, managing,
preserving, publishing and backing up while securely distributing it. The eXo Content portlet gives
you a portal solution that can help you achieve these processes and leverage your business
content across all formats for competitive gain. It also provides an environment for employees to
share and collaborate on digital content and delivering a comprehensive unified solution with rich
functionalities. Every component of your website can be organized, reconstructed easily, which
helps you keep your website under control.

eXo Content consists of three parts:

Document Management System (DMS) - an extension of eXo Content is used to store, manage
and track electronic documents and electronic images and allows documents to be modified and
managed easily and conveniently by managing versions, properties, and more.

Workflow: is the way of looking at and controlling the processes presented in an organization
such as service provision or information processing, etc. It is an effective tool to use make certain
that the processes are effective with the purpose of better and more cost efficient organization.

Web Content Management (WCM): helps in maintaining, controlling, changing and reassembling
the content on a web-page. It also helps webmasters who handle all tasks needed to run a website,
including development, design, content publication and monitoring.

2.2. Site Content Structure

Creating a site is a quick process, but deciding what content to put in the site and how to organize
it will take a lot of time. Thus, to mange a site more easily and more effectively, a site always has
a specific structure as follows:
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Site Content

C55 Documents

&
o

Links Media Web Contents

ALz Irmages Videos

The Site Content are stored in collaboration workspaces of Java Content Repository (JCR).

Details:

CSs
This file is used to define the presentation of your entire site, such as font, color, size and more.

Documents:
All documents, which are used in a site will be stored in this folder.

JS

A programming script used on the site. This file is used to make a web page more animate
and dynamic in terms of graphics and navigation.

Links:
This folder stores all links used in the site.

Media:
This folder includes three sub-folders:

Audios:
Store all sound files used in a site.

Images:
Store all images, pictures used in a site.

Videos:
Store all video files used in a site.

Web content:
This folder is used to store the documents which present main content (texts images,
hyperlinks, audios and videos) of the site.




Web Content

2.3. Web Content

2.3.1. Web Content

Web Content is the textual, visual or aural content that is encountered as part of the user
experience on a website. It may include other things such as texts, images, sounds, videos and
animations.

2.3.2. Web Content Structure

The Web content may include various elements. Thus, to create and manage the Web content
more effectively and dynamically, each Web Content also has a specific structure:

Main content:
It contains all key content such as: texts, images, links, tables, etc.

lllustration:
It contains an image that is used as an illustration for the content. Additionally, a summary
also can be added to come with this image.

default.css:
It contains CSS data which is used to present the web content such as: layout, font, color,
and more.

default.js:
It contains JS data which is used to make web content more animating and dynamic.

2.4. Terminologies

2.4.1. Repository

A repository is a place where contents are stored and maintained. The content repository is:

» A place where contents are stored.
« A place where digital data are stored.

« Accessible to the user without having to travel across a network.

2.4.2. Workspace

A content repository is composed of a number of workspaces. Workspace is a term used by
several software vendors for applications that allow users to exchange and organize files over the
Internet. In our case, the content repository consists of more than one workspace. The “repository”
repository contains multiple workspaces, including : system, backup and collaboration workspace.
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System workspace:
is used to reserve “system folders”.

Backup workspace:
The backup process depends on the published content timestamps, each published document
has a duration for which it can be published and when it exceeds the timestamps, it will be
automatically archived to the backup database. This workspace is mostly used when using
the Workflow based content publication life-cycle.

Collaboration workspace:
Allows users to validate and manage documents. This is the central place to store and edit
contents and media.

2.4.3. Drive

A drive can be understood as a shortcut in the content repository. It enables administrators to limit
visibility of each workspace for groups of users. It's also a simple way to hide the complexity of
the content storage by showing only the structure that makes sense for Business users.

More specifically, a drive consists of:

 a configured path where the user will start when browsing the drive.

a set of allowed views that, for example, will allow to limit the available actions (such as the
edition or creation of content while being in the drive).

 a set of permissions to limit the access (and view) of the drive to a limited number of people.

 a set of options to describe the behavior of the drive when users browse it.

2.4.4. Node

A node is an abstract basic unit used to build linked data structures, such as linked lists and trees,
and computer-based representation of graphs. Nodes contain data and/or links to other nodes.
Links between nodes are often implemented by pointers or references.

A node can be defined as a logical placeholder for data. It is a memory block which contains
some data units, and optionally a reference to some other data, which may be another node that
contains other data. By linking one node with other interlinked nodes, very large and complex data
structure can be formed.

2.4.5. Version

Versioning means that at any given time the node's state can be saved for possible future recovery
and the action of saving called ‘checking in'. A workspace may contain both versionable and non-
versionable nodes. A node is versionable if it has been assigned a mixin type mixin:versionable;
otherwise, it is a non-versionable node. A version exists as a part of a version history graph that
describes the predecessor/successor relations among versions of a particular versionable node.

10
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A Node

Version 1

Wersion 2
(Base Version)

Software versioning is the process of assigning either unique version names or unique version
numbers to unique states of computer software. Within a given version number category (major,
minor), these numbers are generally assigned by increasing order and correspond to new
developments in the software. At a fine-grained level, revision control is often used for keeping
track of incrementally different versions of electronic information, whether or not this information
is actually computer software.

2.4.6. WebDAV

WebDAV stands for Web-based Distributed Authoring and Versioning. It is a set of extensions
to the Hypertext Transfer Protocol (HTTP) which allows users to collaboratively edit and manage
files on remote World Wide Web servers.

The protocol was to make the Web a readable and writable medium. It provides functionality to
create, change and move documents on a remote server (typically a web server or "web share").
This is useful for, among other things, authoring the documents which a web server serves, but
can also be used for general web-based file storage that can be accessed from anywhere.

2.4.7. Podcast

A podcast is an audio file that you can download and listen to on your computer or a portable
MP3 player such as an iPod. The word itself comes from the combination of two other words:
iPod and broadcast.

2.4.8. File Plan

The file plan is the primary records management planning document. Although file plans can differ
across organizations, their typical functions are to:

» Describe the kinds of items the organization acknowledges to be records.

11



Chapter 2. Product Introduction

Describe what broader category of records that the items belong to.

Indicate where records are stored.

» Describe retention periods for records.

Delineate who is responsible for managing the various types of records.

2.4.9. Symlink

Symlink is a special file containing a reference to document or folder. By using symlinks, you can
easily access specific nodes (target) that symlinks point to. In Content Explorer, a symlink has a
small chain symbol next to its icon:

==

Documents.Ink

12
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Get Started

3.1. Account

3.1.1. Register an account

To register a new account on the portal, do as follows:
Procedure 3.1.

1. Go to the portal by inputting the URL in the address bar (e.g: http://localhost:8080/portal/
public/classic).

The anonymous homepage will appear:

D tam I e — wary metty  [Byblited) &

exo

__eXo WCM

Community Members: ! Enterprise or Production Use?
¥ Download eXo WCM Documentation k Try eXo Platform 3

Mew b g WOMT B —
Watth the Grsng Harked Gude, or sk espioring wime of the key depuray u lul
] Canlail B Babsuiie

bisad pimissis Jisk ACDicES BT 9547 afia i a0 Dk and L g saarch Susad e

o
= |
ce 2 =

2. Click the Register link on the top of the site, the Register form will be displayed:
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» Account Setting | » User Profile |

User Name:

Password:

Confirm Password:

Last Name:

I
I
|
First Name: |
|
Email Address: |

Save Resel

(*) required

The Account Setting information includes:

Table 3.1.

Field Information

User Name The user name that is used to login into the
system. It must be unique. The user name
must be started with a character.

Password The security characters are used to login. It
must have at least 6 characters.

Confirm Password The re-typed password above. The
password in Password field and this field
must be the same.

First Name Your first name

Last Name Your last name

Email Address Your email address. It must have a right
format: user nane@bc. com

3. Input values for the fields in this form.

Click the ™ icon to search and check if the inputted user name is available or not.

5. Inputvalues in the fields of User Profile tab, including: Profile information, Home information
and Business information.

14



Sign In

b Account Settng | ~ User Profie |

Giver Name: |

Family Mame: |

Mick Marme: |

:

Birthday: |
Gender: |Mu}e I.Q -

|G Business Info

Errplayer: | | 3

Department: | |

Job Trte: | | e

Langusge | Englsh ] g

6. Click Save to register a new account, or Reset to renew all inputted values. There is an
alert message, and you cannot add a new account successfully if at least one of these cases
occurs:

* User name is existing or invalid.

» Password has less than 6 characters.

» Password and Confirm Password are not the same.
« Email Address has invalid format.

* Required fields are empty.

After adding a new account, contact with the administrator to get the confirmation.

3.1.2. Sign In

This function enables you to go into eXo Platform in the private mode.

15
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Procedure 3.2. Sign in

1. Gotothe eXo Platform in the public mode by inputting the URL in the address bar (e.g: http://
localhost:8080//portal/public/classic/).

2. Click the Login link at the top of the home page. The Sign in form will appear:

Sign in

User name | & I
Password |

[F] Remember My Login

| Sign in ]| Discard

3. Input your registered User name and Password.

4. Click Sign in to accept, or Discard to exit from the Sign in form.

Table 3.2. Options

Option Information

User name To input the registered username.
Password To input the password of your username.
Forgot your User Name/Password To retrieve the forgotten user name or

password when you forget.

Sign in To sign into the eXo Portal with the inputted
user name and password.

Discard To close the Sign In form without any
changes.

If the User Name does not exist or the inputted User name/Password is invalid, there will be
an alert message that requires users to input right values. The page will be redirected to the
private security checking mode.

To login again, enter User Name and Password again.

After signing in, you will be redirected to the authenticated homepage like the illustration.

16
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Sign Out
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DOCUMENTS

T Where we are

Lorem psum dokor si amet Zaf e oo
Welcome consecietuer adipiscng el

Bl Condimons and Requiremenis
Lorem dnlor SEipsum amet  z=ipsizocs
consecisiuer adpesong eld

Hiow 10 join us
Consscigluer adipecng el srpesoos
" i1 kT i SER L . I al, . bk ifesum Golor s amet
= o1 - 1 EH, 5 1smad 18 =1 mesd - o [ T t sed 00 EISmos - funt
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1 LATEST NEWS [
*ﬂ :I. i ,. .:": I.. i t al . I .. 1 - . funt t- ACHE News 1
= i | " . ) gl g b ol dokee man Y ' - ¢ Lorem ipsum doki si amel,
- — “'L . - ! . "u‘ consecnen adipisicing ol

sed do eusmad tempor ncididumt ot
Isbore =t dokoes magna alqua

ACHE Hews 4
24 ! Lorem ipsum dukor sit amel,

COMPANY NEWS ' consacietul adipiEicng e,
d 5o 40 RUSMA EEP0T Rtk ot
Iahare et dokes magna aliqua

3.1.3. Sign Out

The function lets you get back to the anonymous portal. It ends your current portal session.

To sign out, click the Logout link on the right access banner:
m:m@

or click Start Logo — Sign Out from the menu:
5:} Hie | i Geoep Biaboasd g Se G P b i

3.1.4. Retrieve user name/password
If you forget your account or password, you can recover them by doing as follows:

Procedure 3.3.

1. Click the link Forgot your User Name/Password? in the Sign in form.

This form offers two options:
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Chapter 3. Get Started

Why are you are not able to login ?

We apologize for any inconvenience you're experiencing by not being able to access this website,
To resolve this issue as quickly as possible, please follow the troubleshooting steps below,

1. Recover your password: enter your username then dick send.
2. Recover your username: enter your email address then dick send.

9@ Forgot my password
Fargot my username

[ Next ][ Back ]

Forgot my password:
If you forgot your password, you need to select this option.

Forgot my username:
If you forgot your username, you need to select this option.

2. Select one of these two options in this form. The selected option will be shown:

If the Forgot my password option is selected the form to recover the password appears:

Forgot User Name/Password

User name : =

If the Forgot my username option is selected, the form to recover the user name appears:

Forgot User Name fPassword
Email : "

send || Back

3. Enter your username or email in the corresponding form.

4. Click Send to send the inputted values.

18



Change account information

Once information has been sent, you will receive an email with your User name/ Password
in your email address that you registered.

« If you forget User Name: when a username is retrieved, your old username is restored and
can be reused and a new password is also sent to your email with the old username.

« If you forget old password: a new password will be set (as temporary, then you will be
directed to change the password for the next time you sign in).

3.1.5. Change account information

The function enables you change your account information, such as your profile and password.

Procedure 3.4.

e The first thing to do is to directly click your own account name.

0 Mo U Qo wehiaard g Sbe K Tebinted

The Account Profiles tab will appear:

Account Profiles B Change Password

User Name : |0t

First Name - | Root

Last Mame : |R00t |.

Email - |r00t@lacalhast | =

[ Save H Reset ]

Close

Procedure 3.5. To Change Account Profiles

1. Select the Account Profiles tab.
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Chapter 3. Get Started

This tab displays your current basic information.
2. Change your First Name, Last Name and Email. You cannot change your User Name.

3. Click Save to accept changes.

Procedure 3.6. To change your Password

1. Select the Change Password tab.

{(m'}

[ Account Profiles = Change Password
Current Password : =
Mew Password : =
Confirm New Password : =
| Save l Reset
Cloge

2. Input your current password to identify that you are the owner of this account.
3. Input your new password, it must have at least 6 characters.
4. Input your password again in the Confirm New Password field.

5. Click Save to accept changes.

3.2. Change the display language

The priority order of display language is shown to the following order:

1. User's language
2. Browser's language

3. Portal 's language.
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Change the skin of the current site

Thus, to display your preferred language, you should pay attention to this order to change the
language type appropriately.

1. Move the mouse over Start Logo —» Change Language on the top left corner of the portal:

5} — s fiTeaey Dasbbd 5 B Gl L Publinfed -
[ ECTON
The Interface Language Setting form appears:

Interface Language Setting

Arabic agell [
Chinese - China gir - hfE
Chinese - Taiwan oL - &8
Dutch MNederlands

« English
French Frangais -
German Deutsch
Italian Iraliano
Japanese Btk "

Apply l Cancel

2. Select the another language in the list. The currently selected language will be marked with

the ¥ icon.

3. Click Apply to change the display language temporarily, and wait few seconds to take effect,
or click Cancel to quit without any changes.

3.3. Change the skin of the current site

The eXo skins are attractive user interface styles for displaying a portal. Each skin has its own
characteristics with different backgrounds, icons, and more. Changing the skin of the current site
can make use of the portal easier and more effective.

Procedure 3.7.

1. Move the cursor to eXo > Change Skin item in the drop-down menu:
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u—_lme

1), Group | ¢y Dashbosd (@ Group Editor Lty u..u,

“ Charge Lasgiiage
1 Changs Skin
o

The Skin Setting form appears.

Skin Setting

slﬁﬁl.irt ‘ﬁewandseiecuslﬁn
hhmsmm

|_aeply || cancel |

2. Select the skin you want by clicking its name.
3. Click Apply and wait a few seconds to take affect.

These actions can be done by users who have the right to use the administration bar with a
personal preferences menu.
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Basic Actions

These actions are for all registered users after they have logged in the accounts.

4.1. Print content

Users can easily print any content in a site by following these steps:

1. Click Read more to read all the content of a document or of an article in a site.
COMPANY NEWS
ACME News 1

Aug 21, 2009 3:55:11 AM by ool rool
Lorem ipsum dolor sit amed. consectetur adipisicing efit. sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.

Read mare
ACME Mews 2
Aug 21, 2009 3:55:44 AM by root root
Lerem ipsum dolor sit amet, consectetur adipisicing eft, sed do eitsmod tempor incididunt ut labere et dolore magna aligua.

Reaad mare
ACME News 3
Aug 21, 2009 3:56:17 AM by root root
Larem ipsum dolor £E amet, consectaiur adipisicing eit, sed do elusmod femgor incldidunt ut labore of dolore magna akqua.

Read mare

2. Click the Print button. The Print Preview page will be displayed on another tab.

3. Click Print to print the content of this page, or Close to close this tab without printing.
4.2. Manage a site

4.2.1. Create a new site

This function enables you to create a site (portal) to meet your own needs.

Do the following:

1. Click Site on the administration bar. A list of existing portals is listed.
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D T Site Group " Dashboard g7 Sfe Editar Aol Ron Pubisned T
J\. o Wiskome: o
click ! : L

Mews Evenis  Mewslkefies  Contcr Us

— oiF

T preee o EdN Loyt g Edi Mavigation i EdiForidsCom @@ Dokl
2 classic S Edt Laysut " Edi Mavigetion " Edd Foriel= Comg
L = ' W
1 A s Portal .
exlating aites . click

Powered by =Xo WG - Copsenght @ 2000- 2008, A1 nghis Reserved, =Xo Plabom 545

2. Click the Add New Portal button to open the form to add a new portal.

In the Portal Setting tab, set some properties for this site, including the portal name, locale
and skin.

- Portal 5etting Ir Properties "r Permission Setting ] Enter PDrtaI Na me

Portal Name : Iexo I'
Locale © | Epglish o=
skin > | pefault =

| Save || Cancel

Table 4.1. Details:

Field Information

Portal name The name of the portal. This field is required
and must be unique. Only alphabet, numbers
and underscore characters are allowed. The
Portal name must be at least 3 characters.

Locale The interface language of the portal. This
field is required.

Skin The skin of the portal.

3. Select the Properties tab to keep session alive.

The Keep session alive option means keeping the working session for a long time to avoid
the working time out. There are 3 options:

never:
The session never happens even if the application requests.

24



Create a new site

on demand:
The session starts to be used as soon as the application requests.

always:
The session is always enabled.

| » Portal Setting Iv Properties I » Permission Setting

Keep session alive : [{)n Demand "

Select the Permission Setting tab to set access and edit permission for this portal.

The Permission Setting tab includes two sub-tabs: Access Permission Setting and Edit
Permission Setting.

[v Portal Setting "r Properties | » Permission 5Setting |

@ Access Permission Setting \g Edit Permission Setting
v

Check this box

Make it public (everyone can access):
Group Id Membership Type Action

Empty data

&F Add Permission o= Click

[ Save ” Cancel |

Access Permission Setting tab
By default, the access permission list of the portal is empty:
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» Portal 5etting [ Properties | = Permission Setting

;;H Access Permission Setting \? Edit Permission Setting

Check this box

Make it public (everyone can access):
Group Id Membership Type Action

Empty data

& Add Permission Je—— Click

| save || cancel |

Check the Make it public check box to assign the access permission to everyone, or
click the Add Permission button to assign the access permission to a specific group
which is selected from the Select Permissions form (By selecting a group on the left
and a corresponding membership on the right):

After selecting groups, the access permission list is displayed:

|> Portal Setting | » Properties ” « Permission Setting

»@ Access Permission Setting v.é? Edit Permission Setting

Make it public (everyone can access): [

Group Id Membership Type Action
JSrustomers manager i
<« Remove
/partners member i da group
, 4k Add Permission

Access Permission list

[ Save ][ Cancel

In which, the icon is to remove its corresponding group from the Access Permission
list.

Edit Permission Setting
By default, it is also empty and you have to assign the edit permission to a specific group.
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S : select this tab
» Portal Setting | » Properties | - Permission Setting /

x;'ﬁ Access Permission Setting \:-* Edit Permission Setting

(@ Current Permission

Group Id :

Membership : Click

I wu Select Permission I

| Save || Cancel |

You can assign the edit permission to a group with a specific membership by clicking the
Select Permission button in the Edit Permission Setting tab to open the Permission
Selector form. Select a group on the left panel and a corresponding membership on the
right panel:

Permission Selector x
£
Browse and select a group Select a Membership
‘ﬁ?" ¥ member ol
ﬁ Customers ¥ editor
ﬁ Organization ¥ manager =
ﬁ Platform b redactor
ﬁ" Partners ¥ yalidator
-
b webdesigner -

The (*) from the Select a Membership panel means that you assign the right for everyone
in the selected group from left panel.

After selecting a group, the Current Permission will be displayed with detailed information:
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Chapter 4. Basic Actions

[r Portal Setting [ Properties | -« Permission Setting

.,g Access Permission Setting |xZ’ Edit Permission Setting | Current Permission

(@ Current Permission
Group id : /platform

Membership : author

| L] Delete Permission I % Select Permission

Click to delete Click to accept creating a portal

current permission |—SML“ e ]

The edit permission is assigned for only one group at one time. You can click the Delete
Permission button to remove the current edit permission of the selected group or re—
assign the edit permission to another group by clicking the Select Permission button again
and select another group.

5. Click Save to create a new portal.

After creating a new site, a list of the existing sites will be displayed on the screen. This new site
will be added to the exiting site list in Site on the administration bar and to a drive list that includes
all its default files.

To see it in the drive list, click Group > Content Explorer on the administrator bar.

Click John Smith @

hd Lsers )

' Applications
Sites Explorer Content )
Portal )

Content Administration
Administration »

IDE
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Edit a site

For example, after creating a portal named 'eXo’, there is a drive named 'eXo' in Content Explorer:
= = -

Pubdicatio Callabaratan System

i A Foader | g podDocumens | sioan

Hites Management HE

F GEMWERAL DRIVES
K-l acme =
= | oome ciassie collaboration 728 DME AdminisTason
. classic il L=l k= »

&l shared 1
- 4 Evems L Ll B4 Sdwr FAaragemem & Srarsd Groups Spece
= i 4 [
[ Shared Sie Shared Users Space Trash
N i kzl = 55

4.2.2. Edit a site

This function enables you to edit a site, including the configuration (setting, permission), the
navigation and the layout components of the site.

There are two ways to approach a site that you want to edit:

« The first way: Edit the site that you are browsing by accessing to Site Editor.

» The second way: Edit the site by accessing to Sites.

4.2.2.1. By accessing to Site Editor

Directly edit the site you are browsing by going to Site Editor > Edit Layout
) — site Group () Dashboard | [j| Site Editor |
+ Add New Page

= Edit Page

m Mews Newsletters Contact Us » ﬂ[‘:? -
1 Edit L ut

The form to edit the site appears.
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- Conderd Usdsl
Comen Dl ol Du Coner Do H Bearch Portlet].
Banner Portlet Sian in Partlet H

s EUR Iline Compussr E"i
Aozl Gl [

Corare il

Navigation Portlet
g Conters

............................................................................................................................. |——-:|:| Autiarng Drsshosed

Puge: Descrigtan

m—| Cxtegary Combarde

|ﬂ Categary Havigatinn

Coniwr Derw

Footer Portlet . v

i Saes oy | | || Swich vies Mode

Details:

Table 4.2.

Indicator Meaning

i Site's Config Slte.s cc_mﬂg: allows editing the site's
configuration.

Switch View Mode: shows how the current

| Switch View Mode layout looks like with real content.

Finish: allows saving all changes and
| = escaping the Edit page

x| Abort: allows canceling all changes that have
o not been saved and quitting the Edit page

With this way, you can only edit the layout and the configuration of site.

Edit layout. Editing the layout means editing a banner, a navigation bar, a breadcrumb bar,

a homepage and a footer of a website. You can also add more portlets to the site by dragging
and dropping from the Applications tab of the Edit Inline Composer form to the main pane.
Moreover, you can move a portlet from a location to another location.
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Edit a site

Click to move
the portlet

-Okcl Dt

Edit the portlet

Pugu Destmplion

e [ABle— Delete the portlet

Edit Inline
Composer

Canieni sl

w Edlinkng Compossr B|x
Ao OIS

PErmInTTAR

Lurnkenks

| Aulbormy Dwesbuard

mm=mi|  Catwgary Comtanie
| Cuteaary Mavigatios

dd Barta Soiy | | || SwkehViow Miode

Editing the banner portlet is similar to editing the Sign-in portlet and the footer portlet so in this
guide, we only show how to edit the banner of the site as an example of editing the layout.

Edit Banner

Show the form to edit a banner by clicking the
Portal form like the illustration below.

icon of the banner portlet in the Edit

Edit Portlet

A form to edit the current banner will appear.

31



Chapter 4. Basic Actions

» Edit Mode |rmm]'>mm"rm1m]rmm|

Conient Selection -

Gontent Pain [AGHE Logo |*[E ]« click to select the path of ccﬁte}ﬂt
- Display
] Show Tite [ Show Date [ Show Option Bar |"5hnw the prift button
~ Print sesings Pl
Show optiun?’"“"‘“’l[‘"‘"’"‘" ]Q|-(— Choose a page for the print view
with § conten-id J& Pararmeter containing the content path
- fheanced
Py et e «_Enable and defi Y
_ nable and define
: © Disabied the correct parameter
by | conentid @

2. Select Edit Mode tab:
Content Selection: Select the path of the content that you want to show by clicking .

Display Settings:

< Show Title: Specify whether the title of the content is displayed or not.
« Show Date: Specify whether the date of the content publication is displayed or not.
* Show Option Bar:Show or hide the Option bar used to show the print link.

Print Setting:

* Show in page: Choose a page for the print review.
« with: Parameters contains the content path.

Advanced: The content should enable “dynamic navigation” that interprets the URL and
shows a content.

3. Select the Portlet Setting tab:
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Edit a site

v Edil Mode | - Porliet Ssiting

Details:

Table 4.3.

v Selectlean | » Decoration Themes b+ Access Permission |

Display Name: Content Detal
Portlet TEE | 5anpe |

Width: |

Height: |

Shorw Inifo Bar
Show Portiet Mode :

Show Window State |

-
=
=

#— Show options

Drescriplion

i Save And Close ] Cancel |

Display name

The display name of the portlet. You cannot

change it.
Portlet Title The title of the portlet. You can change it.
Width The width of the portlet.
Height The height of the portlet.

Show info bar

Tick the check box if you want to show the
info bar of the portlet.

Show Portlet mode

Tick the check box if you want to show the
portlet mode.

Show window state

Description

Tick the check box if you want to show the
window state.

Enter a description about the portlet.

Select Icon tab: Select an icon for the portlet by clicking it.

Select Decoration Theme tab: Select a decoration theme for the portlet.

Select Access Permission tab:

By default, all users can access the portlet:
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|» Portal Setting | » Properties | v Permission Setting ]

l@. Access Permission Setting l@ Edit Permission sm(lglql | i this-b
ec IS DOX

Make it public (everyone can access):
Group Id . Membership Type Action
Empty data

| ¥ Add Permission Iq— Click

| save || cancel |

However, you can edit the access permission by unticking the checkbox > click Add
Permission:

| » EdiMode | v PoretSeming | » Seiecticon | » Decoration Themes "vmmmmm‘]
Untick

Make i publc (everyone can access)
Group 1d | Membership Type | Aton
Empiy data

I 4 Add Permession I‘- Click
Save And Close | | Cancel

The ListPermissionSelector form appears. Select a group on the left pane and a
membership on the right pane.

7. Click Save and Close to commit.
8. Click the disk icon to quit the form to edit the current site.

Edit Configuration. To edit the configuration (including language, skin and permissions) of the

site, click the l ﬁ e foaen ] button to open the same form as the form to add a new portal.

Do the same steps as in Section 4.2.1, “Create a new site”.
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4.2.2.2. By accessing to Site

This approach way enables you to edit the layout, configuration and navigation bar of a site by
going to Sites > select the site in the existing site list.

Logoet | Thange ianguage Register

i — = EoN Lapout S SO Novagation =¥ Edk Pomls Conlig Diieie
- =T " ok Mamgation =2 i Fovinfs Gl delale sile
i T Lot " bt Neogation "% Bk Porinfs Canfy s

Al Mirws Portad

Edit Layout. Do the following to edit the layout of an existing site.

1. Click Site --> Edit Layout to open a form to edit the site layout.
2. Do the same steps as the part Edit layout of the current site.

Edit Navigation. Do the following to edit the navigation of a site.

1. Click Site --> Edit Navigation to open the Navigation Management form.
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Mavigation Management x
exo <*— The Name of the Site
ﬁ}:ﬂﬂ
EI Home

Group Mavigation

Portal Navigation

..H.

-"_ Register
---_ MNews
---_ Events
Add Node Save
A
Click

2. Click Add Node to open the ADD/EDIT PAGE NODE form. (For more details, refer to the
Section 5.3.1, Add a new node, Gateln User Guide 3.1.)

3. Inthe Page Node Setting tab, enter a name for the node. It is required.
| [ ADDVEDIT PAGE NODE x

| ~ Fage Node Setting * Pape Selecior k lcon

Node Mame: | ¢opencts *

Labet: |ontact U]
Vishle: [

Pubfication date & time: ||

Save Back
Details:
Table 4.4.
Uri: The node's identification. The Uri is

automatically created once a new node has
been created.
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Label: The node's display hame on the screen. This
field may be changed and its length must be
between 3 and 60 characters.

Visible: This checkbox allows the page and its node
to be shown or hidden on the navigation bar,
the page navigation bar and the sitemap.
See above for more details.

Publication date & time: This option allows this node to be published
for a period of time. Two fields, including
'Start Publication Date' and 'End Publication
Date' only display when this option is

checked.
Start Publication Date: The start date and time to publish the node.
End Publication Date: The end date and time to publish the node.
4. Select the Page Selector tab:
[==] ADDVEDIT PAGE NODE b

+ Page Node Setling

Enter the page name

Page Id:
MName: I l
i fe~ Enter the title of the page
I “F- Create Page II {5 Search and Select Page I
Create a new page Select an existing page
Save Back

Details:
Table 4.5.

Page Id: The identification string of the page. It is
created automatically when the page is
created.

Name: The selected page's name.

Title: The selected page's title.

Clear Page: To remove the input page information in the
fields

Create Page: To create a new page with the input name
and the title.
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@ Note

Search and Select Page: To search and select an existing page.

< Enter a title for the page.

» Click Create Page to create a new page or Search and Select Page to select an existing
page for the node.

Select the Icon tab to choose an icon for the node. It is not required.

Click Save to create a node for the navigation.

You can edit/delete a node, edit a node's page, copy/cut a node and more by right-
clicking the node in the form Navigation Management form.

Edit Configuration. The portal's configuration including language, skin and permissions can
be edited by doing the following:

1.

2.

Click Site --> Edit Portal's Config to open the same form as the form to create a site.

Do the same steps as in Section 4.2.1, “Create a new site”.

4.2.3. Switch between sites

This function is used to change the current website by another one.

Just select a site in the site list that appears when you move the cursor to Sites on the
Administration bar:

>:) — Site Group Dashboard Site Editor

&
— classi

= acme

Oven eXo

Your current site will be switched to the selected site, and you will see all the child pages that
displays on the Navigation bar of the selected site.
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2:) T Site Group "7} Dashboard & Site Editor
7 classic Welcom
T acme  » Owverview

. Cwer s
T exo Mews

Events

Mewsletters

Contact Us

4.2.4. Delete a site

This function is used to delete a portal (site) from the portal list.

1. Show a portal list by clicking Site on the administration bar:
}:j IE' Croap Dasshisonnd i | She Editar Hooi Roc M

wiew Mews  Evenls  Mewsbetbes  Contec: Us

BGME £ bl Laymt " B Maygaon " B Borlats Conbg ﬁ [istete

chassic £ Edit Lagoout " Edt Mavigadon

[t "y Ed Forin’s Comlig

ann = Edi Layout °FF  Edi Mavigodon O Edil Foriofs Conlig & Dokie

Fudd Mew Forinl

, @ DCelete ,
Click the button in the row of the portal that you want to delete.

3. Click OK in the confirmation message to accept deleting.

@ Note
You cannot delete the Classic site by default.

4.2.5. View a site

In eXo Platform, we use the 'Website' term which is equivalent to the 'Portal’ term. So, viewing a
portal means viewing a website. You can select the site that you want to view by selecting the site
name in the drop-down menu on the Administration bar:

5[] s o | 3 Dastnosm X S P Puisbmi
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The main screen of the site will appear like the illustration below:

}:1 Site Group Cashboard S Site Editor 1 Moo Mool | Peblshed

DOCUMENTS.

B

5 \Where we are
Lorem ipsum dofor stamet
mecieleer adipcng e

5. BN MauisemEnts
3l T AT
e DOpesang ¢

How 10 oinus
Comserriser adpsong ol
lomem ipsum dolor 3 amet

LATEST NEWS

(]

COICEE aipemong eit,
=ed doensmod erpor nodident ut
e o dalrs magna akjua

SCME s a
CONPAMY NEWS r Lo o o} Lowem ipsurn dodon s amed,
= R A i
Sod 00 SRS SO kO
labore & dolore magna alqua.
ACME News L =
AdN) 1. FO0E 111 SM I 1 =
HCME Hewrs 3
LONSM DS 0o8or St amel, conaooe i Adpe=ong i, 580 00 Sasmod empor incdidunt Ul bone & Gol0ee Magna aegqua. Lorem mpsum oo
' iy CoTsECkERe adpes
S0 00 SAUERITI O i
RDOne &1 00MNE Magna Asgua.

ACME Naws 2
Lowaim ipsEum dodorn S ames,

et addigesicing o, w00 chemod e incididunt ul labare #1 dokose magna alqua

| diz s | gt incadcheny
O S D0M0NE Magna akqua.

ACHE Hews 3

A 1, FO0E LT A I i
L0 R0 CRONOd 51 amel CoNaoieiur A0eson S, 360 00 Saesmiod iempor Inosdunt il laoone &1 Ge0ne Magna aagua.

ACWAE Mesws 2
i 31, 3000 355 M by
LOFET) i ol S ame, consenens adipesicng o, s do sheamod emges incididunt il labaons &1 dokoss magna aiqua

Fowered by eXo WM - Copyright & 2000-2009. A1 rights Mesereed, eio Flatom 5475

=]

Administration bar which contains administration functions related to portals (websites).
A Banner which contains slogan, logo, icon used in the website.

A Navigation bar which helps users to visualize the structure of the website and provide quick
links to different pages.

M Home page which is the main page of the website. This is the default page that is displayed
first when you visit the website.

M Footer of the website. It can be texts, or image that is displayed at the bottom of the website.
It provides information about author/institutional sponsor, revision date, copyright and more.

4.2.6. Search content in a site

The Search function allows you to quickly search for any contents in the system with a keyword
from the front page, even if you do not log in. However, the number of the search results displayed
depends on your role.

For example, if you do not log in, you only see the search results that are published.
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4.2.6.1. How to search for contents?

To search for contents, do the followings:

1. Enter a keyword into the search box and press Enter.

The search results matching with your keyword are displayed in the search page:

= Enter keyword
. Eyword t
Search farm —jm e

Poral | 41 . Paga o] Decumant

Saarch
Search results
Document and Page Aemsle 1+ 5 (000532 pecondy)
ACME Event 1
s/ ocahost: BOBD/ scrdema) private somey detad) reposiiony colisboration; stes conbent /e someweb contents/Events/Event] - 21120
ACME Event 2
britp: | menlhoe: BOB0 me e (peroas) somas. et repomtney relsborshor i rorteeslos) seme) cek cordentyEusety'Eeentl - 2L12A
ACME Event 3
http: | iccalodd: B3 s rrodema et ate: semaey dete ) renondory solaborabion e cortees s some) el cortents/Evecty' Evertd - ZL120
ACHE Event 4
Fetig: sl : BOED) s et e aiti iy ke raseeaan ) colaber alioe | slin Cor et Ty i B el cortants By ety Everld - 21120
ACME Event 4
i | Miocailbhs s BXOBAL dec rvaierra[oere arbi' By chitasly nepecaiiory ) Codaboration, ses conbend/ Ty somi sk conents Eventy' Eventd] 2] - 1220
Mg

In case of no search results matching the keyword, the search page is displayed as below:

Wecome: jobe ] | ]

| Search
Document and Page
Your march X - did not match amy dosurmsnd and page
Details of the Search form
Table 4.6.
Field Details
Keyword The keyword used to search.
Portal The scale where you want to search. You
can search in all portals or in a specific portal.
Page Search in all pages containing the keyword.
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Chapter 4. Basic Actions

Details

Document Search in all documents containing the
keyword.

2. In the Search form, you can enter another keyword in the Keyword field and set the the
search scale.

3. Click Search to start searching.
4.2.6.2. Edit the Search portlet

Editing the Search portlet allows you to change the display of search results.

Do the followings:

Procedure 4.1. Edit the Search portlet

1. Open the Search page as Section 4.2.6.1, “How to search for contents?”.
2. Open the form to edit the Search portlet

There are two way:

e The first way

Turn on the Edit mode, and then click the & icon:

D — mite Group Dashboard [ Site Editor Tuwrn on Edit mode
Walermae Joben 1 [ . &xp
P Click 5 L
Fortal g -

7| Page 7| Document

St

Document and Fage
Your search EX0 - did nof mabch ary document and page
e The second way

Click Site Editor --> Edit Page on the administration bar. The Page Editor will be
displayed.

» Hover the mouse pointer over the SearchResult portlet and the toolbar appears.
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Search content in a site

I sexchiesit@)D |
semrrroesst . w Page Editor
Edit Portiet

Apphcaliond Contamners
Click
Admensirason

— A pplication Registry

Rew Account

Contents
Dashboand
il Wiews Page propertes Swibch vhew Mode:
) Click & to edit the portlet.
The form to edit the Search portlet appears.
Items perpage g -
Page Mode  pore -
Search form template || DefauitSearchFom. gtmpl -
Search result templste || DefauhtSearchResult. gtmpl -
Search page leyout  |J|SearchPagelayoutDefault.gtmpl -
template
Base path  getsil \
[ Save I [ Cancel
Details:
Table 4.7.
Field Details
Items per page The number of search results displayed in
each page.
Page Mode The way to display the search results. There

are 3 options:

« None: Only the first page of search results
is displayed in the search page.
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Field Details

e More: When you click the Search button,
the first page of search result is displayed.
The difference from the None mode is
that, there is a More button allowing
you to see more search results. When
clicking this button, new search results
are appended to the current search result
page like Twitter or Facebook behavior.

e Pagination: In this mode, the search
results are divided into many pages (for
example, 1, 2, 3 and Next). You can
navigate to another page by clicking the
page number or Next in the bottom of the
Search portlet to view more results.

Search form template The template of the Search form.

Search result template The template for displaying the search
results.

Search page layout template The layout of the Search portlet.

Base path The page where you can see the content of

a search result.

3. Edit your desired portlet and click Save to accept your changes.
4.3. Contribute content

4.3.1. Edit mode

When you access a site, by default, the site contents are in the published mode and you cannot
edit them.

However, each site in eXo Platform has the Edit mode which enables you to edit all contents of the
current site. When hovering your cursor over contents, you can see edit icons which enable you to
quickly edit these contents. You can take advantage of this feature to submit contents to a page.

To turn on the Edit mode, hover your cursor over Edit on the Administration bar, then select
Content from the drop-down menu.

ﬁ My Sites Dashboard Edit

aC Page »

B i Site ¥
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InContext Editing

For Single Content Viewer (SCV), you can see the current state of the content, the Edit Content
icon and Preferences icon.

The "published” state -

For Content List Viewer (CLV), you can see the current state of the content, the Edit Content icon,
the Preferences icon, the Add Content icon and the Manage Content icon.

Ice powers enable instant freeze capabilies. In Whether for recreation, utiities;

addition, you can create ice formations without
a wiater supply, such as ice cubes, skating rinks
or even decorative sculptures,

Wind power provides a wide range oOF capabitige!
for Acme Superheroes. Gentle brpazac ta asls
force winds can be generated ins

modified on the fiy.

Edit content

The Fire super power allows you to create fire
instantly, with no fuel source required. You can
control the temperature, size and direction of
the flame with only vour thoughts. Acme
cautions its customers to be responsible with
this power, as it can cause significant injury and
property damage.

Injury and ilness can be an uncomfortable
interruption to daily ife. The Healng power lets
you stop these inconveniences the second they
start. Note: Healing powers are only avaiable for
the ndvidual owner and cannot be appled to
third parties at this tima.

4.3.2. InContext Editing

By using the InContext Editing feature, the process of editing a page becomes more intuitive.
This feature allows you to edit content "in context" without using the WYSIWYG editor, and the
new content will automatically override old one.

To use InContext Editing, turn on the Edit Mode.
4.3.2.1. Add a content

Adding a new content by using InContext Editing is enabled for the Content List Viewer (CLV).

1. Turn on the Edit Mode, then hover your cursor over the CLV to which you want to add a
new content.
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Chapter 4. Basic Actions

2. Click @ onthe CLV.
You will be redirected to the Sites Explorer with a list of content templates for you to select.

Select your template in the list below

— sl
Free layout Ficture on head
webcontent layout

3. Click one template for your content. Each template has an Info bar on the top of the template.

i >
Free layout webconteng(Change Content Tyoe) [<e=——Select another template Save Save & Close Close | 44

Details:
Table 4.8.
Change Content Type Select another content types.
Save Save the content without closing the content
form.
Save & Close Save the content and close the content form.
Close Close the content form without saving the
content.
R Switch on/off the full-screen mode.

4. Fill all the fields in the form. See the Add a document section to know how to create the
different content types.

5. Click Save or Save & Close to save the document.

E] Note
The folder, where a document is saved, is the path you have selected in the
section.

4.3.2.2. Edit a content

You can edit any contents on the homepage for SCV and CLV with InContext Editing. However,
for CLV, you only can edit each content in it.
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InContext Editing

1. Turn on the Edit mode by hovering your cursor over Edit on the Administration bar, then
selecting Content.

2. Hover your cursor over the content you want to edit, and click & at the right corner. You will
be directed to Sites Explorer with the document form for you to edit.

Publication Collaboration
¥ Upload Files i Manage Categories Back to the hcmepage:ﬂ-ﬁ'ﬁ_'
Free layout webcontent ( save )I: Save 8 Close )I: Close ]‘ ::
" Main Content | Tlustration Advanced

Title  ACME Introduce -

Name  Introduce =
Language en -
Main Content (@
Elsource 5] B 4Bl « » HOEOHE
afgdn.iiiiEE et AT @ BEP
anmal(...ﬂ Font ! Srzs! @
Welcome to Acme

Super Powers for Regular People

3. Make changes on the content, then click Save or Save & Close to accept your changes.

4. Click @ to return to the site. In the Edit mode, your new content will be in the "Draft" state
with its visible modifications.

Fublish contert

5. Click @ , or s+ on the Action bar to publish your edited content. Your content is now in
the "Published" state.

4.3.2.3. Manage content

With InContext Editing, you can easily manage a Content List Viewer on the homepage. You
can add a new content in the CLV, edit, delete an existing content or copy/cut/paste to another
CLV and take more actions in the right-click menu.
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Chapter 4. Basic Actions

Manage content in the CLV

1. Turn on the Edit mode.

2. Hover your cursor over the CLV which you want to manage on the homepage, and click L .

You will be directed to the Sites Explorer page.

collaboration Admin Info
=iy eb contents - — ’ - B
r Add Content W5 Add Folder @f‘i Add Translation (;3 Add Symlink
@@ Events
-] Fire Name
-|_] Flight
I= ¢ . .| Events
-|_] Healing L
[ 1ce S || Fire
-] Immunity [] Flight
| Invisibility || Healing
E+J_, NewEvents = [ Ice

4 I 2

3. To add a new document to the CLV, click Add Content on the Action bar and do the same
steps as in the Add Content section.

To take other actions on a specific content in the CLV, right-click it to open a drop-down menu.
For more details, see the Actions on folders and documents section.

4.3.2.4. Preferences

Preferences enable you to edit contents in the Single Content Viewer (SCV) and the Content List
Viewer (CLV), reset the display of the contents in SCV and CLV and publish contents.

Content Detail Preferences

To edit the Single Content Viewer, do as follows:

1. Turn on the Edit mode.

2. Select @ of a Single Content Viewer.

Publshed p;:

Welcome to Acme
Super Powers for Regular People

The Content Detail Preferences dialog appears.
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InContext Editing

Content Detail Preferences x

Content Selection

Content Path  ACME Tntroduce « @¢— hepathtothe

content folder
Display Settings
[C] Show Title [C] Show Date [T] show Option Bar Q

Print Settings
Show in Page printviewer Q
with  content-id
Dynamic Navigation

Advanced -
Dynamic Mavigation

e

Contextual Content ) Enabled @ Disabled

by content-id

Contents Visibility
F Restricted by Authentication ©) Restricted by User roles |‘_ Contents Visibility

Save Cancel

Details:

Table 4.9.

Field Description

Content Selection Select the path of the content that you want

to show by clicking * .

Display Settings Configure the visibility of Title, Date and
Option bar.

« Show Title: Select this checkbox to
display the title of the content.

e Show Date: Select this checkbox to
display the date of the content publication.

e Show Option Bar: Select this checkbox
to display the Option bar which is used to
show the print link.

Print Settings ¢ Show in Page: The content is shown in

the page.

« with: Parameters contain the content
path.

Advanced link: When clicking this link, the Advanced pane
will be shown with two parts.
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Field Description

e Dynamic Navigation: Allow you to get
a parameter to configure the portlet by
URL. It means that the URL containing the
content path can be dynamically changed.

e Disable: By default, if the property is
set as "Disable", the Advanced pane is
closed by default. It means the single
content will be opened by an URL
containing the Content Path.

« Enable: This portlet is configured with
the provided parameter (“content-id" by
default) and the content.

* By: This parameter is the key in the
URL to let SCV know which really is the
path in the current URL. It is editable
when the Contextual Content is set to
"Enable".

e Contents Visibility: Allow you to use
a cache shared between users to get
contents. If you want to get contents,
which are displayed in CLV or SCV,
from one cache, select Restricted by
Authentication. If not, select Restricted
by User Roles.

@ Note

Hover your cursor over ' to see a quick help for each section.

Click * next to the Content Path to select another content. The Select Content dialog
appears.

Select a folder on the left pane, and content in the folder on the right pane. The selected
content will be displayed in the Content Path field.

Tick the checkboxes, including Show Title, Show Date and Show Option Bar, if you want
to display the content title, the publication date and the print button like the illustration below.
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InContext Editing

[EQiE introduce | t==The content itie

S

i. In the Print Setting part, click to open the UlPageselector dialog. You will see
Printviewer.

ii. Click the Print button. The content is opened in the print viewer page.

6. Click Save to save all your changes.

Content List Preferences

To edit the Content List Viewer, do as follows:

1. Turn on the Edit mode.

2. Select the Preferences icon of a Content List Viewer.

Content List Viewer Click =“

Login as an Acme User

Jack Miller
An authenticated visitor who will see the admin bar wich a parsonal preferences manu.
Login as Jack

James Davis
An author with authoring rights on the website contents and a backoffice access.
Login as James

Login as Mary

John Smith

An adminstrator with admnistrator rights on the platform. he can manage security access and application.
Login as John

Mary Williams
1 A publsher who can write contents but ako can create new pages or edit them in the current site.

The Content List Preferences dialog appears.
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Chapter 4. Basic Actions

Content List Preferences

Contents Selection
Mode @ By Folder O By Contents
Folder Path  web contents =[] <= The path to the content folder z
Order by  OrderByOsteCreated

|

) Descendant @ Ascendant

Display Settings
Heade! Festured Products Automatic Detection [ 3
Template  TwoColumnsCLVTemplate gimpl v
Paginator  |J|PagratorEmpty gimpl -
Items per Page 3 .
Show Title [ Show Image [] Show Summary (]
Show Header [7] Showpate [ Advancedpane  gpou ik
Show Refresh [ ] Show More Link [ Show RSS Link [ 3
 Advanced
Dynamic Navigation )
Contextual Folder ) Enabled @ Disabled 3
by Foiderid @
Show in Page detai ! @
WEN  content-id @
Contents Visibiity §
@ Restricted by Authentication ) Restricted by User Roles
Save Cancel
Details:
Table 4.10.
Field Description
Contents Selection Mode: This mode is to select web content for

the list viewer. There are two modes:

* By Folder: This mode allows you to select
a content folder in the Folder Path field.

* By Contents: This mode allows you to
select by the content in a specific folder in
Folder Path field.

Folder Path: The path to a location of a
folder that contains the content.
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InContext Editing

Field Description

Display Settings

Order by: Sort content in the List Viewer
by Title, Date Created or Date Modified in
ascending or descending order.

Header: The title of all contents that are
listed in the List Viewer.

Template: The template which is used to
view the content list.

Paginator: The template which is used to
view each content in the list.

Items per Page: The number of items which
will be displayed per page.

The following options which can be shown
or hidden by ticking or unticking checkboxes
respectively.

e Show Title: Title of each published web
content/document.

¢ Show Header: Header of each published
web content/document.

* Show Refresh: The Refresh button at the
left bottom of the page.

e Show Image: The illustration of each
published web content/document.

 Show Date: The created date of each
published web content/document.

* Show More Link: The Read more link to
read all the content of a web content and/
or document.

e Show Summary: The summary of each
web content/document.

« Show Link: The link of web content/
document.

e Show RSS Link: The RSS link of all
contents of a web content/document.
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Field Description

Advanced link Dynamic Navigation

« Disable: The single content will be
opened by an URL containing the Content
Path.

« Enable: This portlet is configured with
the provided parameter (content-id by
default).

e By: This parameter is the key in the URL
to let CLV know which really is the path in
the current URL.

¢ Show in Page: A single content in CLV
will be shown in a selected page. You can
select any page but should take one with
a Content Detail Portlet. The "Dynamic
Navigation” is enabled in the Content
Detail Portlet that interprets the URL and
shows a single content.

e With: This parameter is the key in the URL
to let SCV know which really is the path in
the current URL.

Contents Visibility: Allow you to use a
cache shared between users to get contents.
If you want to get contents, which are
displayed in CLV or SCV, from one cache,
select Restricted by Authentication. If not,
select Restricted by User Roles.

3. Browse the documents or web content of an available site by clicking '*' next to the Folder
Path field.

4. Ifyou select the By Folder mode, select an available site on the left, then select a folder that
contains contents (documents and/or web content) on the right by clicking the folder.

If you select the By Contents mode, select an available folder from the left pane, all content
in this folder will be listed on the right pane. Click a content on the right that you want to add
to the content list. There will be a message, informing that you have successfully added it to
the Content List. The selected content will be listed in the Content List.

5. Enter a header for the content list in the Header field if you want.
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Inline Editing

6. Select a template to display the content list in the template list.
7. Tick/Untick your desired options.

8. Click Save to accept your changes.

4.3.3. Inline Editing

The Inline Editing mode allows you to edit directly on the page without going to a separate one.
By using this mode, you can edit the text in the same location in such an intuitive and convenient
manner.

To do the inline editing, do as follows:

1. Turn on the Edit mode on the Administration bar.
2. Hover your cursor over the area you want to edit. The editable area will be highlighted.

3. Double-click the area until the Edit area is shown as below.

Discard

=p>
? \Worried about a straying spouse? Go Invisible to find out for sure! (Note: badeground check required. ) </p> Ehanges
Accept changes =kl

In case the hovered area is in the Rich Text format, the Edit area will be displayed with
the CKEditor [http://docs.cksource.com/CKEditor_3.x/Users_Guide] as below. (See more
information about CKEditor here.)

El sourcz F B ; 400033
B I U = = = ic = & A% ]

Formal

4. Make changes on your selected area, then click ¢ to accept,

or X to discard changes.
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Chapter 4. Basic Actions

« After you have made changes on your content, it is only in the Draft state.

Hew: Invisibility Draft Ers

ng spouse? Go Invisble to find out for sure! (background chedk required

Click to publish
* Click < to publish the content. Now, your edited content in the Published state.

4.3.4. CKEditor

When using CKEditor to write/edit a document, you can also:

* Insert a portal link to the document.
 Insert a content link to the document.

Insert a portal link

1. Click & to open the Insert Portal Link form.
InsertPortalLink [ ]
Title:
URL: Get portal link

Preview Save

] Cancel

2. Enter the title of the portal in the Title field.

3. Enterthe portal URL manually, or you can also click Get portal link to open a page containing
all the portals in the same server, then select one that you want.

4. Click Preview to view the portal.
5. Click Save to accept inserting the portal to the document.

Insert a content link

1. Click @ to open a page.
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Publication process

CONTENT SELECTOR

Thumbnail View

2. Click the plus before the document name or click directly the document name on the left pane

to show the contents in the right pane or click “¥ uploadFiles | tg upload a file from your local
device.

3. Click a content that you want to insert to the document.
4.3.5. Publication process

After a new content has been created, it is saved as draft and you can easily to publish it on your
site. The publication process consists of four steps:

Request for Approval --> Approval --> Stage --> Publish

In case you want to publish your content without having the "Approve" or "Publish” right, you first
need to send your request for approval.

In case you have the right to approve or publish a content, you can yourself publish it with the
Stage step immediately.

* Request Approval: When a new content is created, it must be approved before publishing by
clicking Request Approval on the Action bar of the Sites Explorer or clicking Pending in the
Manage Publication form.

Manage Publication ®
Revision History
Revision: plf-35-release
Status:
Draft Pending Approved Staged Published
Scheduled
’7From To
| Revisions | Date |Authnr | Status |Actinn |
|Rev|5\un:plf-35-release |Nov 29, 2011 11:16:36 AM |]ohn |Draft[currant revision] | D |
Save Reset Close

» Approve: To approve a content, click Approve on the Action bar of the Sites Explorer, or
Approved in the Manage Publication.
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« Stage: This step allows you to publish a content in a period. After selecting the publication
schedule for the content, it will be automatically published as the schedule.

To publish your content just in a stage, click Stage. Then, click From/To to select the start and
end dates for publication from a mini-calendar.

To publish your content forever, you should not set time in the To field.

« Publish: A content will be published when you have completed the Stage step.

@ Note
You will see a list of draft contents, pending contents which are waiting for your
approval if you have the approval right, and contents that will be published at
the bottom of the Sites Explorer. Click your desired contents to review, approve
or publish.

New: Invisibility

4.4. Content inside categories

In eXo Platform, you can create new contents in any folders or directly in a CLV with Incontext
Editing. However, to facilitate the content management, categories are usually used to sort and
organize documents that makes your desired searches more quickly. Also, creating contents
inside a category helps you manage and publish them effectively.

After creating a document, you should categorize it by adding it to a category. Otherwise,
documents should be created right in a category and links to those documents will be automatically
created in the category. In eXo Platform, categories are stored in JCR.

4.4.1. Create a content inside a category

This section will show you how to create a content in a category.

1 Hover your cursor over ¥ --> Content --> Sites Explorer on the Administration bar.
Click John smith (&)
v Users y
: Applications
[ sites Explorer | | Content »
Portal y

Content Administration
Administration »

IDE

For example, select the acme-category drive as the following illustration.
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Dynamic Navigation

acme-category

| New: Speed
|2l New: Invisibility

i | Movement

®-§ | Natural Elements

MPPEPO]

bdk Add Category

Document Title

New: Speed

o
3

New: Invisibility
Defense

Fire

Flight

Ice

Movement

r d Content "':-’" Upload Files

Created Date Author
11/29/11 10:05
11/29/11 10:05
11/29/11 9:29 A
11/29/11 10:05
11/29/11 10:05
11/29/11 10:05

11/29/11 9:29 A

==, Content Navigation

Last User Status
root Published
root Published
root Published

2. Click the Add Content button to create a new content. See the Add a document section to
know how to add a new content. The new content is a Symlink. To view the content, simply
click the Symlink.

{3 (O /Defense

acme-category bdp Add Category "—0 Add Content ¥ Upload Files ==, Content Navigation

=% | Defense -
-§ | Healing Document Title Created Date Author Last User Status
-§ | Immunity 1 Healing 11/29/11 9:29 A
L Invisibility & | Immunity 11/29/11 9:29 A
-, Release PLF3.5 E .
:_l Vision i | Invisibility 11/29/11 9:29 A
g
11/29/11 4:11 P john john Draft

i [1L, Fire =z Release PLF3.5

- [CL Flight
[l Ice o

1 vision 11/29/11 9:29 A T

Created Content

4.5. Dynamic Navigation

Dynamic Navigation enables you to get a parameter to configure the portlet by URL. It means that
the URL containing the content path can be dynamically changed.

This section shows you how to use Dynamic Navigation in eXo Platform.

Do the following to access Dynamic Navigation:
Procedure 4.2. Access Dynamic Navigation

1. Turnonthe Edit Mode > hover the mouse over SCV or CLV and select the Preferences icon.
If you select the Preferences icon of SCV, the Content Detail Preferences form displays.
If you select the Preferences icon of CLV, the Content List Preferences form displays.

2. Clickthe Advanced link in the Content Detail Preferences form/ the Content List Preferences
form.

The Dynamic Navigation will display.

Dynamic Navigation in SCV
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b=| Content Detail Preferences x
Content Selechon
Content Path  ACME Introduce - g Selectthe 3
content path
Display setfings
| Show Title || Show Date Shaow Option Bar 1
Print settings

Show inpage  prinbiewer
with  contant-id Dynamic Navigation

- !

Diynamic Menvigation
Contesxtusl Comtent Enabled @ Disabled

by content-id

Cache Management
Share contents between users @ Enabled Disabled
Details:
Table 4.11.
Contextual Content « Disable: It means a single content will be
opened by an URL containing the Content
Path.

* Enable: This portlet is configured with
the provided parameter (content-id by
default).

By This parameter is the key in the URL to let
SCV know which really is the path in the
current URL. It is editable when Contextual
Content is Enable.

For example, open a single content with the Content Path "ACME Introduce". The URL of
the content is the following:

URL: ... /ecmdemo/private/acme/printviewer?content-id=/repository/collaboration/sites
content/live/acme/web contents/site artifacts/Introduce&isPrint=true
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Dynamic Navigation

Dynamic Navigation in CLV

s Comern List Preferences

Corments sslection
Mode @ gy Foider ) By Contenss -
Folder path | yents | s The path to the content folder #
Onder by Fubicaiondate
) Deseendarne ¥ pscendanm
Diisplary sestings
Faadar Automanic Detecton (5] b+
Tempiate TwoColsmraCLVTempiate gtmp v
Paginstsr  UiPagnaworDefaan gimpl o
1 =
e Dynamic Navigation
Sk Tithe [l Shaw [mage Fi Shaw Summanry Tl
Show Header 1] Shaw Date Show Ltk
Show Refresh [ Show More Link o5 Show RSS Link 7] 3
Agvainoed
Crmere Mavigatan .
Canterusl Folder | Enabled @ Disabled 4
by [ded g Parameter containing the content folder
Show in page  darsd L I
w [Emeid = Parameter containing the single content path®
Toche Managemant
Share conients eSS @) Ensbled () Dissbled
Save Cancel
Details:
Table 4.12.

Contextual Folder

« Disable: It means a single content will be
opened by an URL containing the Folder
Path (for CLV)

e Enable: It means the path of content list
(Folder Path in the Content Selection path)
can be dynamically changed by URL.

By

This parameter is the key in the URL to let
CLV know which really is the path in the
current URL.

Show in page

A single content in CLV will be shown in a
selected page. You can choose any page but
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Chapter 4. Basic Actions

you should take one with a Content Detail
Portlet. The Content Detail Portlet should
enable “dynamic navigation” that interprets
the URL and shows a single content.

With This parameter is the key in the URL to let
SCV know which really is the path in the
current URL.

4.6. Content Explorer

4.6.1. Access Sites Explorer

This page is used to manage all documents in different drives. This is really a flexible way
because you can do through Internet whenever and wherever. By default, anyone can access
Sites Explorer, but the ability to do actions on Sites Explorer depends on the role of each user.

*  Hover your cursor over # on the Administration bar, then select Content --> Sites Explorer
from the drop-down menu.

Click John Smith @

v Users ¥
z Applications
Sites Explorer | | Content 2

Content Administration Portal »
Administration »

IDE

A list of all drives organized in groups (Personal drives, Group drives and General drives)
in the Sites Explorer displays.

% Add Folder F(, Add Content ¥ upload Files Show Drives —.D
@ Click the Show Drives button on the action bar to showyhide a list of drives.
¢ _GENERAL DRIVES
®| acme-category (= collaboration =) default-category ® intranet-category (®) Sites Management = Trash General
Drives
* GROUP DRIVES
/ developers . / organization / ~# [ organization / i’ / platform / i’ /platform / users 25 / platform / Group
amployees management [ administrators web-contributors |l Drives
executive-board a
* PERSONAL DRIVES
LI Y Personal Private ! Public _‘_Pe'goqa\
=i = = e
Documents Drives
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Personal drives
Personal drive is the working space of a user. If you want to do in private, select the
Private drive, no one else can access or get your private resources. If you want to create
resources and share them with others, work in the Public drive.

Group drives
The drive of a group is the working space of users in that group.

In the following example, the user "root" joins in three groups : "executive-board",
"administrators" and "users" so he has the right to access these group's drive.

General drives
This is the working space for everyone but your access right in different drives depends
on your role. If you access as an administrator role, you can see all drives; otherwise,
you can see some drives only as a web contributor role.

4.6.2. Drives

4.6.2.1. Private drive

The Private drive contains personal data of registered users. Hence, only these individuals can
access data in this drive type.

& 0 [BEame e The curent node

| *® Upload Files T Add Folds Dalete | 5 Manage Actions | §, Manage Relations I Manage Audit

Bookmarks

Hame Date Created Date Modified Owner Versionable Auditing
Documents

Favorites

Functions

e Initialized folders

Searches

videos

By default, there are some initialized folders to store private resources of users.

In Private drive, there are many functions on the Action bar, including:

» Create new folders/documents.
» Upload files from your computer.
e Add Symlinks.

* Overload Thumbnails.

» Watch/Unwatch documents.

* Add tags to a document.
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Set multiple languages for a document.

* Vote for a document.

« Comment on a document.

« By selecting the Search tab, you can:
» Do the simple search.
» Do the advanced search with more constraints, or by adding new queries to search.
» Do search by existing queries.

 In addition, you can:

e Set up your browse preferences.

Cut/Copy/Paste/Delete nodes.
» Lock nodes.
* Rename nodes.

» View document content by the WebDAV function.

Download documents (folders) to your machine.

4.6.2.2. Public drive

With the Public drive, there is no initialized folder but you can create by yourself.

In the Public drive, you also can take similar actions to those in the Private drive.

Public ¥ Upload Files WG Add Folder  [i7;] Delete

MName T

Functions

T

Mo initialized folders

44— Filter bar

4.6.2.3. Personal Documents drive

This drive consists of the Private and Public folders. The Private folder contains all your personal
data resources that cannot be accessed by other users, inversely the Public one is accessible
for all users.
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¥¥ upload Files [ Add Folder & Manage Actions  f, Manage Relations TN View Node Properties More *
Hame Date Created  Date Modified Owner Versionable Auditing
L. Private 12/6/11 2:07 PM 12/6/112:07 PM  _system false false
Public 12/6/11 2:07 PM 12/6/11 2:07 PM  _system false false

Initialized folders

In the Personal Documents drive, you also can take similar actions to those in the Private drive.

4.6.2.4. Drive of a specific group

By default, there are two initialized folders but you also can add more and take actions that is
similar in the Private drives. Only users in a specific group can access its drive.

w2 = ® G O

/ platform / users ¥ Upload Files [ Add Folder [£3] Delete

|| Documents

Name

|2 SharedData

T Functions

Folders

4.6.2.5. Hide/Show the sidebar in a drive

The sidebar is used to show nodes like a tree or show the related documents, tags, clipboard
and saved searches.

You can hide/show the sidebar in two ways:

The first way

1. Click © to open the Preferences.

Preferences x
Sort by Alphabetic - Ascending -
Show Sidebar @D Enable Drag & Drop
Nodes Per Page 10 ~
Advanced Tick

Save Close
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2. Deselect the Show Sidebar checkbox, then click Save to accept your changes.

* To show the sidebar, tick the Show Sidebar checkbox in the Preferences form.

The second way

* Simply click 4 to hide the sidebar as the illustration below.

m 2 = @® <3 (O /Documents

/ platform / users ¥ Upload Files 6 Add Folder

| Documents

Mame
“|=) SharedData

() €— Click o hide the sidebar

All Ttems

» Owned by me

* Favorites

The drive will be displayed like the illustration below.
m 52 = @& <& (O /Documents

@ Upload Files W5 Add Folder E Delete

Name

®4— Click to show the sidebar

Click ¥ to show the sidebar.

E Delete
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4.6.3. Views

There are many drives in Sites Explorer. Each drive has some views that enable you to view
data in the drive in a particular way. Each view has some action tabs and each action tab contains
some functions.

eXo Platform supports you some ways to view nodes in a specific folder and show actions of
corresponding tab on the Action bar.

4.6.3.1. Admin view

In this view, each item in the list includes following information: Name, Date Created, Date
Modified, Owner, Versionable and Auditing. These information will help you manage nodes
easily.

o ooz m@o]éor . a
Sites Management Q Updoad Files nmmlder #4 Manage Actions . Manage Relations F View Node Properties Mara = nsE &
- acme MNodesin
1 " 3 Name Date Created  Date Modified Owner Versionable Auditing
& defauk descending order 3
& intranet = acme 12/20/11 1:28 AM12/20/11 1:28 AM  _system false false
& {5 phato_jpg = default 12/20/11 1:28 AM12/20/11 1:28 AM  __system false false
&I shared W intranet 12/20/11 1:28 AM12/20/11 1:28AM  _system false false
@ photo.jpg 12/20/11 B8:36 AM 12/20/11 8:36 AM oot true false
= shared 12/20/11 1:28 AM12/20/11 1:28 AM _system false false
A . B % Q i

You also can sort hodes to the nodes information by clicking the label of corresponding column.

* - indicates that nodes are ordered in the ascending order
e - means nodes are in the descending order.
4.6.3.2. Cover Flow view

This view is defined as a dynamic one with the side-scrolling view to nodes in a folder. In this view,
when a node is selected, its name is set with bold effect to more outstanding than others.
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EE:: = @ & O [Pivate
Personal Documents T add Folder (@] Delete  [g] Overload Thumbnail ¥ Upload Files
EH. Private -
% Documents
B videos
& Music
Pictures E r
- Searches
& [ Favorites
& Folksonomy
. Bookmarks =
4
All Ttems

* Owned by me
» Favorites
> Hidden

Filter By Type - Diocumsents Videos Music Pictures

+ Content

= Nooument

To move from one node to another one, you can do one of these ways:

* Use the mouse wheel.
« Hold and move the yellow circle button to the left or the right.

* Click the folder/document name that you want to select.

4.6.3.3. Icons view

In this view type, nodes in a specific folder will be viewed as icons. The name of each node will

be shown under its icon.
O @ DE'IIIII g m~<$ O/

Sites Managefent @ Upload Files Tr_'o Add Folder  [g] ©Overload Thumbnail

lcon view
B acme

- B B B N B
¥ intranet
'"E photo.jpg acme default intranet photo.jpg shared

&~ I shared

4.6.3.4. Thumbnails view

By using the Thumbnails view, nodes in a specific folder are viewed as icons bounded by frames.

Name of each node is shown under its icon.

If nodes are image files, their thumbnails will be shown like the screenshot below.
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O @ omEom a@yE & O

Sites Management

L S M - 1

&

& Add Folder
Thumbnail view

& acme

& default
& intranet
™ photo.jpg

W shared

4.6.3.5. Slide Show view

'CJ Add Content

& -

default

¥ Upload Files [x] Overoad Thumbnail

shared

mtranet photo.jpg

In this view type, pictures in folders are viewed in the slide show.

To view pictures in the slide show, click = .

J

CIEENG

If nodes are pictures, they are displayed like the following illustration.

p.I e
P ki

(P Add Symilink

The Slide Show view automatically shows all picture nodes. Users can control this slide show
by clicking the below buttons.

Table 4.13.

Go to the first picture node.

Button Function

View the previous picture node.
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Button Function

m Pause the slide show. After clicking this button,

III will become IR. click R to continue viewing
the pictures node.

[ >» View the next picture node.

[ > ] View the last picture node.

4.6.3.6. Timeline view

This view enables users to view all nodes created and uploaded by simply clicking = .
Ol m =2 wm & m -~

All the nodes, which have been created and uploaded, will be displayed.

You can directly click the node name to view its content in details.

Bl =@ m e m -G O

Sites Management ¥ Upload Files 0§ Add Folder

"ir acme

"'i default Hlame

& intranet Today

'"E photo.jpa ' photo.jpa

&~ @ shared 5 my annoucement
i default.css
¢ default.js
B Time Travel

4 Earlier This Year
=
All Ttems

Basic Template

Social Bookmarking

You can also click to mark your item as favorite, or * of a favorite node again to remove
it from favorites.

4.6.4. Functions on action tabs

Functions are added to tabs in Sites Explorer by administrators. The number of displayed actions
depends on each tab and each drive you are browsing and your role.

This section shows you how to take all actions in Sites Explorer.

4.6.4.1. Add a category

This function enables you to add a category to a node.
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1. Select a node to which you want to add a category.
2. Select i+ cst=ier on the Action bar to open the Add Category form.
3. Enter a name for the category in the Category Name field.

4. Click Save to accept creating the new category.

4.6.4.2. Add a document

There are several types of document in eXo Platform, such as File, Article, Podcast, Sample
node, File Plan, Kofax and more.

The table below shows types of nodes which can be added to various document types. The rows
indicate which nodes in the left column can be added. The columns indicate which nodes at the
top can contain.

Table 4.14.
File Article  Podcast Sample File Kofax Content Docume
node Plan documen folder folder
File <@ < V V V @ V V]
Article ,@, ,@ @ @
Podcast @ V] @ 9 @ @ @ <@
e @ ° ° ¢
File <@ V V @ V V]
Plan
Kofax <@ < 9 9 @ @ @
:i’lpemade" V) < & V V V V <
cnent @ © | © @ © ©
Pocument . g © © © © ©
‘ Note
1
-~

@' indicates that the corresponding document can be added into. A blank entry
means that the corresponding document cannot be added into.
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Following the horizontal, you will know which nodes can be added.

Following the vertical, you will know which node can be included.

Add a new document

1. Select afolder from the left pane where you want to add a new document.

Click “o #99<2m=t o0 the Action bar to open a list of content templates.
3. Click your desired template. See more details in Step 3 [46] of the Add a content section.

Each document (except Article) must be added to categories when being created.

Attach files to a document

1. select a document or a folder that you want to attach files, and click * urlead fils on the Action
bar.

The Upload File form will appear.

Upload File X
Mame &
Select Fil [ I
elect File ‘1— Click to select file
Categories List +

Save Cancel

2. Enter a name into the Name field. If not, the Name field is automatically filled with the file
name.

3. Click Browse... to select the attachment file. You can click ' to add more files.
4. Click Save to attach the files.

To view the attached file directly in Sites Explorer, simply click its name.
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I Maven_introduction.odp I.‘_ The ﬂle name DOWﬂ|Oad the ﬂle | Downiload this File

4 Page 1 of3ap] & @ [100% :| DR @ Save—qg, Save as PDF File

Open source integration
with Maven

http://maven.apache.org/

@ Note

eXo Platform enables you to view all types of documents, such as Open Office,
Microsoft Office in the PDF format.

Create a new File document

1. Follow the steps in the Add a new document[72] section to open the corresponding form
to add a File document.

2. Input a name for the file document in the Name field. Some special characters (@ # % & *
O)“" 5 [14/") cannot be used in the Name field.

3. Click the Mime Type field and select one type. There are three types of File document:

< text/html: when creating a text/html File document, you can input values like source code
(HyperText Markup Language HTML) in the Content field . After being created, it will
generate the content you want, then you can see both the input source code and the
generated content in that document.

« text/plain: after a text/plain File document is created, it will display exactly what you input
in the Content field.
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« application/x-groovy+html: it indicates your file as a groovy file.

4. Input a value in the Content field:

« text/html or application/x-groovy+html: if you want to create a File document with a

source code and generated content, click the E = putton in the Editor bar.

« text/plain: if you select text/plain type, the content field will be displayed like the following
illustration.

Name [ ]'

Calegories T

Mime Type | text/plain

(53

Language | en Z
Content
"
Title [ | &
Description l J-‘-
Creator l J_|_
Source [ ]-l-

5. Optionally, fill values in all the rest fields, including Title, Description, Creator and Source.
Click the plus icon to open more fields.
6. Click Save or Save & Close to accept creating a new file document.

After being created successfully, a file document with the text/ntml type will be displayed like
the illustration below.

| » \iew a5 HTML | * View a5 Plain text
Hard Work and Success - One Follows the Other

The common sense point here is simple -- and sobering for those who are looking for
career success shortcuts. Be willing to go the extra mile. Create custom resumes for every
job for which you apply. Once you get a job, work harder than others. Volunteer for
unpopular jobs -- and then do a great job. Yes, if vou want to become an outstanding
performer, it's important to be a lifelong learner, set and achieve high goals, and get
organized. But it's also important to do something a lot simpler -- and totally in your
control: be willing to work hard. Hard work will help build your brand and put vou at the -
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b ViewasHIML || = View as Plain text

Hard Work and Success - One Follows the Other%20

<p>The common sense point here is simple —— and sobering for those who are
locking for career success shortcuts. Be willing to go the extra mile.
Create custom resumes for every job for which you apply. Once you get a job,
work harder than others. Volunteer for unpopular jobs -- and then do a great
dob. Yes, if you want to become an outatanding performer, it&$39;s3 important
to be a lifelong learner, set and achieve high geala, and get organized. Buc
ic&$#39;3 elso important to do something a lot simpler -- and totally in your
control; be willing to work hard. Hard work will help build your brand and

put you at the top of the promotion list, and bottom of the layoff list.</p>

Create a new article

1. Follow the steps in the Add a new document[72] section to open the corresponding form
to add a new Article document.

2. Input name and title of the Article in the Name and Title fields. Special characters (@ # % &
*()"' o [14/1) are not allowed in the Name field.

3. Input values for both fields: Summary and Content.
4. Click Save or Save & Close to accept the inputted values.

After being created, your newly added Article document will be shown as below.

o qﬁ
MNew Features in Gateln 3.2 That Will Improwe the eXo Platform 3.5 Experience %@/

Summary

Cateln is the open source portal fram ework that serves as the backbone of eXo Platform, and the upcoming Gateln 3.2 will provide eXo Platform 3.5 with a set
of great portal features. Gateln 3.2 15 a logical evolution of the Gateln 3.1 release; the vision is to improve the project and continue the implementaton of
what we started with Gateln 3.0. In this post, | will describe a few of Gatein's numerous new features.

Content -

Navigation Controller
The navigation controller is a major change that could be summarized as the decoupling of URL expression and URL processing in Gateln. This means that

URLs processed by Gateln can be easily changed because they are now declarad in an XML file
Friendly URLs are now supported, giving the portal administrator freedom to configure how himp URLs should appear

44— Related documents

Amachments - = Uploaded files

47 Gatein Reference Guide en.pdf]

avg, Rating: 0.0 vores: 0 Remove uploaded files

The Links area lists all its related documents. After adding relations to a document, Article will
be displayed. You can click these links to view the content of the related documents. For more
details about how to add a relation to a document, refer to the Add a relation section.

The Attachments area lists all its uploaded files/documents which are attached with the Article.
You can remove the attachments by clicking @.

For more details about how to add an attachment, see the Attach files to a document[72]
section.
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Create a new Podcast

Follow the steps in the Add a new document[72] section to open the corresponding

Podcast form.

Name |

Categories

Title
Link

Author
Explicit
Category

Keyword
Publish Date

Language en

Description

Upload File

Mime Type  audo/mpd

Length

Details:

Table 4.15.

Field Description

Name The document name which is required.
Special characters (@ #% &*()“":;[1{}/)
are not allowed in the Name field.

Categories Categories of a document.

Title The display name of a document.

Link The link to the source path of the uploaded
media file that is required.

Author The author of the uploaded media file.

Explicit Itis used to indicate if your Podcast episodes
contain an explicit content or not.

Category The category of the uploaded media file, for

example music, film, or short clip.
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Once being created, a Podcast will be displayed.

Field Description

Keyword This field allows you to search your Podcast
files more quickly. You can use commas to
separate between keywords.

Publish Date The date when an episode was released.

Description Information about the uploaded media file.

Mime Type The type of the uploaded media file.

Length The length of the uploaded media file.

Input values for fields. To upload a media file, click Browse... and select the media file from

your device.

Click Save or Save & Close to finish.

Podcast: Proud of you
Title: Proud of you
Link: yvoutube.com
Author:

Explicit: no
Category:

Keywords: Proud, love
Publish Date: MNovember 28 2011
Mime Type: audio/mp3
Length:

Description:

My favorite song :)

Avg. Rating: 0.0 Votes: 0

Create a new Sample node

4.

Follow the steps in the Add a new document [72] section to open the Sample node form.

Complete the appropriate fields.

To upload an image, click the Browse... button and select an image from your computer.

Click Save or Save & Close to finish.

After being created, a new sample node will be displayed.

77



Chapter 4. Basic Actions

Node Name sample-node

Title Sample Node

Date November 28 2011

Date Time November 28 2011 10:20:15

Description Image

One of the best sight-seeings in Vietnam

Summary Content

The fresh and quite atmosphere. It is a good place to relax at weekend :)

Relations Attachments

The Relations area is used to list all its related documents. See the View relations section.
You can click the links to view content of the related document.

The Attachments area is used to list all its uploaded files. See the Attach files to a
document [72] section for more details.

Create a new File Plan

1. Follow the instructions in the Add a new document[72] section to open the corresponding
form to add a File Plan document.

Name Record Properties Process Properties

Name

Categories &

Language en -

File Plan Note

Details:

* The Name tab

Table 4.16.
Field Description
‘ Name ‘ The name of the file plan. ‘
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Field Description

File Plan Note

Categories The categories of your file plan. Select the
categories for your file plan by clicking *'.
Language The language of the File Plan document.

Note for presenting any other information
for users.

e The Record Properties tab

Record Category
Identifier

Disposition
Autharity

Permanent Record Tmue
Indicator

Disposition |
Instructions

Contains Records  True
older

Default Media Type  Bectronic
Default Marking List  None

Default Originating
Organization

Table 4.17.

Field Description

Record Category Identifier

The alphanumeric identifier indicates a
unique record category. This must be a
unique ID. If this field is left blank, it will be
created automatically by the system.

Disposition Authority

Permanent Record Indicator

A reference number to the regulations that
govern the disposition.

A type of record indicators which should
never be deleted.

Disposition Instructions

A readable guideline on how to handle the
records associated with the file plan.

Contains Records Folder

Default Media Type

Default Marking List

The confirmation is about whether the
records folder is contained or not.

The choice for preset media types which
are made available to simplify the data entry
for the record. The frequently-chosen value
is "electronic" or paper.

Handling and classifying information that
are printed at the bottom of the record, such
as UNCLASSIFIED or NOCONTRACT.
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Field Description

Default Originating Organization

Vital Record Indicator

This option is to enter the original
arrangement as default which is made
available to simplify the data entry for
the record and to assume that originating
organizations are the same for the
information in the file plan.

This flag is to allow tracking or reminding
you of the record as essential or not.

Vital Record Review Period

e The Process Properties tab

Name Record Properties Process Properties

Process Cutoffs  True
Event Trigger

Cutoff Period  One Minute
Cutoff on Obsolete  Tne
Cutoff on Superseded  Te
Process Hold Tre

Hold Period  One Minute
Discretionary Hold  Trs
Process Transfer Tnue

Default Transfer
Location

Transfer Block Size
Process Access The
Access Location

Access Block Size

Process Destruction  True

Table 4.18.

The choice for the interval of time between
vital record reviews.

Field Description

Process Cutoffs

Event Trigger

The Boolean data type is used to break a
process. If the process cutoff flag is set in
the file plan, the record is cutoff after the
expiration, or after it has been obsolete or
superseded, depending on the information
in the file plan.

The text data type is an automatic executing
code which is used to tell the event to
perform some actions.

Cutoff Period

Cutoff on Obsolete

The duration for the record cutoff

performance.

The record is cutoff when it is obsolete.

Cutoff on Superseded

The record is cutoff when it is removed or
replaced.
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Field Description

Process Hold

This boolean data type is used when a
record process may be held before the
further disposition is handled.

Hold Period

The duration when a record may be held
after cutoff which is normally measured in
Years.

Discretionary Hold

Process Transfer

The Boolean data type is used when a
hold may be discretionary, such as after
a command change. So, the discretionary
hold flag allows the records management
module to track these manual checks.

The boolean data type is used to determine
how a record process will be transferred.

Default Transfer Location

The text data type is used to determine
where a record is transferred by default.

Transfer Block Size

Process Access

Access Location

The float data type is used to determine
in what size blocks for organizational
purposes that is normally measured in
Years.

The Boolean data type is flagged when a
record, which is held permanently, must
be ultimately transferred to the national
records authority.

The text data type is flagged to specify an
area for the access transfer.

Access Block Size

The text data type is flagged to determine
the blocks size for organizational purposes
which is normally measured in Years.

Process Destruction

The Boolean data type is flagged if there
is any record to be destroyed. After that,
the record is marked in the Alfresco system
to be permanently destroyed so that all
information, metadata and physical traces
are removed and cannot be recovered.

2. Fill'in the appropriate fields of the tabs in the form.

3. Click Save or Save & Close to finish.

Create a new Kofax document
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4.

Follow the instructions in the Add a new document[72] section to open the Add Kofax
Document form.

Mame =
Categaries €
Language en -

Input a name for a Kofax document in the Name field which is required. Special characters
(@#% &*()"“":;[1{}/") are not allowed in this field.

Select categories for a Kofax document by clicking = .

Click Save or Save & Close to finish.

After being created, a Kofax document will be displayed.

File View Document View

Kofax Document Name Kofax Document

Downloadable File 21 Garden jpg

Avg. Rating: 0.0 Votes: 0

« The File View tab is used to display all added nodes in that Kofax. Besides, all added files in
Kofax are also displayed in the Document View tab.

Create a new event

5.

6.

Follow the instructions in the Add a new document[72] section to open the Add an event
document form.

Enter a title for the event.

Input the location where the event will take place in the Location field. Select the Google
Maps checkbox if you want the location of the event to be shown on Google Maps.

Enter the Start and End Date/Time of the event.
Fill the Summary and Content fields.

Click Save or Save & Close to finish.

After being created, the event will be displayed like the illustration bellow.

Paris MAY & MAY

-Bi 3 ' L]
eXo-Big Event .
eXo will attend the “Solutions Intranet et Traval Collaboratif™ event on May Sth and 6th in Paris.

eXo will ahend the “Solstions Intranset &t Travad Collaborati™ event on May Sth and Gth in Parts, Come to meet us to talk about Infranets and
Collaborative Solutions eXo i oflering. It also wil be a nice cpportunity 1o share aboul industry rends and new eXo develspments.
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4.6.4.3. Add a folder

You can create a document immediately in a specific drive. However, adding a document to a
specific folder enables you to manage documents better.

There are two types of folder:

» Content folder.

* Document folder.

&7 Documents
“-|_| Document Folder

_ Content Folder

In the default skin, the icon for a content folder node is displayed in blue and the icon for a
document folder node is displayed in yellow.

File and folder types in a folder

Content folder
+ Add a Content folder to a Content one.

* Add a Document folder to a Content one.

Add documents to a Content folder.

Upload files (images, MS Word documents, Open Office documents, .pdf files, .txt files, .xml
file, and more) into a Content folder.

« Import sub-nodes which were exported into a Content folder.

Document folder

Add a new Document folder to a Document folder.
* Add File, Podcast, File Plan documents to a Document folder.

» Upload files (images, MS Word documents, OpenOffice documents, .pdf files, .txt files, .xml
file, and more) into a Document folder.

e Cannot add a Content folder to a Document folder.
e Cannot import an exported Content folder into a Document folder.
« Cannot import an exported Article, Sample node, Kofax into a Document folder.

Create a folder

1. Select the path to create a folder.
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2. Click [ Add Folder on the Action bar. The Add Folder form is displayed:
’ Add Folder @I
Type  Content Folder ~ < Select folder type
Title  Travel w Req uired
Name  trayvel *

su

3. Select a folder type.

4. Input values for both Name and Title fields which are required. Special characters (@ # %
&*()"':;[1{/") are not allowed in these fields.

5. Click Save to accept creating a new folder.

4.6.4.4. Add translations to a document

This function enables users to add multiple languages for a document. This action is similar to
adding a language.

1. Select a document to which you want to add the translation. For example, select an Article
in English.
@~ Content
Bookmarks
Article Fr

2. Click ® addrransiation on the Action bar. The Symlink Manager will appear.

Symlink Manager Iz‘

Path Node @# Click
sove
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3. Click *, then browse to the target document that has different language with the first
document. For example, the Article version in French.

Select Document

Content Search Form Search Result

[=]

4 |Personal Drives + Personal Documents »  Private |#— The path to the node

Content Browser

Filter All

+- =] General Drives i Name Date Created Size
»-[B Group Drives Article En 28/11/11 04:56
. |- Article Fr | 28/11/1104:55
= Personal Drives
+ Personal Document:
= Private Click
+ Documents
+ Videos

4. After you have selected the document, click Save on the Symlink Manager form.

5. Select the document to which you have added the translation, then click the Relation button
on the Filter bar.

You will see the available language for the selected document. Click the language on this
pane to view the document in the corresponding language version.

& & O [[Private/articie-en | 4— The current node

Admin Action

Click to review gy
different language “©

add Content W Add Folder  [G] Delete [, EditDocument 3% Manage Actions i} Manage Audit

No Related Document
References List Article En
No Related Document

Summary :

All tems Relation
+ Owned by me
+ Favorites

+ Hidden

4.6.4.5. Add a Symlink

It is English

Content :

Content is empty

You also easily add a Symlink to a document. This function allows you to access your desired

documents quickly.

1. Select a node where you want to add a Symlink.

2. Click ¢ Addsymink o the Action bar. The Symlink Manager pop-up will appear.
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Symlink Manager x

Path Node A

Symlink Name *

Save Cancel

Details:

Table 4.19.

Field Description

‘ Path Node ‘ The path of a link.

‘ Symlink Name ‘ The name of a link.

Click *' to open the Select Target Node form.

4. Select the workspace which contains the node that you want to add a Symlink.

5. click @ in the row of the node that you want to add. The path that the node will appear in
the Path Node field and the name of the node is set by the name of the selected node. You

can also edit this name.

Symlink Manager x

Path Node collaboration:/Usersfi__fjo_ fish__fjohn/Priv i =+
Symlink Name  pLF user quide. txt.Ink =

Save Cancel

6. Click Save to finish adding a Symlink.

m= m it = @ < O[Private/content-folder J&— The current node
Personal Documents Admin Action
Folksonomy : @ rddTranslation P AddSymiink 4l ExportNode | 4l ImportNade & Manage Actions {3 Manage Audit
@[] Favorites
@ | Documents Name Date Created  Date Modified Owner

Document Folder &, PLF user guide.txt +— The Symiink added to the document  11/28/11 5:40 AM11/28/11 5:40AM  john
= Content Folder

- (@), PLF user guide.tit
& Content
i Bookmarks
Article Fr i

4.6.4.6. Comment

This function is used to comment on a document.

More ¥

Versionable Auditing

true false
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1. Select a document to which you want to add your comment.

2. Click % comment onbocument on the Action bar.
The Comment form appears.

3. Add your comment to the Comment field.

4. Click Save to commit.

The comments are shown at the bottom of the document.

= The best places for summer 2011

If you're on the lookout for a fantastic deal on summer holidays in 2011, you've come to the right place. With plenty of
low cost package holidays available, we've got something for everyone, Whether you're a couple looking to get away
for a relaxing break, a group of friends in search of some fun in the sun or & family planning a child-friendly trip
abroad, there are a host of cheap summer holidays on offer in 2011,

| || Content:

If you're on the lookout for a fantastic deal on summer holidays in 2011, you've come to the right place. With plenty of
low cost package holidays available, we've got something for everyone, Whether you're a couple looking to get away
for a relaxing break, a group of friends in search of some fun in the sun or a family planning a child-friendly trip
abroad, there are a host of cheap summer holidays on offer in 2011,

& Attachments :

Avg. Rating: 0.0 Votes: 0

Last comment posted by mary at 11.44 AM. Thu, Jul 14, 2014
1 Comment(s) Show comments

To view your comment, click the Show comments link:

Commented by john - Emall: john.smith@acme.exoplatform.com - 5:57 AM. Mon, Nov 28, 2011 (4 [
}

It's interesting :)

You can edit your comment by clicking = or delete it by clicking .
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4.6.4.7. Edit adocument

There are two ways to edit a document.

The first way
1. Select a document you want to edit in the left panel.

2. Click I Editpocument on the Action bar.

The second way

1. Select a folder that contains the document you want to edit.
2. Right-click the document you want to edit and select Edit from the menu.

The Edit Document form will appear. All information of the selected document will be
displayed in this form and ready for you to change except the Name field.

3. Click Save to commit your changes.
4.6.4.8. Export nodes
Nodes can be exported into either .xml or .zip file types.

1. Select a node that you want to export.

2. Click 'l BportNode o the Action bar to show the Export Node form.

Export Node x

Path to Export: /Users/j fio Jioh Jiohn/Private/Documents/plf-user-guide

Format: @ gystem View
) Document View

Zip: [
Export Export Version History Cancel
Details:
Table 4.20.
Fields Description
Path to Export The path of the node being exported. This
field will be pre-populated.
Format The format of the original node.
System View Each node and each property of that node is
included in a different tag.
Document View Each node is a tag and properties of that
node are considered to be elements of that
tag.
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Fields Description

Zip If this field is checked, the node will be
exported as a .zip file.

3. Click Export and select a location to save the exported file.

@ Note
The Export Node form can contain Export Version History if the exported
node or any of its child nodes is versioned.

This action exports all of the node's version history.

4.6.4.9. Import nodes

Nodes which are in the .xml file format can be imported into the JCR Explorer system.

1. Select the location where you want to import the new node.

Click & ImeortNode o the Action bar. The Import Node form appears.

Import Node x

Upload File:

UUID Behaviour:  Create New v

Version History:

Import Cancel

3. Click Browse... next to the Upload File field and navigate to the file you want to import.

4. Select one value from the UUID Behaviour drop-down menu, including:

Create New
If you select this behavior, the imported nodes receive new UUIDs which are completely
independent of any existing nodes. As the imported nodes get new UUIDs, there are
no UUID conflicts with the existing nodes in the workspace. The existing nodes in the
workspace are not moved, modified or deleted. The imported nodes are considered as
new nodes and therefore, do not have a version history. You cannot import a version
history for these nodes.

Remove Existing
If you select this behavior, the imported nodes in a selected path receive the same UUIDs
of the exported nodes. As the result, there is UUID conflicts with the existing nodes.
Therefore, the existing nodes are removed from the workspaces and the new nodes will
have the same version history as the existing nodes.
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6.

7.

Replace Existing

If you select this behavior, you only can import the exported nodes into their original
workspaces where they are exported. When the new nodes are created with the same
UUIDs of the existing nodes, causing UUID conflicts with the existing nodes in the
workspaces. Therefore, the existing nodes are replaced by the new ones in the same
location and the new nodes have the same version history as the existing nodes.

Throw Exception
If you select this behavior, there is a message which will alert that you can not import this
node in case this node has been existing in the workspace. If this node hasn't existed,

a new node will be created.

Click Browse... next to Version History to select a version to import.

Select a format.

Click Import to import the file's selected version.

4.6.4.10. Manage actions

4.6.4.10.1. Add an action

Select the node to which you want to add an action.

Click /% Manage Actions 5 the Action bar.

The Manage Actions form will appear.

Select the Add Action tab.

Manage Actions

Available Actions

Create Action of Type

Add/Edit Action

Name

Lifecycle

Metadata
Is Deep

MNode Types

Description

Affected Node Types

Add Action

exo-addetadataAction

User Action
Centent Addiion
Content Removal
Property Addiion
Property Removal

metadata steMetadata
W

Save

Back

90



Functions on action tabs

Details:

Table 4.21.

Field Description

Name The name of this action. This name is internal
to the JCR explorer.
Lifecycle Select the lifecycle for this action. The action

will be executed, depending on the lifecycle:

e 'User Action': The action is executed
when right-clicking the folder and then
selecting the action.

e 'Content Addition': The action will be
executed on a new document, but not
on a subfolder when the document or
the subfolder is created in the folder to
which an action has been added. Itis also
applied to a new document in the subfolder
of the folder.

¢ 'Content Removal': The action will be
executed on a document, but not on a
subfolder in the folder when the document
or the subfolder is moved.

e 'Property Addition': The action will be
executed on a document when a property
is added to the document.

e 'Property Removal': The action will be
executed on a document when a property
is removed from the document.

* 'Property Modification': The action will
be executed on a document when a
property of the document is modified.

* 'Schedule’: The action is done at specific
time.

If you need the same action to be executed
in several lifecycles, you have to create
several actions.
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4. Select one type for your action from the Create Action of Type drop-down menu.

exn-autoVersioning
exo:create RS 5FeedAction
exo :enableVersioning

e :get Mail Action
exnpopulate ToMenu

exo sendMail Action

o taonomyAction
o transform Binary To Texd Action
Details:
Table 4.22.
exo:AddMetadataAction Add metadata.
exo:autoVersioning Add a version automatically.
exo:createRSSFeedAction Create an RSS file.
exo:enableVersioning Enable versioning.
exo:getMailAction Fetch mails.
exo:populateToMenu This type is not supported.
exo:sendMailAction Send mails.
exo:taxonomyAction Create categories.
exo:transformBinaryTo TextAction Convert .pdf or .doc file types into plain text.

5. Complete all the fields in the form. The Name and Lifecycle fields are required.

6. Click Save to commit the action.

All actions of a node are listed in the Available Actions tab.

Once an action is added to a node, it is auto-added to any child nodes of the selected node.

If an action is added with the lifecycle named 'User Action’, it will be applied to the current node.
If an action is added with other lifecycles, it will be applied to the child nodes.

@ Note
Not all actions are listed in a right-click menu of nodes. Some actions can be
performed immediately when that action is added.

4.6.4.10.2. View actions

1. Open the Manage Actions form and select the Available Actions tab.

2. Click @ that corresponds to the action you want to view.
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The details will be displayed in the Action Info tab.

Manage Actions x
Available Actions Add Action Action Info
Action Name add action
Is Deep true

Node Type Names

Lifecycle node_added

Affected Node Types

Metadata metadata:siteMetadata

Description

Cancel

4.6.4.10.3. Edit an action

1. Openthe Manage Actions form and select the Available Actions tab.

Manage Actions x

Available Actions Add Action

Name Triggered Action Life Cycle Action
User action [exo:addMetadata,  User Action @
cl -
ose Edit

2. Click ¢ that corresponds to the action you want to modify.

3. Edit properties in the Action Form.

Edit action x

Action Form =

Name  add action

Lifecyele | Uger Action -
2
Contant Removal 3
Property Addtion
| Property Removal T
Metadata  metadata:siteMetadata -
Is Deep [

Node Types 3

Description

Affected Node Types + O

Save Back

4. Click Save to accept your changes.

4.6.4.10.4. Delete an action

1. Openthe Manage Actions form and select the Available Actions tab.
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Manage Actions x

Available Actions Add Action

Name Triggered Action Life Cycle Action
User action [exo:addMetadata,  User Action @ ¢ |m]
Close

Delete

2. Click @ that corresponds to the action you want to modify.

3. Click OK in the confirmation message to delete the action.
4.6.4.11. Manage auditing

This function logs property changes in nodes.

1. Select a node.

2. Click £ Men=0e Audit on the Action bar. The Activate Auditing message appears.

Activate Auditing x

Auditing has not been activated for this node.

Are wou sure to activate?

Activate Cancel

3. Click Activate to enable auditing on the selected node.

Click £ Manage Audit again to view the audit information of the selected node.

The Auditing Information list appears.

Auditing Information *

Operation Username Date Version

Property added john 09/30/2011 18:2217 No Version

Close

If the node has no audit information, the form will appear as below.

Auditing Information ®

Operation Username Date Version

Close
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4.6.4.12. Manage categories

4.6.4.12.1. Assign a category to a node

You can add categories to the document type nodes only.

1. Select the node to which you want to add a category.

Click “™===* on the Action bar.
The Add Category form appears.

3. Select the Select Category tab to show the available categories.

Add Category x
Referenced Categories Select Category
Category Tree  System -
Root Tree @
Name Add
t. :
H—- 5| cms
Lems = ©
g % | calendar ;
&g | calendar o @

Close

4. Click @ to add the corresponding category to the node.
The category, which has been added to a node, is listed in the Referenced Categories tab.
All nodes, which belong to a category, can be viewed as follows:

View a category

1. Goto the drive which contains the category you have added. There will be a list of categories
available.

2. Select your desired category. The documents in that category will be listed.
SO HThe selected category

acme-category 3 Add Category :v Add Content ¥ Upload Files ==\ Content Navigation
P Document Title Created Date  Author Last User Status
£ | Natural Elements
p " t Published
&2 IMovemenE [CL Time Travel 11/28/11 1:31 roo ublishe
[, Time Travel 7| | Bk speed 11/28/11 1:31 root Published
[ speed [k Flight 11/28/11 1:31 root Published
@[, Flight
@[ Ice
L Documents
[ Flight

@ Girn
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4.6.4.12.2. Delete a category

1. Select a categorized node.

Click L&momcamsn:

3. Select the Referenced Categories tab.

4. Click @ that corresponds to the category you want to delete.
4.6.4.13. Show/Hide a content

Nodes can be hidden or shown easily.

Hide a node

1. Select the node you want to hide.

2. Click [ Hide/show content on the Action bar to hide the node.
A confirmation message, which notifies that the node has been hidden, will appear.

Show a node

To show a hidden node, click [ Hide/show Content ggaijn,

4.6.4.14. Manage publication

This function is used to manage node publication.

1. Select a node (on the left or right pane) which you want to manage its publication.

2. Click ¥ Manace Publicatons o the Action bar.

The Manage Publication form appears.
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Manage Publication %

r
Rewvision ] History

Revision: 1
Status: ) )
U—0—u—0—«
Draft Pending Approved Staged Published
From To
Revisions Date Author | Status Action
Revision:The best places for Sep 29,2011 1:47:54PM  |john Draftjcurrent revision] | [C]
honeymoon
Revision'| Sep 20,2011 1:49:20PM  |john Published O &
N N
Save | ( Reset | Close |

The Revision tab displays some basic information and the current state of the selected node.

Click ¥4 to view the content of the node or click # to restore a version (refer to the Manage
versions section for information about versioning).

Select the History tab to view the publications history of the node.

Click Save to accept your changes.

Publication process

4.6.4.15. Manage relations

You can use this function to create relations between nodes.

4.6.4.15.1. Add arelation

Select the node you want to add a relation to.

Click &. Manseereitons: g the Action bar.
The Add Relation form appears.

Select the Select Relation tab to see a list of other documents.

Click @ that corresponds to the documents related to the document selected in the Step 1.

Documents linked to the original via a relation will be listed in the Relation List tab.
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A node cannot have a relation to itself.

4.6.4.15.2. Delete arelation

Select a node that has links to related documents.

Click the &. Mansa=Relstions |y tton on the Action bar.

Select the Relation List tab to view relations of the selected node.
Click T corresponding to the relation you want to remove.

Click OK in the confirmation message to accept your deletion.

The related document will be removed from the list.

4.6.4.15.3. View relations

Select a node that has links to related documents.

Click the relation button on the Filter bar.

= m i = @& < O |/Documents/pl-user-guide The selected
content
Private Admin Action

@] Proud of you o — -
H W7, Add Content |85 Add Folder
PLF user guide i

| note_for_doc.txt
E

Name

note_for_doc.txt

i [} Kofax document exa:actions

+[] eXo Big Event
; Article Fr

I
m &

] comments

Article En

[E]es—= Relation M

All nodes related to the selected node will be displayed in the left pane.

Languages List

Mo Related Document

Relations List

- PLF user guide.txt

References List

Mo Related Document

<= Relf@ation
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3.

Click the name of the related node to view the document.

4.6.4.16. Manage versions

46.4.16.1. Add versions to a node

1.

2.

3.

4.

5.

Select a node to add a version to.

Click ¥ Manase varsions g the Action bar.

The following message will appear.

Activate Version

Wersioning has not been activated for this node.

Are you sure to activate it?

Activate Cancel

Click Activate to enable a version for the node.

Right-click the selected node and select ChecklIn from the drop-down menu.

Sample Node

4| Song

] Proud of you

Wi note_for_doc.ts

PLF user guide

[l Kofax document

All Ttems

eXo Big Event
Article Fr

+ Owned by me

> Favorte:
« Hidden

&

Filter By Type

* Content
* Docume:

» Image

nt

% Add Translation
Name

Wi note for docbt

Copy
Edit
Cut

Delete

I = OV

Lock
[® chedan

#| Rename

Add Symlink
Paste

View Information

B® 0 il

View Document

Download And Allow Edition

K

User actio...

F Copy URL To Clipboard

Click ¥ Mene0versoms a9ain to open the Version Info window.

Version Info

plf-user-guide

@ Version: 1 (Base Version)

Close
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The node selected in Step 1 has been added as the Base version..

6. Right-click the node again and select CheckOut to obtain a version of this node.

4.6.4.16.2. Add/Remove labels for versions

Add a label

1. Select a versioned node.
2. Click ¥, en=s= v=rsons o the Action bar.

3. click “! icon on the Version Info window to show the Add Label field under the version list.

Version Info @

(=) plf-user-guide

& version: 1 (Base Version) Add labels—p@
Add Label
Label =

4. Enter a value into the Label field.
The label must be unique without containing any special characters, such as @, #, $.
5. Click Save to submit the new label.

Remove a label

1. Select a versioned node which has at least one label.
2. Click T Mansse versons o the Action bar.

3. click ©! on the Version Info window to show the Remove Label field under the versions list.
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Version Info %
! plf-user-guide
[@ Version: 1 [PLF, User Guide,3.5] (Base Version) @ [a
Remove Label
Select Label PLF, User Guids,3.5 - Remove labels

4. Select the label you want to remove from the drop-down menu.

5. Click the Remove button to remove the selected label.

4.6.4.16.3. View versions

1. Select a versioned node.

2. fick B Manase versons

3. Click @ to see the current versions of the selected node.

=] Version Info @
[ 7| eXo news M
&5 Version: 1 [important] [eXo] [news] [articie] viel & Om

(5 Version: 2 geanm
5 verson: 3 ganm

[ Version: 4 (Base Version) v/

= eXonews
Languages English

= Summary :

Document Management Systems (DMS) Overview -

|~ Content :

Document Management Systems (DMS) is the use of a computer system and
software to store, manage and track electronic documents and electronic images of
paper-based information captured through the use of a document scanner, The term
document is defined as "recorded information or an object which can be treated as a
unit”, Decument Management Systems allow documents to be modified and managed but
typically lack the records retention and disposition functionality for managing records. E
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4.6.4.16.4. Restore a version

1. Select a node which has at least two versions stored.

N

Click !D Manage Versions i
3. Select the version that you want to restore as the base version.

4. Click & to restore the selected version.

4.6.4.16.5. Delete a version

1. Select a node which has at least two versions.
2. Clle qg Manage Versions .

3. Click @ corresponding to the version you want to delete.
A confirmation message will appear.

4. Click OK to delete the version.

4.6.4.17. Multi-Languages

This function is used to add multiple languages to a document. Each document can be displayed
in many languages.

1. Select a document that you want to add languages.

2. C|ICk @Md!EditLooalisedComems on the Actlon bar

The Multi Language form will appear.

Multi Language @

Wiew Language Add Language

Language Engiishidefault) - *: Click to see the language list

( View j ( Set Default ) ( Cancel )
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The View Language tab contains a list of all languages. The default language for the
document will be automatically populated.

Select the Add Language tab. This tab will be displayed differently, depending on which file
you selected. However, the area where you can add languages to a document is the same.
The below illustration shows the Add Language tab for a Sample node file:

Multi Language x

‘iew Language Add Language

Language  Engish -
set Default () o= Tick to set the default language

MName
S This area is different
elect Fila Browse. - depending on the
content type
Save Cancel

Select a language you want to add from the Language drop-down list.

If the selected language has not been added to the current document, the content field will
be blank.

Select the Set Default checkbox if you want to set your selected language as a default
language.

Click Save to be returned to the View Language tab. Your selected language is now added
to the Language field.

You can view this document in your newly added language by selecting that language from
the Language drop-down list, then click the View button.

View the languages list of a document

Select a document that you want to view the languages list, then click the Relation button
on the Filter bar:

Personal Documents
FIoLures

- Music

| Folksonomy
#-| | Favorites

2~ Documents

m

|| Sample Node

2] Song

@] Proud of you
PLF user guide

I:|4-—— F;‘elat'ion

The list of language (and all related documents) will be displayed on the left pane.
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'.-muqm List

- en (Mola Cafe)

- en (Mola cafe)

- de (New)

- ar (Mola)

- en (Mola - Hanoi)

Relations List
- Best spots in Hanoi .odt

No related document

You can view the document in the new language by clicking the corresponding link in
Languages List.

For more details about Relations, refer to the Views relations section.

4.6.4.18. Overload thumbnails

You can overload a thumbnail image for a folder. Overloading allows a folder to be represented
by a thumbnail image, rather than a folder icon (see the Thumbnail view section).
1. Select the folder you wish to overload with a thumbnail image.

2. Click [&] ©verload Thumbnail op the Action bar.

The Add Thumbnail Image form appears.

Add Thumbnail Image x|

Thumbnail Image Browse_

( Save ) ( Cancel )

3. Click the Browse... button to select the image which will be used as the display icon for the
selected folder.

4. Click Save to accept your changes. The node will be stored in an exo:thumbnails folder.
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4.6.4.19. Request approval

If you want to publish one created content but not obtaining the 'Publish’ right, you must send a
request for approving your content.

1. Select the content that you want to send the request for publishing it.
2. Click the Request Approval button on the Action bar.

The content is displayed at the bottom of the Sites Explorer of the people who have the right
to approve contents.

4.6.4.20. Approve a content

When a content is created by users, it is possible to approve the publication if there is an approval
request. To approve a content, do the followings:

1. Select a content that needs approving.

2. Clickthe Approve Content button on the Action bar and the content is ready to be published.

Manage views

4.6.4.21. Publish a content

After the content is approved, it can be published by people who have the "Publish" permission.

1. Select a content that you want to publish.

2. Click the Publish Content button on the Action bar. The content will be published as the
schedule that you set up.
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Manage views

4.6.4.22. Show drives

This function enables you to show or hide all the drives in Sites Explorer.
To show drives, click & Show/Hide Drives gp the Action bar.

To hide drives, click & Show/Hide Drives gqain,

4.6.4.23. Show JCR Structure

This function allows you to view document nodes in a tree structure.

Show the JCR Structure

1. Select a document.

2. C||Ck E5j show/Hide Like ICR Structure Q[N the Act|0n bar

Hide the JCR Structure

1. Select a document which is showing the JCR structure.

2. Click ki show/Hide Like JCR Structure again_

4.6.4.24. Tag documents

A tag is a keyword or term associated with or assigned to a piece of information (a picture, a
geographic map, a blog entry, a video clip, and more). Each tag describes one item and enables
the keyword-based classification and search of information.

Add a new tag to a document

1. Select a document to which you want to add tags.
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Click ® Tag bocument g the Action bar. The Tag Manager will be displayed.

Tag Manager x

Tag Mames User guide {Seperate mutiple tags with the

Tag Scopes  Private -

Linked Tags content @‘— Remove tags

eXo
Add Tags Close

Details:
Table 4.23.

Field Description

Tag Names The tag names that users want to add tags
to documents.

Tag Scopes Classify the tags. There are four tag types:
private, public, group, and site. Currently, the
two first types are activated ("Private" means
that a user who creates tags can view and
edit tags; "Public" means that all users can
view and edit tags).

Linked Tags List all tags of a document after the Add
Tags button has been clicked.

Input a value into the Tag Names field. Several tags can be added to a document at a time.
To do that, input all tag names in the Tag Names field and separate by commas.

Select a value for the Tag Scopes field.

Click Add Tags to accept, or Close to quit. Only you can see this tag in this document.

Click T to delete tags.

Remove tags from a document

Select a document with tags that you want to delete the tags.

Click ® T2 becument g1 the Action bar to open the Tag Manager form.

Click @ corresponding to the tags you want to delete.

Click OK in the confirmation message to delete the tags.

107



Chapter 4. Basic Actions

4.6.4.25. Upload files into folders

This function allows you to upload a file from your device. All file types can be uploaded. Special
characters (! @ $ % & []) are not allowed.

1. Select the folder that you want to upload a file into from the left/right pane.

2. Click ** usload Files on the Action bar to open the Upload File form.

Upload File X
Mame &
Select Fil [ I
elect File [[Browse_ | @— Click to select file
Categories List +

Save Cancel

3. Browse and select a file on your device by clicking the Browse... button. The selected file
name will be displayed in the Select File field.

If you want to upload multiple files at the same time, click *' to open more Upload File forms.

Upload File §
Name
Select File LJ
Categories List = 2
Name %
Select File lmj Open more

Caregories List 5> Upload File forms

Save Cancel

Click Il to close a Upload File form.

To change the uploaded file, click I in the Select File field and select Browse... again to
select another one.

4. Optionally, type a name in the Name field which is not required. Special characters (! @ $ %
& []) are not allowed in this field. If not, the name of the uploaded file will be kept as original.
new name in

You can click * next to the Categories List field to select categories to which you want to
add this file.
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Add Cateqories [x]
=
Taxonomy Tree  Syslem -
m | Hame Action
$ 0 iloms /]
s e £ calendar ]
&% | Caendsr

i. Select a category in the left pane to open its child nodes in the right pane.

ii. Click @ corresponding to a child node that you want.

=] acd Categaries [x]
) calendar -
Taxonamy Tree  Sysem v

. | s pn
i Q&'Ihch'r 0

® Elarier S — ®
sElca | e /]
= e ©

= L pectns i other 9

% ] ersonal .-

. | O ° .

Manage categories

6. Complete uploading file by clicking Save.

After being saved, the main information of the uploaded file will be displayed.
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Upload File x
' Information |
File Name Node File Size Mime Type Manage
Name Metadata
o take-note- take-note- . 5
=l ecms.txt ecms.txt 45 Byte(s) text/plain @)

Clck

7. Optionally, click ¢ to see more details about its external metadata information. The List
External Metadata tab will be enabled and you can do some actions in this tab.

Upload File x|
Information List External Metadata ]
Metadata Name Action
& dc:elementSet &
( Add metadata ) ( Close )

* Click ¢ corresponding metadata that you want to edit.

¢ Click Add metadata to add more metadata to the uploaded file. Then, tick the checkbox,
and click Add.

Add External Metadata

x

_metadata:siteMetadata
_dc:elementSet

( Add ) ( Cancel j

The new metadata are displayed in the List External Metadata tab.

8. Click Close to quit the Upload File form.

After being uploaded, the tree is displayed in the left pane.
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4.6.4.26. View metadata

This function allows you to view metadata attached to File nodes, Podcast nodes, File Plan child
nodes and uploaded file nodes (nt:file nodes).

1. Select an appropriate node (nt:file).

2. Click [ viewretsdsts The view Metadata form appears.

View Metadata x
2011-08-08T09:26:38.000407:00 N/A
N/A N/&
Adobe InDesign CS5{7.0.3) Mac OS5 X 10.6.8 Quartz PDFContext
N/& N/A
N/A N/A 3
N/& N/A
N/A N/&

Add/Edit Cancel

3. Click the Add/Edit button at the bottom of the View Metadata form to add metadata.

4. Complete the desired fields in the Add/Edit Properties form. Click * to add further metadata.
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Add/Edit Properties

Title | ok
Creator +
Subject +
Source +

Contributor ek
Resource Type +
Date  11/29/2011 10:50:08
Publisher  exq pLatform £
Description +
Rights +
Relation +
Format +
Coverage +

5. Click Save to accept the new metadata values.
4.6.4.27. View node types

This function allows you to view the detailed information of a node.

1. Select a node that you want to view its detailed information.

2. Click & Vview node Tyoes to view detailed information about the selected node.

Properties Management

Froperties Add New Property
Name Multi Value Value Action
1 jer:primaryType x false nt:file
exo:datetime; exo:sortable;
exo:modify; mix:referenceable;
E)go:awneabla; _mi)c:ilEn;
W crmixinTypes v true mix:votable; mixicommentable;

exoirss-enable;
publication:authoring;
publication:authoringPublication;
mix:versionable

uE  jer:uuid x false ed6deDabc0aB01263ef076370631

[ exo:datecreated % false  549111-29710:46:00.999+07:0 4
[ exo:dateModified x false  5014.11-29T10:46:01.118+07:0¢ ’
|| exo:index % false 1000 V4
|| exo:language x false en r 4
[ excslastModifiedDate x false 2011-11-20T10:52:15.436+07:0C 4
| ] exo:lastModifier x false john 4
= w false A A P ==

3. Click the tabs at the top of the form to view categorized information.

4.6.4.28. View permissions

This function allows an administrator to manage the permissions for nodes.

m

m
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1. Select a node.

2. Click @& viewremissions The Permission Management form appears.

Permission Management x
User Or Group Read Add Node Set Property Remove Action
root true true true true rd
#/platform /administrators true true true true V4
#/platform /web-contributors true true true true V4
any true false false false V4

Add a permission to that node

User Or Group « 8 :'u. G‘
Read Right []
Add Node Right []
Set Property Right [
Remove Right []
Save Reset Close

By opening the Permission Management form, you can perform the following actions:

Add permissions

1. Add permission for specific users

i. Click @ next to the User Or Group field.

Select User Permission Select a user in a specific group Ed

Group:| fplatform/fusers % Usemame  ~ S

Username First Hame Last Name Email Action

demo Jack Miller jack miller®acme. exoplatform.com  SeleCt 8 USET g e

james James Davis james.davis@acme.exoplatform.com @

john John Smith john.smith@acme exoplatform.com @

mary Mary Williams mary williams@acme exoplatform .com @

root Root Root root@localhost @

i. Click @ next to the users to whom you want to grant permissions.

2. Select users from a specific group

< Enter a group name in the Group field at the top of the form (for example, /platform/users).
All users in the nominated group will be displayed.
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Or;

* Click “ beside the Group field to open a form that lists groups and their sub-groups. Select
a sub-group to add all users to that sub-group.

Select Group x
g platform
Select Group Select Child Group
-
' F /platform/administrators
s Development b /platform/guests

m

: 5 . »
& organization /platform/users

= & Platform
: & Administration
luﬂi Guests

- AR isitars

¥ /platform/web-contributors

3. Search for auser

i. Select an information parameter (Username, First Name, Last Name, Email) from the drop-
down menu in the other field at the top of the page and enter information into the textbox.

ii. Click “* to search for users matching with your selected information.

4. Add permissions based on memberships

i. Click & next to the User Or Group field.
The Select Membership form will appear that allows you to select users by membership.
ii. Select a group on the left pane, and membership types on the right.

5. Add all users/groups with read access

Click & next to the User Or Group field.

6. Select the permission you want to grant the selected users or groups by ticking the
corresponding checkboxes beside rights you want to add.

7. Click Save to accept your changes. The new permissions will appear in the permissions table
above.

Edit permissions

1. Select the permission of a user or a group in the table of list permissions.
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2. Click #.

3. Change the permissions as desired.

4. Click Save to accept your changed permissions.

Delete permissions

1. Select the permission of a user or a group in the table of list permissions.

2. Click T

3. Click OK in the confirmation message to remove the permission.

4.6.4.29. View properties

This function allows users to review all the properties and values of a node. It can also be used

to add values to a node.

1. Select the node you want to review or add values to.

2. Click & View Node Properties tg show the Properties Management form.

This form has two tabs:

Properties

This tab displays all properties and values for the selected node.

Properties Management

Properties #Add New Property

Hame Multi Value

FTl  jerprimaryType x false
W jermixinTypes o7 Ll
w  jeruuid x false
E exodareCreated x false
B exodareModified ¥ false
exoindex x false
exolastModified Date ¥ false
exolastModifier x false

[re1) exo.name x false
o) ax0oWREr x false
Fl  exopermissions v e

Value Action

axotaxKonomy

exo sortable, exomodify, exodatetime,
exo.owneable; exoprivilegeable,
mix:referenceable; exoactionable;
mix:wersionable

bicaeddaciadol sf0000e472bE8dF 143
2011-09-30T17:04:36.699+07:00
2011-09-30T17:04:36.700+07-00

1000

2011-09-30T17:04:36.699+07-00
__Eystem

events

__Eystem

& /platform fadministrators read. */platform

fadministrators add_node; */platform

Sadministrators set_property, . platform

Jadministrators remove, */platform

[web-contributors read, *./platform

fweb-contributors add_node; *-/platform

/web-contributors set_property, *./platform d
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Add New Property
This tab contains fields to add new properties to the selected node.

Properties Management x
Properties Add New Property
Namespace -
Name W
Type  Sting -
Multiple e -
Value W
B Ay
Save Reset Cancel

3. Select the Add New Property tab to add new properties to the selected node.
4. Select the namespace for the property.

5. Enter a name for the new property in the Name field.

6. Select the property type from the Type drop-down menu.

7. Enter a value for the property in the Value field.
To add multiple new values, click *' and repeat the above steps.

To remove a value, click .
8. Click Save to accept your new values, or Reset to clear all modified fields.

After you have made changes on new properties, you will be returned to the Properties tab. The
newly added values will be displayed.

In this form, you can edit a property by clicking ¢, or delete it by clicking .
4.6.4.30. View relations

This function shows/hides documents related to a selected node.

* View relations.

Select a node, then click & Show/Hide Relations  Dgcuments related to the selected node will be
shown in the Filter bar.

Relations List

- wiki_page_edit.png
- use_wiki.wiki
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If the node does not have any related documents, the message No Related Document will
appear instead.

Relations List

Mo Related Document

. Hide relation

Click &z Show/Hide Relations 44ain to hide relations.

4.6.4.31. Vote for a document

This function is used to vote for a document.

1. Open the document you want to vote for.

2. Click sy Vote For Document o 4he Action bar.

The Vote Document form will appear.

Vote Document @

Cancel

3. Rate the document by clicking the appropriate star level.

Vote Document @

W W W W

After a vote has been added, the rating will appear at the bottom of the document:

Awg. Rating: 4.0 Yotes: 1 f}j& 'ﬁ(ﬁ
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4.6.4.32. Watch documents

By using this function, whenever any change is made on the document, a notification message
will be sent to your email address. To receive that email, you must configure in your mail server.

Watch a document

Select the document you want to watch and click < watunwatch pocument,

The Watch Document form will appear. Click the Watch button to finish.

Watch Document %

Notification Type  Email -

Click =

=

Stop watching a document
Select the document and click ‘@ wstchunwstch bocument

A message will appear to confirm the action.

4.6.5. Manage content in Sites Explorer

Web content is a key resource which is used for a site. Other resources make a site more dynamic
and animated by using layout, color, font, and more. This section focuses on how to manage a
web content in a specific site.

4.6.5.1. Create a new web content

This function is used to add a new web content to a specific site.

1. Gotothe Sites Management drive, then select a site to which you want to add a web content.

2. Select the web contents folder on the left.
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Managing web content of a site becomes more easily.

You only may add a new web content in this folder so that you do not need to
select a web content document in the list of document types. It makes adding
a new web content more flexibly.

3. . = . .
Click ¥ 499 5omt=nt on the Action bar to open a list of content templates.
Select your template in the list below = |a:
- ¢ - -

C55 /O

Announcement Article C55 File Contact Us Event File File Plan Free layout HTML File

N P = . N - = — =N N
‘ ] e

Web Link applicatior
4. Select a template to present the web content by clicking one.

5. Enter values in the fields of the Add New Document form.

6. Click Save or Save & Close to save the content or Close to quit the Add New Document
form.

Tabs in the Add New Document form

The Main Content tab

Table 4.24.
Field Description
Title The title of a webcontent.
Name The name of the webcontent that you want to
add new.
Language The language of the webcontent. At present,
eXo Platform 3.5 supports two languages:
English and French.
Main Content The main content that you want to display when
publishing this webcontent.

The lllustration tab allows you to upload an illustration that makes the site's content more
attractive.
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Main Content Advanced

In this pane, you can specify an image that will be shown when your web content is displayed in the lists. In addition, you can specify some
summary texts to come with this image

llustration Image Browse.

Summary

5] Source B I U = (= iZ

» @& D] oma ® . 7 @

Details:

Table 4.25.

Field Description

Illustration Image The path to an image that you want to upload
into a site. This image will be used like an
illustration of that site.

Summary You can give a short description about the

webcontent because it will be displayed with
the illustration image when the webcontent is
listed. The main content will be shown when it
is selected to be viewed.

Upload an image

1. Browse a list of images on your local device by clicking the Browse... button, then select a
specific location.

2. Select an image in the list to upload.

The Advanced tab includes two parts: CSS Data and JS Data.
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Main Content lustration Advanced

CSS Data

JS Data

Details:

Table 4.26.

g In thiz pane, you can specify the
main stylesheet for your web
content. This style will override the
one defined at the site level and at
the shared level

In this pane, you can specify some
JavaSeript codes that can be
executed before your web content
is rendered

o

Field Description

CSS Data Contain the CSS definition to present data in a
webcontent. You can optionally enter CSS data
into this field to specify the style.

JS Data Contain the JS content to make the webcontent

more dynamic after being published. You can
optionally enter the JS content in this field.

4.6.5.2. Edit a webcontent

This function is used to edit a webcontent in a specific drive of an existing site.

1. Gointo the folder of a site which contains the webcontent that you want to edit.

2. Select the webcontent by double-clicking it on the left tree or on the right pane. The detailed
information of webcontent will be viewed on the right pane.

Click [ Edit Document 5 4he Action bar to show the form to edit the selected webcontent.

This form is similar to that of creating a new document.

4. Make changes on current values in the fields of this form.

5. Complete editing the selected webcontent by clicking Save or Save & Close.

@ Note
When you click Edit Document, the webcontent will be auto-locked for your
editing. After finishing, the content is back to the unlock status. You can manage

"Locks" in the

[207] section.
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4.6.5.3. Delete a webcontent

This function is used to remove a webcontent from the webcontent folder in a specific site's drive.

1. Right-click the name of the webcontent that you want to delete, then select Delete from the
drop-down menu.

2. Click OK to accept your deletion in the confirmation message.

4.6.5.4. Publish a webcontent

This function helps you publish a webcontent that you have added to webcontent folder in Sites
Explorer.

See the Publication process section to know how to publish a webcontent.

After the content is published, all users who have the right to access that position can view the
published web content as a page on the Navigation bar.

4.6.5.5. Preferences

This function is used to set up your browsing preferences.

1. Click & on the right side of the Sites Explorer portlet.

The Preferences window will appear.

Preferences x
Sort by Alphabetic - Ascending -
Show Sidebar Enable Drag & Drop
Nodes Per Page 20 -
Advanced
Show Non-document Nodes Show Referenced Documents ]
Show Hidden Nodes ] Enable DMS Structure ]
Query Type sQL -
Save Close
Details:
Table 4.27.
Field Description
Sort by Sort nodes in the nodes list by Alphabetic,
Type, Created Date, or Modified Date
‘ Show Sidebar ‘ Display/Hide the sidebar. ‘
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Field Description

Enable Drag & Drop

Enable/Disable the "drag and drop" action.

Nodes Per Page

This number of nodes displayed per page.

Show Non-document Nodes

Display/Hide nodes that are non—
documents.

Show Referenced Documents

Display/Hide referenced documents.

Show Hidden Nodes

Query Type
Enable DMS Structure

Display/Hide hidden nodes.
This query type.

Display/Hide nodes in a document the tree
structure.

2. Configure the preferences as required and click Save to set them;

Or click Close to quit without submitting changes.

4.6.5.6. Search in Sites Explorer

There are three ways to search an existing node:

* Quick search.
¢ Advanced search.

« Search with saved queries

4.6.5.6.1. Quick search

With the quick search, you can directly type a search termin the search field. All documents, whose
keywords are matched with the search term, are retrieved and listed in the Search results form.

1. Enter a keyword into the search text box.

Click “ to perform the search.

Or press Enter.

The search results will be displayed in the right pane.

Search keyword

tdh Add Category FC Add Content ? Upload Files l—\ Content Navigation

Type Name

exo:actions
exo:actions __system __system

Date created: 11/29/11 9:29 AM

= Path: /sites content/live/acme/categories/acme/exo:actions

Score Action

38 @
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The search results are empty if no document contains the search string.

Type Name

No results found.

3. Click @ to view the content containing the keyword.

Or click ‘= to go to the node that contains the search result.

4.6.5.6.2. Advanced search

Perform an advanced search

1. Click © on the Filter bar.

acme-category

[ New: Speed

[ New: Invisibility
i | Defense

[ Fire

[ Flight

Llce

i | Movement Click
&-4 | Natural Elements

[ Dala—mca NI CD B

2. Then click © to open the Advanced Search form.

<:| O [sites contem:j"\i\.rs:facme,ﬁ-’aebj]i)\~

»

m

Saved Searches Click jadvanced Search

= All Articles

+ Created Documents

* CreatedDocumentDayBefore location:
= allarticles Content Name

Search

All Items

Search by Name Advanced Search New Query

Saved Query

Search in this /sites content/live/acme/web contents

*

Cancel

Search Results

The tabs in this form offer different search functions:

» Search by Name

¢ Search with constraints

Search by creating a new query

Search by existing queries
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4.6.5.6.2.1. Search by Name

Use the Search by Name tab to search nodes by name as follows:

1. Enter the exact name you wish to search in the Content Name field.
2. Click Search.

Results will return with the message “No result found” if there is no node with the entered
name.

Results will be returned in the Search Results tab if the requested name is found.
4.6.5.6.2.2. Search with constraints
This search enables you to search with more constraints to limit the returned results.

Extra search constraints are entered in the Advanced Search tab of the Advanced Search form.

Advanced Search x

Search by Name Advanced Search Mew Query Saved Query Search Results

Current location fsites content/live/acme

Aword or phrase in | platfarm|
content l | | & Enter keyword

Cperator  And -

More constraints

Show/Hide Constraint Form Search Save Cancel

The Current location field is not editable. It shows the path selected to search.

1. Enter search terms in the A word of phrase in content field.

2. Select the Operator.

« Select AND operator to only return results that meet both the search terms and the entered
constraints (see Step 3).

« Select OR operator to return results that meet either the search terms or the entered
constraints (see Step 3).

3. Click Show/hide constraints form to add more constraints.

A further constraint options window will appear.

125



Chapter 4. Basic Actions

Operator; And = 1

|:| Property: Comﬁin Exactly: :

|:| Property: Comain: &
[Tl Property: Not Contain: ¢
[7] Created = From To 5
|:| Document Type: -f/ £
7

[] category: L_I.:'::.

Details:

Table 4.28.

Item Description

1 You can add more than one constraint with
either of two operators (AND and OR).

2 Add a constraint to search by a property with
specific values.

3 Add a constraint to search by a property
that contains one of the word in the specific
string.

4 Add a constraint to search by a property that

does not contain the specific string.

5 Add a constraint to search by a duration of
date (created, modified).

6 Add a constraint to search by a document
type, including File, Article, Podcast, Sample
node, File Plan, Kofax).

7 Add a constraint to search by categories.
) Add a document type.
% Add a category.

4. Select the constraint operator (AND/OR).

5. Add the required constraints using one of the following methods:

* Add a constraint for exact values [127]
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Add a constraint including or excluding values [129]

Add a constraint by date [130]

Add a constraint by document type [130]

Add a constraint by category [131]
6. Click Add to add any/all activated constraints.

The constraints will be converted to an SQL query and displayed in the search form.
Advanced Search x

Search by Name Adwvanced Search New Query Saved Query Search Results

Current location fsites content/live

Aword or phrase in
content

Operator  fAind -

More constraints { CONTAINS{dc:resourceType, Features of Platform’) )
and (jcr:primaryType = 'exoarticle’ or jerprimaryType = 'ntfile’ or jorprimaryType =
"exo:product' )
and {exo:category = ‘System/calendar' }

Show/Hide Constraint Form Search Save Cancel

Remove unnecessary constraints with the @ icon.
7. Click Search to launch the search. Results will be displayed in the Search Results tab.

8. Click Save and put a name for this search configuration if you want to save it to use at another
time.

4.6.5.6.2.2.1. Methods to add the required constraints

Add a constraint for exact values

1. Check the box that corresponds to the constraint you want.

2. Enter the property you want to locate or click ® .
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Operator; And -

|:| Property: ontain Exactly: 4’>
|:| Property: -@>C0ntain:
[ Property: -@>Not Contain:
[[] Created - From Ta
7] Document Type: )
|:| Category: ‘ =h
Add Cancel

A list of possible properties appears.

Select Property |

Metadata Type  dcielementSet -

@ dc.coverage
O deresourceType
! deicreator
5] dc:description
B dclanguage
B depublisher
B deisubject
) de:contributor
7 de:source
! derights
I detitle
7 dcdate
7 decrelation
O dcidentifier

7 deformat

Add Cancel

3. Select a property from the list and click Add. The selected property will populate Property
field.

4. Define the property value to search for by entering a value into the Contain Exactly field or

click the < icon.
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Operator; And -

|:| Property: -@>Contain Exactly:

[]Property: -@>Contain:
[C]Property: -@>Not Contain:
[[] Created + From [fe
7] Document Type: @
[ category: g BH]
Add Cancel

The Filter Form will appear.

Filter Form X

Filter: /,v>

Results:

Select Cancel

All pre-existing values for the property you selected will appear.

« If the value you require is in the list, select it and click Select.

If the value you require is not in the list, enter it in the Filter field and click the “ icon. The
value will populate the Contain Exactly field of the constraints form.

Operator: And

[¥]Property: de:title -@>Contain Exactly: How to join us /«v>
[ Property: -@>Contain:
[ Property: -@>Not Contain:
[] Created ~ From To
I:‘ Document Type: )
I:‘ Category: ‘: L]
Add Cancel

Add a constraint including or excluding values

1. Check the box corresponding to the Contain or Not Contain constraint, as appropriate.
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3.

Enter the required property in the Property field or click © (refer to Step 2 in the Add a
constraint for exact values [127] section for more information).

Enter the required values in the Contain or Not Contain fields.

Add a constraint by date

Click the check box beside the field with the drop-down menu (below the Property entries).
Define the search condition from the drop-down list (CREATED/MODIFIED).
Click in the From field.

A small calendar will appear.

Operator: And =

| Property: dc:title *’>Cnntain Exactly: How to join us *’>
Property: J>Contain:
Property: J\>Nnt Contain:
Created = From 11/20/2011 To|
4 2011 »
Document Type: )

Category: -4}. 1 2 3 & 5
Add Cancel 13 14 13 16 17 18 19

27 % 29 30

Select the date you want to use as a constraint.
Repeat the above steps for the To field.

The selected dates will populate the From and To fields in the Add constraint form.

Add a constraint by document type

1.

2.

Click the checkbox beside the Document Type field.

Enter the document type you want to search for or click ** to open a list of document types:
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Select Node Type x

kfx:document [ i
exochtmlFile [
exo:cssFile [
exojsFile []

exositeSearchBox [ | i
exo:pictureOnHeadWebcontent [
exowebContent [
exositeMavigationWebContent |:|
exositeBreadcrumb [

exolink [] 3
exo.contact_us |:|
exoannouncement [ |
exo:product [

Save Cancel

3. Click the checkbox of the document type you want and click Save.

The selected document type will populate the Document Type field.

Advanced Search x
Currentlocation fsites content/five -
A word or phrase in
content
Operator  And -

More constraints

Show/Hide Constraint Form Search Save Cancel
Operator: And -
| Property: de:title # »Contain Exactly: How to join us
| Property: % »Contain: =
| Property: # #Not Contan:
[7] Crealed « From 11/29/2011 Te 11/30/2011

| Document Type:  nt:file,exo:article, exo:evi <@
| Category: e

Add Cancel

Add a constraint by category

1. Click the checkbox beside the Category field.

2 Enter the category you want to search for or click ‘¥ for a list of categories:
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Add Category To Search x
Select Category
Category Tree  System -
Root Tree @
Name Add
t. -
H. § | cms
i |cms o @
H ¢ | calendar @

&g | calendar

Close

3. Click @ that corresponds to the category you want.
The selected category will populate the Category field.
4.6.5.6.2.3. Search by creating a new query

You need a knowledge of the structure of query statements to configure a search using the
parameters on the New Query tab.

1. Enter a unigue name for this query in the Name field.

2. Select a query type from the drop-down menu: SQL or xPath.

3. Enter a query statement.

4. Click Search to perform the search and display the results in the Search Results tab.
Or click Save to save the search query to the Saved Query tab.
Or click Cancel to quit.

4.6.5.6.2.4. Search by existing queries

This tab lists all saved search queries (that you have access rights to use).
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Advanced Search x
-~
Search by Name Advanced Search Mew Query Saved Query Search Results
Name Type Statement Permissions Actions
..cle}

[not(@jcrmixinTyp

All Articles xpath ‘exocrestorelocatic  =/platform/users i ¥
arder by
BexodateCreated
descending

m

.2 ="exoarticle’

ar

BjcrprimaryType

="nt:file’) and

Eexoowner="5{Us
Created and -
Documents - not{@jcrmixinType ST reTe &

'exorestoreLocatic
order by
®exo.dateCreated
descending

..cle}

[[®exodateCreate
“
xs:dateTime( §{Dat
and
CreatedNocumeant! whath notl@icrmivinTwne #fnlatform fusers [« ¥} i

* Click = to perform the search and see the results in the Search Results tab.

» Click ¢ to edit the query statement. The query form will appear like when creating a query (see
the Search by creating a new query section); however, you cannot edit the name of the saved
search.

* Click the I to delete a query (provided you have the access rights to that query).
4.6.5.6.3. Search with saved queries

Do the followings to perform a search with saved queries:

1. Click “ on the sidebar to see the list of existing queries.

Saved Searches i

= Al Articles
* Created Documents

* CreatedDocumentDayBefore

&

A query list will appear. It contains the sections, including All Articles, Created Documents,
CreatedDocumentDayBefore and allArticles.

= allarticles
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<0 () Jesncecmfqueries/All Articles - exn

Saved Searches 4 W, Add Content ¥ |ploadFiles == Content Mavigation

= All Articles

* Created Documents Twpe Name Score Action

Savec

> CreatedDocumentDayBefore *_Q‘r-‘?r\r‘hi' Release PLFLS

+ allArticles SEEETES release-pifas Aelease PLFLS john john en john lifecyclel draft Authoring publicatian ... e ™
. — Path: /sites i b oo 117115 pIFIS[2] L

Date created: 11/25/11 4:11 PM

Release PLF3S

- release-plf35 Relesse PLFLS john john en john lifecyclel draft Authoring publication ... aara
All Ttems Path: /sites content/live/acme/web contents/2011/11/29/ release-pif3s =
i Date created: 11/29/11 4:10 PM
* Owned by me PLF 3.5 release
john ifecyclel 2 ba172fc, published, john edase105c0a301 5 ‘48380, enrolled, john
* Favorites 3373
» Hidd 4 Path: /Users(i__/jo___jjoh___fjohn/Private/Documents/ plf-35-relesse
den Date created: 11/29/11 11:16 AM
Maondial Expo : Are you ready for the Future ?
rar By TyDe Mondial Expo : Are you ready for the Future root roct
Filter By Type
Little appreciated during his lifetime, his fame grew in the years after his death. Today, ... 3530
+ Content
Path: /sites ) web dy-for-the-future
+ Document Date created: 5/5/10 2:25 AM
+ Image Architecture and Design, the future of our products .
3+ Mugic root rook San Francisco, CA, United States en Architecture and Desion, the future of our products
™ li ot isi eni
+ Video ragna aliquam erat volutpat. Ut wisi enim ad ... 3530
Fath: /sites web co ign-th re-of-gur-products

Date created: 5/5/10 2:21 AM

2. Launch, modify or delete the queries as required (see the Search by creating a new query
section for more information).

3. Filter results with the entries in the All Items and/or By Type panes on the left of the tab.
Items matching the selections will appear in the right pane.

4. Click the required document or folder name to view or download them.

4.6.6. Actions on folders and documents

This section represents actions on folders and documents through the right-click menu (Adding
to favorites, copying, cutting, pasting, adding Symlink, locking/unlocking, viewing/renaming/
downloading document, and allowing edition and copying URL to clipboard) and other actions
(dragging and dropping folders or documents).

Depending on the actions on folders or documents, the right-click menu (drop-down menu) is
different.

The actions in the right-click menu for documents:

1§ Add To Favorite
(] copy

& Edit

4 Cut

Delete

5 Lock

Checkin

| Rename

[& Add Symlink

'@' View Information
|:| View Document
E8l Download And Allow Edition

|E_ Copy URL To Clipboard
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The actions in the right-click menu for folders:

&
(] copy
4t Cut
Delete

=) Lock

#| Rename

(e Add Symlink

l@l] View Information

E2l Download And Allow Edition

F_ Copy URL To Clipboard

4.6.6.1. Add to favorites

This function helps users easily add nodes (documents, folders or files) as favorite.

1. Right-click a node you want to add as a favorite.

2. Click = from the drop-down menu.

A symlink of your favorite nodes (folders, documents, files) will be created in the Favorite folder.

4.6.6.2. Copy/Paste & Cut/Paste
This function is used to make a copy of a node (including sub-nodes) to other places.
There are two ways to cut/copy & paste the node:

The first way

1. Right-click the node, then select Copy or Cut from the drop-down menu.

2. Right-click a destination node that you want to be the parent node of the copied/cut node,
then select Paste from the drop-down menu. Note that the Paste function is enabled in the
menu only after selecting the Copy/Cut action.

The copied/cut folder (and its sub-folders) will be pasted into the new selected path.

The second way

1. Right-click the node and select Copy/Cut from the drop-down menu.
2. Select the destination node that you want to be the parent node of the copied node.

3. Select the Clipboard icon on the Filter bar.

135



Chapter 4. Basic Actions

Personal Documents Admin
. @ note_for_doc.txt .g} add Conte
s Add To Faverite
®-3.f Favorites
-
[ Folksonomy
) (A Edit )
- Music Click
. Cut
B ricwes Rt e
& Searches M@ oelete
LB videos 2 Lock
ﬁ Public E CheckIn
i’i . L 3 q Rename
v E Add Symlink

All Ttems Clipboard [ Ppaste

* Owned by me View Information
+ Favorites View Document
» Hidden

E2 pownload And Allow Edition

Copy URL To Clipboard

The Clipboard window will appear.

Clipboard

Path Cm Act

Favorites | COPY L @

Soreiease o O @
# Clear all

.;’;'L@‘Q

4. Click U in the clipboard window to paste the copied/cut node into the selected destination
node in Step 3.

* You can click @ to delete a specific waiting statement.

You can also click the Clear All link to delete all waiting statements in the list.

After the action has been taken, a confirmation message will appear with detailed information
about the destination path.
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4.6.6.3. Edit documents
To edit a document, refer to the Edit a web content section.
4.6.6.4. Delete folders and documents

This function helps you remove folders/documents from their locations easily. Do the same steps
as in the Delete a web content section.

4.6.6.5. Drag and drop folders and documents

This function allows you to move folders/documents from a current location to another one by
using the drag and drop feature.

1. Hover your cursor over folders/documents in the right pane, or hold the Ctrl or Shift key to
select multiple folders/documents at once until the cursor changes to &,
2. Press the left-mouse button and drag the selected folders/documents.
m@‘.ﬁ m,;:. ==-, E ; m:u:‘ @30/ :c:'m futher fastfer —
EE acme i ﬁ categories 9430/11 5:02 PM
wi;j“:xu:a?_lm*::m I:e' ; events ;z:: :::: 9/30/11 5:04 PM
i |22 L = jo 02 BM 9/30/11 5:02 PM
GE;" =| [ Qe links :;:Z:: :;:zm 9/30/11 5:02 PM
g ks || F median 8 mediax 9/30/11 502 /30111 5:02°M
& gl wodias | B Platform User Guidé Platform U“'G"i%ﬁﬂl 2:19 PM john 10/3/1 2:%.“”9“ Mjohn Draft
7 pacforn i1, eh contents [ webcontents  g/ap1y so2pm  9/30/11 502
g ——
3. Drop theminto another folder in either the right or left pane by releasing the left-mouse button.

The "dragged" folders/documents will be relocated to the destination folder.
4.6.6.6. Lock/Unlock folders and documents

This function is to avoid changes on specific folders/documents and actions by others, during a
specific time.

Lock folders/documents
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Just right-click a folder/document (on either the right or left window pane) and select Lock from
the drop-down menu. The selected folder/document will be locked.

Unlock folders/documents

To unlock the locked folder/document, right-click it and select Unlock from the drop-down menu.
The folder/document will then be unlocked and other users can take actions on it.

4.6.6.7. Rename folders and documents

This function is used to change the folder/document name.

1. Right-click a folder/document that you want to rename, then select Rename from the drop-
down menu.

The Rename form will appear.

Rename @
Title  New: Invisibility .
Name zmme *

2. Input a new name in the Name field. You can also change the its title by entering a new one
in the Title field.

3. Click Save to accept your changes.

4.6.6.8. Add a Symlink

A symlink embedded into a node allows you to quickly access the node even if you are in other
nodes.
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 Right-click a document that you want to add a Symlink, and select Add Symlink from the drop-
down menu.

The symlink will be added to the selected document immediately. To view its content, simply
click the symlink.

4.6.6.9. View WebDAV

WebDAYV enables users to access files, folders, and read/write documents over the web. Thanks
to its benefits of easy, quick and flexible manipulations and time-saving, WebDAV is used to view
nodes.

1. Select the path of node you want to view WebDAYV or open that folder from the left/right pane.
2. Right-click the node and select Download And Allow Edition from the drop-down menu.

With each type of node, the form to view in WebDAV will be different:

L]

Folder: The sub-nodes list of the current folder will be displayed in WebDAV.
 nt:file: The content of the document will be shown.

« Article: This node type does not, by default, list any folders. However, if the Article includes
actions, added language or other data, all folders will be listed and named; exo:actions,
exo:language and so on.

< Podcast: Being viewed in WebDAV, this node type will be attached a form which must be
completed to download this document.

« Sample Node: This node lists folder names as exo:images. Like Article, if the Sample
node contains actions or added languages, folders will be named as exo:actions,
exo:language, and more.

¢ File Plan: This node behaves the same way as Article and Sample Node.

Kofax: This node behaves the same way as Article and Sample Node.

4.6.6.10. View information

eXo Platform supports you to view all information of a document, such as name, title, creator, and
publication state of the document.

» Toview information of a document, right-click the document, and select View Information from
the drop-down menu.

The View Information form appears as below.
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View Information b 4
MName events
Title avents
Type exotaxonomy
Owner __system
Last Modifier __system
Created Date 2011-09-30T17:04:365.609+07:00
Last Modified Date 2011-09-30T17:04:30.699+07:00
Close

4.6.6.11. View document

The View Document item is visible in the drop-down menu when you right-click a document. This
function allows you to view the document on another tab with the link containing the document
path.

» To view a document, right-click a document that you want to view, and select View Document
from the drop-down menu.

The document is opened in another tab.

4.6.6.12. Copy a URL to the clipboard

The Copy URL To Clipboard enables you to copy the WebDAV URL of a selected folder or a
document. You then can view it with the WebDAV view on a browser.

1. Right-click a folder/document, and select Copy URL To Clipboard.

2. Paste the URL on another tab.

= A 1o | htkpsfflacalhosb:a0e ecmdemsfrest-somd emafjorfrepositoryfcallaborationfUser ool /Private/Favoribes w
[~1 Gmail - Doc review -book_.. ¥ Cvemiew W Content Explorer # | WERDAY Browser X
ZI-—-— Up Lo Lhe rool node
[Eoozimentd— current node WebDAY URL of Lhe node

You can view the folders of the node you copied its URL or download documents to your
computer. You also view other nodes by clicking ... above the current folder to go up the root
node as below.

LARE i .E[I'tl e fncalhostR0a0/ecmdemeres-ecmdemn oy repositanycallabaration/Users roat/Private | -

. f :
Cherview H Content Explorer [ wEBD &N Bravser x |+

[ J— oot node

Diclments WebDAY URL af Lhe node
Favaries
Folksanoery
< Musi —— Folders
Piztures
SRArCIes
Witenz
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4.6.6.13. Manage tags

Tags are easily managed by editing or deleting them with the Tag Manager.

Edit atag

1. Click Tag Cloud on the Filter bar, then click ® at the upper-right corner of the tags pane.
Private Tags  Click —h®

user guide eXo PLF 3.5

Public Tags @
PLF 3.5 Symlinks
Ta§ Cléud —gm[ ®]
The Edit Tag form will appear.
- Edit Tag x
Hame Action
content 4
eXo #
User guide &

Click ¢ that corresponds to the tag you want to edit.

3. Edit the tag to your desires.

Tag

Tag Name  pntent #

Save Cancel

4. Click Save to accept your changes.

Delete a tag

1. Do Step 1 [141] from the procedure above.
2. Click m.
3. Click OK in the confirmation message to delete the tag.

Use your created tags
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1. cClick
You will see all existing tags which are listed and classified by private or public tags.
Private Tags ~ Click —he
user guide eXo PLF 2.5

Public Tags @

PLF 2.5 Symlinks

Tag Cléud —gim[ ®]

Depending on the popularity of tag, the display of each tag will be different from others by:
font-size, font-weight, color, font-family, text-decoration. For example, when a tag is added
to over 10 documents, it will be displayed in red color, size:20px, bold. This can also be
configured in the Manage Tag tab.

2. Eachtagis similar to a link which lists all documents that it is added. To display the documents
list in the right pane, click a tag name.

4.7. Manage content with WebDAV

What is WebDAV?

WebDAYV is an abbreviation of Web-based Distributed Authoring and Versioning. It is used
to publish and manage files and directories on a remote server. It also enables users to perform
these functions on a website.

WebDAV provides the following features:

Locking
This feature prevents two or more collaborators from overwriting shared files.

Site Manipulation
WebDAYV supports the "copy" and "move" actions and the creation of collections (file system
directories).

Name Space Management
This function enables copying and moving webpages within a server's namespace.

Why use WebDAV?
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With WebDAV, you can manage content efficiently with the following actions:

» Copy/paste content on your device and have those changes reflected in a host-based website.

« Manipulate actions on a website easily, quickly and flexibly without accessing it directly with
web-browsers. Files can be accessed from anywhere and are stored as in local directories.

» Easily and quickly upload content to a website simply by copying it into the appropriate directory.

4.7.1. Use WebDAYV in eXo Platform

To use WebDAYV in eXo Platform, you first need to have the Internet or Intranet connected. Next,

you can follow one of the two following ways:

The first way

You need to connect to the WebDAYV server. For example, for Windows XP, do the following steps:

1.

Navigate to the My Network Places on your local device. You will see all shared files and

folders:

2| My Melwork Places

o Folders  |HHE|-

Hedvanrk Tashs

uz A 3 peweTk plans:

‘.-:"; Wi nebmoni
canrechons
Setupa home or amal
aoffce retwore

,_f.-r Setup awinckss
netsore for & home or
amal pffiox

Py View varkgroup
campukers

M chow icons for
netsorees UPP
dEvioEs

Other Maces

[F Deskacp
5 My Conpater
(=} My Doauments

I Shared Doosments
Ga R 2 =
G Frirters and Fanes

L=

>

Zmeng 1= wuon mha on Mg

Finan Mza

Phusics om Duyiy

The: Tmlerrned

=%0 07 eXoerver cerper
[Barha, Lbunbi] (137, .,

Unspeciied

=

192, 1£8. 1. 20e¥o o EXasarser
sarvar (Samba, Ubori) (192,

/

i 8 1S

=%D an eXoSarver sErusr
{Sarrbs, Unynby] (Cxcservar)

mavEn-prIy on Ein e
e (S, Uhrhi) ..

Publcon Cuv

- ,} sxn-mrston Tawuyg

' Tk 01 hica
o

i Share on Hoanghm
...-E

Click the Add a network place link on the left to open the Add Network Place Wizard.
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Add Network Place Wizard X]

Welcome to the Add Network Place
Wizard

Thiz wizard helps you sign up for a senvice that offers online storage space.

You can use this space to store, organee, and shars your documents and
C) !

pictures using only 3 \Web browser and Intemet connechion.

You can also use this wizard to create a shortcut to 3 \Web site, an FTP site,
ar other netwark location.

To continue, click Mext.

3. Click Next to select a network location:

Add Network Place Wizard X]

Wwhere do you want to create this network place? N

Select 3 senace prowader. If you do not have 3 membership with the provader you select, the wizard will help
you create an account, [ojust create & shortcut, chek "Uhooss another network locabon.”

Sennce prownders:
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Select Choose another network location to create a shortcut.

Enter an address into the Internet or network address field.

For example, the address of the demonstration site Acme is htt p: / / myconpany. com 8080/
portal /rest/private/jcr/repository/collaboration/sites/content/live/acne.

Network Places directory.

p My Netwark Places

Fle Edit WView Favorites Tools Help

Q- O

O senn (vt [

Click Next. After a few seconds, a folder named acme on localhost appears in the My

Adress | S My Natvork Places

Local Hebawork
Nebtwork Tasks
d Acd & nebwork place [ seme on bcalhost
@. Wiew network comnections 2{:.
‘3 Setup a home ar small =
7 affioz network -:-rj Charg trai vuan =ha on Moa
<2 Setup awreless netwark L
far a hame or small offic= ——
iy View werkgroup compatens “
B Hide icons for networked { = testonlozahost
UPnP devices =
Other Places { ! dassic an locahost
[@' Dizsklop -
i My Camputer WRT54E
EJ My Dacuments
I3 Shared Documents
The Internet

'Zh_h Printers and Faxes

Details ¥

1'\
L/
-

elp on eXgSereer seryer
[Samba, Ubuntu] (192

f .."- acme on localbast [2)

; .) Musies an duylu
-
[F==]

_‘('.) Tirtt yeu ngot fgao o Maa
===

L 2

Iz onlocal - — -
hitp: flecathosizBIE] fportal frestjprivate fo frem

A

10 abjecis

Each site managed by WebDAYV appears as a folder in this location.

7. Take actions on the content in this folder to administrate the site content remotely.

The second way

This way can be done through Sites Management.

L Hover your cursor over * on the Administration bar, then select Content --> Sites
Explorer from the drop-down menu.

2. Click the Drives button, then select Sites Management.
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FO Add Content ¥ Upload Files ==, Content Navigation Drives button —kEl

* GENERAL DRIVES

&) acme-category ) collaboration %) default-category 3 intranet-category k) Sites Management [ Trash

¥ GROUP DRIVES

) | developers =y / organization / y / organization / =y / platform / =y / platform / users . / platform /
employees management / administrators web-contributors

executive-board

» PERSONAL DRIVES

Personal Documents 4 Private Ll Public
== = =]

You will see all sites listed in the left sidebar.

Sites Management

™ acme

W default
W intranet

- [ shared

3. Right-click the site you want to view with WebDAV and select the Download and Allow
Edition item in the menu.

The selected site will be shown in WebDAV.
Eile Edt Mew Higtory EBookmarks Tools Help

o c £ | | hetp/lccalhestB0B0 scrmdemoyTest-ecmdemcyjorrepositany/oollaboretionssites con 7+ | [ WP Yohoo

ApplicationDana
I.'ill.l!':JI.ﬁll':!!i
CBS
documents
ijs
links
J madias
web contents

| Mg
In this view, you can access documents in the directories that are linked to the web server.

4.7.2. Add new content to a specific site

This function enables you to copy web content, such as an .html file, from your local device to
a web content folder of a site.
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1. Access a site via WebDAYV (refer to the Use WebDAV in eXo Platform section), then go to
a web content folder of the site.

2. Copy the web content on your local system into this folder.

The copied file will be converted to web content that is viewable by WebDAV automatically.
The content is converted to a directory containing CSS, documents, js and media.

After a new content is added, it can be viewed as a folder in WebDAYV or as a page content using
a web browser.

4.7.3. Delete a web content
This function enables site administrators to delete web content files separately or in batches.

1. Navigate to the folder that contains the content you want to remove.

2. Right-click the content files or directories (hold the Ctrl key to select multiple files at once),
and select Delete from the drop-down menu.

3 bai4nbreak-my-heart.html

W laura-pausiniHt-s-
(_Jsite artifacts Open
_1Word-to-000.htm Explors
Send To »
Cut
Copy

Create Shortout

-

Properties

The selected files will be removed from the site.

eXo Platform provides the Newsletters service, aiming at helping users quickly get the updated
newsletters from a website.

4.8.1. Newsletter viewer

@ Note
The Newsletter portlet is deprecated in eXo Platform. It remains fully supported for
eXo customers, however it will not receive any enhancement and will be removed
from the product scope in the future.

With Newsletters, you can instantly get newsletters from your email to update the last information
about categories and subscriptions.
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Subscribe your email to get newsletters from eXo Service.

1. Goto Newsletters on the Navigation bar. The Newsletters page will appear.

i T
four Email |john.smith@acme.exoplatform.com |q_Enter your email
| General General information about us
Subscription Check to subscribe
I"l' how to use your new cn ) el :\'. Wers
Le nore ab: o ]
|| Corporate Wou want to know where we are, where we go 7
Subscription Check to subscribe

y newsletter about our financial results and forecasts

Subscnbe

2. Enter your email address in the Your Email field.
3. Select the checkbox corresponding to the subscription that you want to get newsletters.

4. Click Subscribe. A message informing that you have just subscribed to the selected
newsletter will appear.

5. Click OK in the confirmation message. You can reselect the subscription that you want or
do not want to receive newsletters by re-selecting the checkbox in the Check to subscribe
column.

6. Click Change your subscriptions to update your changes.

7. Click Forget this email if you want to unsubscribe from newsletters.

4.8.2. Newsletter Manager

@ Note
The Newsletter Manager portlet is deprecated in eXo Platform. It remains fully
supported for eXo customers, however it will not receive any enhancement and
will be removed from the product scope in the future.
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eXo Platform facilitates administrators to easily and quickly manage newsletters.

To use this portlet, you first need to add it to a specific page by dragging and dropping Newsletter
Manager from Page Editor to the main pane. This can be done when creating a new page or
editing an existing page or editing the layout of a portal.

b:l Page Creation Wizard: FRe-arange the Page Layout and add Porters 1o the Page. = Page Editor = B )
ey 1
 Integration |
== Newsletter Manager Mavigation |
|

Newsletter
j Newsletter

1 —| Newsletter Manager
Drag & Drog -

' PlasformMavigation
pall
Search

|
|
|
SEQToolbar |

Sreanl
(i viewPage properties | | Switch View Mode |
N A A\E A

Access the page with the Newsletter Manager portlet to open the newsletter page.

newsletter

fEmy Mew Letter |@ New Subscription | New Category | g Manzge Users |

% | General General information about us

Subscription Number of User Pending Letter
acme Trainings 1 0
3cme Mewsletters 3 0
E Corporate You want to know where we are, ...
Subscription Number of User Pending Letter
Results 2 0

4.8.2.1. Manage categories in Newsletter

This section shows you how to manage categories in a Newsletter page, including:

e Add a new category
« Edit a category

* Delete a category
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* Manage users

4.8.

2.1.1. Add a new category

Click New Category on the Action bar of the Newsletter page. The Create New Category
form will appear.

Create Mew Category x
Mame Fag *
Title Fag *

Description The guestions related to the product....

Moderator manager: jplatform *E &
Save Cancel
Details:
Table 4.29.
Field Description
Asterisk (*) This mark next to each field means that it is
required to enter values into that field.
Name The name of a category.
Title The title of a category.
Description A brief description of the category.
Moderator Select users/groups who have rights to
manage this category.
Save Accept the addition of a new category.
Cancel Quit the category form without adding a
category.

Input values into fields.

i. Select a moderator for a category by clicking @ next to the Moderator field to select a user.
The User Selector form will appear.
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3.

User selector

Group:

demo
james

john

root

First HName
Jack
James
John

Mary

Root

Last Name
Millar

Davis
Smith
Wiliams

Root

Usemame

Email

jack.miller@acme.exop
james.davis@acme . exc
john.smithi@acme.axo|
mary.wiliams@acme.e

root@localhost

* Click @ corresponding to a user in the list that you want to select.

ii. Click & to select users in a specific group. The Group selector window will appear.

Group selector

& platform

Select Group

t
&-

- developers
:.ﬂi organization
:.ﬂ:, platform

:.ﬂi administrators
:.ﬂi guests
ml-m- LIcAre

m

Select Mermbership

mermber
author
editor

manager

k redactor

validator

W=

-

| »

m

« Select a group from the left pane and a membership type from the right pane.

The membership and group selected will be displayed in the Moderator field.

Click Save to accept creating a new category.

You will see your added category in the list of categories.

o
=

000 Olg—

x

« After creating a category, you can create new subscriptions or newsletters for this category.

* When clicking the Administration button, you will see a drop-down menu consisting of all
actions on this category.
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4.8.2.1.2. Edit a category

1. Select a category that you want to edit.

2. Click Administration --> Edit Category from the drop-down menu.

newsletter > FAQ

@ Mew Letter | (&b New Subsaiption |

| &1 Faq |Thequeﬂ:i:nsrelabedwﬂlep... Click '=.l
Subscription Number of User Pending Letter ]

€XO powered by eXo Platform v3.5.0-Beta2-SNAPSHOT - build 20111004 - rev. 74565

The Create New Category form appears.

3. Change the values in the Title and Description fields as required.

4. Click Save to save all changes.

4.8.2.1.3. Delete a category

1. Select a category that you want to edit.

2. Click Administration, then select Delete Category from the drop-down menu.
3. Click OK to delete the category.

4.8.2.1.4. Manage users

Administrators can manage users accounts and activities with actions, such as editing, banning,
removing bans, or deleting.

1. Select a category that you want to edit.

2. Select Administration --> Manage Users from the drop-down menu.
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1| FAQ The questions related to the p ... 1 Administration |
Subscription Humber of User Pending Letter &l

2 Edit Category

|
Delete Category
e)(.; Powered by eXo Platform v3.5.0-Beta2-SHAPSHOT - build 20111004 - rev. 74565 ——————
6 Open
2 Edit
Delete
:
The Manage Users form will appear.
Manager Users x
Email Banned
john.smith@acme.exoplatft  false E. % |
john@exoplktform.com false EI % ]
john@grmail.com false 2 E
john@gmail.comn.fr false El % |
rock@yahoo.com false 2 ZE
Close
Details:
Table 4.30.
Field Description
Email The email address of user who has
subscribed this subscription.
Banned This field has two values:
False
The user is allowed to get email.
True
The user is not allowed to get email.
E Ban this user from receiving emails.
E Remove a ban on a user.
Delete the user.

3. Click Close to close the form.
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4.8.2.2. Subscriptions

Administrators can add more subscriptions to any category via two ways as follows:

The first way

1. Click New Subscription on the Action bar.

newsletter

By New Letter | {5 New Category | i Manage Users |

The Create New Subscription form will appear.

Create New Subscription o
Selecta
Category |General - “— category
MName &
Title =
Description
Redactor *8 &
Save Cancel
Details:
Table 4.31.
Field Description
Asterisk (*) This mark next to each field means that it is
required to enter values into that field.
Category The category which contains this
subscription.
Name The name of the subscription.
Title The title of the subscription.
Description The brief description about the subscription.
Redactor Select users/groups who have rights to
manage this subscription.

2. Click the Category field and select a category from the drop-down menu.
3. Enter the rest of their values in the form.

4. Click Save to create the new subscription.
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The second way

1. Click directly the category to which you want to add a new subscription.

newsletter > FAQ

G New Letter | [k |New Subscription

FAQ The questions related to the p ... Administration

Subscription Number of User Pending Letter

2. Click New Subscription on the Action bar.

The Create New Subscription form pops up.

Create New Subscription b 4
Category | FACQ
Mame *
Title *
Description
Redactor *B &
Save Cancel

3. Do the same steps (3, 4) as stated in the first way [154].

< Administrators can create newsletters for each subscription.

» These Newsletters can be opened, edited, deleted or converted to a template for reuse.

% | acme Newsletters Learn more about our offers Moderation
Letter Date Status O

Basic Template Nov 29, 2011 draft ]
Release PLF 3.5 Nov 30, 2011 draft =

Details:

Table 4.32.

Element Description
‘ Shoes The name of the subscription. ‘
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Element Description

Fashion Shoes The brief description about the subscription.

Letter The list of all letters of this subscription.

Date The date and time when creating this
newsletter.

Status There are three types of status: draft, awaiting
and sent.

Moderation This button allows you to take actions on your
selected newsletter.

4.8.2.3. Open a newsletter

Administrators can easily view the content of a newsletter as follows:

1. Open the subscription containing the letter you want to open by clicking it or checking the

corresponding box and then selecting Administration --> Open.

newsletber > FAQ

i;"ﬁ New Letter | | & MNew Subscription

FAQ The questions related to the p ...

Subscription Number of User

Resuls 0

2. Directly click the newsletter;

Pending Letter

0

Administration z

]

Select —®(@ &

Or, select the checkbox corresponding to your desired newsletter, then click Administration

--> Open.
ﬁ New Letter

Results Monthly newsletter about our f ...

Letter Date
Basic Template Oct 6, 2011
Releass Platform 3.5 Oct 7, 2011

Status
draft
draft

:

:
7 Edt
il Delete

E] Convert As Template

The View Newsletter's Content form pops up.
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View Newsletter's Content »

]
5]
o
i
[}

About us : Virtualize your Desktop
Quisgue digr
Lorern ipsum dolor sit amet, . Sed at erat. Phaselus condimentum. Mullam sed magna. Donec quis tellus in neque
congue porttitor. Proin sit amet ligula id leo porta rutrum. Lorem ipsum dolor sit amet, consectetuer adipiscing elit. In suscipit, pede a
rutrum malesuada, lecus massa evismod neque, a hendrerit justo ante at eros.

Follow your path
Quizque digr
Lorem ipsum dolor sit amet, . Sed at erat. Phaselus condimentum. Mullam sed maagna. Donec quis tellus in neque
congue porttitor. Proin sit amet ligula id leo porta rutrum. Lorem ipsum dolor sit amet, consectetuer adipiscing elit. In suscipit, pede a
rutrum malesuada, lacus massa euismod negue, a hendrerit justo ante at eros.

How-to: Create your own template
Quizgue digr
Lorem ipsum dolor st amet, . Sed at erat. Phasellus condimeantum. Mullam sed maagna. Donec quis tellus in neque
congue porttitor. Proin sit amet ligula id leo porta rutrum. Lorem ipsum dolor sit amet, consectetuer adipiscing elit. In suscipit, pede a
rutrum malesuada, lacus massa euismod negue, a hendrerit justo ante at eros.

sim dictum ante

=im dictum ante

=im dictum ante

Close

3. Click Close to exit.

4.8.2.4. Edit a newsletter

1. Select the newsletter you want to edit by ticking the relevant checkbox in a specific
subscription.

2. Click [ Moderaton , then select Edit from the drop-down menu.

1
ﬁ“ Open

Edit z
Delete

[Z) convert As Template

The Newsletter Entry pops up.
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Newsletter Entry

Template :  Basic Templsie -
Send Date :  10/04/2011 15:15:44

Caktegory ererel
Subscrption 1 | acme Mewsletien
Update Sending Parameters
Main Content Iustration Advanced
Tithe  gasic Template -
Name  basic-template -
Language en -
0 - | I 1 =1 Iy — -
Main 5] Source B] f o 55 @ T ] G B 3 3
Content T . -
B I Use | EEFE| i = - A 2 £ dd_a [

Your Company

About us : Virtualize your Desktop

Lorem ipsum dolor sk amet, consectetuer adipiscing elt. Sed at erat. Phaselus condimentum. Nulam sed magna.
Donec quis telus in neque congue porttior. Proin sit amet liguls id ko porta rutrum. Lorem ipsum dolor sit amet,
consectetuer adipiscing elit. In suscpit, pede a rutrum malkesuada, bous massa eusmod neque, 3 hendrert justo
ante at eras. Cickitus haritus,

3. Change the values in the fields that you want to edit: Template, Send Date, Category,
Subscription.

4. Click the Update a Newsletter's info button.

5. Change values in the Title and Main Content fields.
6. Click Save to save as draft, or click Send.

4.8.2.5. Delete a newsletter

Administrator can delete obsolete newsletters.

1. Inaspecific subscription, select the newsletter you want to delete by ticking the corresponding
checkbox.

2. Click | Mederztion | then select Delete in the menu.
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!
= Open
2 Edit
:

E] Convert As Template

3. Click OK in the confirmation message to accept your deletion.
4.8.2.6. Convert as template

The administrator can reuse the template of the frequently used newsletter template.

1. Select the newsletter that you want to create as a template.

2. Click (Moderaton , then select Convert As Template from the drop-down menu. For the next
time when you create a newsletter, this template will be listed in the Template field in the
Newsletter Entry form.

4.8.2.7. Create a newsletter

Each subscription consists of many newsletters. In eXo Platform, you can easily create
newsletters by following these steps.

1. Select a subscription where you want to create a newsletter.

2. Click % === on the Action bar. The Newsletter Entry form appears.
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Newsletter Entry

Template :  Basic Templsie -
Send Date 1 10/04/2011 15:15:44

Category : Erers
Subscription :

Update Sanding Parameters

Main Content Iustration Advanced

Title  Basic Template =

Name  basic-template =
Language en -
0 ] 1 3 == A — —
Main 3| Source B] f o 55 @ SO 0h @
Contant — — =
B I U o EEEE iz = * AT @ £ .}iﬂ =
- - v '|:_J-f

Your Cormpany

About us : Virtualize your Desktop
Lorem ipsum dolor sk amet, consectetuer adipiscing elt. Sed at erat. Phaselus condimentum. Nulam sed magna.
Donec quis telus in neque congue porttior. Proin sit amet liguls id ko porta rutrum. Lorem ipsum dolor sit amet,
consectetuer adipiscing elit. In suscpit, pede a rutrum malkesuada, bous massa eusmod neque, 3 hendrert justo
ante at eras. Cickitus haritus,

Details:
Table 4.33.
Template The template for your newsletter form. Basic
Template is set by default.
Send Date The date and time to send the newsletter.
Category The category contains this newsletter.
Subscription The subscription contains this newsletter.
Update Sending Parameters This button allows you to update information
about this newsletter.

3. Click the Template field to select the template for the newsletter.

4. Click the Send Date field. The calendar will appear, allowing you to select the date and time
when you want to send the newsletter.
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16 17 18
23 24 25
30 31

16

Ln

12
19
20

108:

- 2011 »

—
n
(93]

12 14 15
20 21 22
27 28 29

5. Click the Category and Subscription to select the category and the subscription in the list.

6. Click the Update Sending Parameters button to update information about this newsletter. A
message pops up and informs you that you have updated information successfully.

7. Input a title of a newsletter into the Title field.

8. Create a content for a newsletter by inputting information into the Main Content textbox.

9. Click Save to save this newsletter as draft, or click Send to send this newsletter.

4.9. Manage contents with Fast Content Creator

The Fast Content Creator portlet in eXo Platform enables you to quickly create and save a new
document with only one template in a specific location without accessing Sites Explorer. This
helps you save a lot of time when creating a new document.

There are two modes in Fast Content Creator: Content Creator and Standard Content Creator.

The Standard Content Creator mode allows you to add an action to your document. When
Configuring Fast Content Creator, the Edit Mode tab has the Actions part that allows you to add
an action to the document and view actions added to the document.

Edit Mode Portlet Settings Select Icon Decoration Themes

Actions

Redirect [
Redirect Path http:/jwww.aoogle.com.vn

Access Permission

[ Action:

Add

Name Description TInstance of Action

Add action

m

Save

Close

To add an action to a document, click Add or & to open the Add Action form. Do the same steps

in the Add an action section.
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To use the Fast Content Creator portlet, you need to add it to a specific page first by dragging
and dropping Content Creator or Standard Content Creator from Page Editor --> Applications
--> Forms to the main pane. This can be done when creating a new page or editing an existing
page or editing the layout of a portal.

- Poge Editor B
''''' D Faq
Form Generator Portlet

o

3 WeEw Page properties

Switch View Mode

4.9.1. Configure Fast Content Creator

In eXo Platform, the Fast Content Creator is applied in the Question? portlet with the Content
Creator mode by default. Thus, in this guide, you are instructed how to configure the Fast Content
Creator by editing the Question? portlet as an example.

~ Page Editor B x
Applications Containers
Homepage
hdderin
KO ECM Admin
& Contact U Z <] \
TontacT us / Xy
Adeiiisty stion
e Collaboration

Contants
Contraller

Dashboard

ECM

Fag

Form Generator Portlet

Forms

& View Page properties

Switch View Mode

1. Open the Question? page.

2. Hover your cursor over Edit --> Page, then click Layout on the Administration bar.
The edit page appear.

3. Hover your cursor over the portlet, then click ¢ to edit the portlet.

The form with the Edit Mode tab appears.
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4.

Select Icon

Edit Mode Window Settings

Decoration Themes

Access Permission

—Save Location

Location to Save fsites content/live/acme/documents

& 8

—Template Options
Select Template Cortact Us

Custom Save Button send

Custom Save Message Your comment has been received. We
appreciate your feedback,

Redirect

Redirect Path fortalfpublic/zcme fcontactus/confirmation

m

Close

Details:

Table 4.34.

Field Description

Location to Save

Select Template

Select the location to save documents or
messages.

Select a template for the document. There
are different input fields corresponding to
each selected template.

Custom Save Button

Change the label for the "Save" button.

Custom Save Message

Change the content of custom message that
informs you have just saved a document.

Redirect

Redirect Path

Allow you to redirect the path in the Redirect
Path field.

Show a path to which you will be
directed after clicking OK in the confirmation
message.

Select a specific location to save documents.

i. Click & to open the Select Location form.
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Select Location x
Waorkspace
Root Path &
Hame Add
exo:ragstry ¢
= EX0IServices @
: EX0ISRrVices /
B e Users &
Usars ’
8- & Groups - @
c Digital Assets Groups @
- |2 Documents o Dighal Assets <o
@[ Trash Documents &
l% Records Space i Records Space ]
= tags tags b
& | sites content & sites content ]
& ApplicationData ApphcationData .&‘.
1= OrganizationIntegrationSs Total pages: 2 (| x]||1] 2][]> 0

ii. Select the parent node on the left pane and click € in the Add column to select the child
node on the right pane. After being selected, this location will be displayed on the Location
to Save field. Created documents will be saved in this location.

5. Select a template which is used to create a new document.
6. Change the label for the Custom Save button, and the content for Custom Save Message.

7. Tick the Redirect checkbox if you want to redirect to the path in the Redirect Path field after
clicking OK in the confirmation message.

8. Click Save to finish the configuration of Fast Content Creator. Then, click OK in the
notification message to accept your changes.

9. Click Close to quit the form to edit the configuration of Fast Content Creator.

4.9.2. Create a new content

1. Go to your newly created page.
2. Fill values in all the fields in the page.

3. Click Save to accept creating the new document. A message appears to let you know that
the document is created successfully at the location selected in the Location to Save field.
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4.9.3. View a content

After creating a new document by Fast Content Creator, you can view it as follows:

1. Go to Sites Explorer.

2. Select the drive and the path that you established in the configuration of Fast Content
Creator. You will see this document.

4.10. Create content templates with Form Builder

The Form Builder portlet allows users to create and edit the template of document types.
Documents are stored in the so-called node; therefore, the term "node" and node types are often
applied.

To use this porlet, you need to add it to a specific page first by dragging and dropping Form
Generator Portlet from Page Editor --> Applications --> Form Generator Portlet to the main
pane. This can be done when creating a new page or editing an existing page or editing the layout
of a portal.

{p‘l Page Creation Wizard: Fe-arange the Page Layout and add Porders to the Fage. = Page Editor Save W

— Form Generator Portlet

| Form Generator Ponler

Dashboard

Faq
Fom Generator Portlet
Form G Portlet
Drag & Drop “-M‘ Fom Generator Portlet

Forms
Forum
Gadgets

Naviaation i
(@ View Page propenties | | [ Switch View Ilode-)\
\S JAX 4

Create a content template

1. Open the Form Builder portlet.
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amouse

Description

Enter the template hame into the Name field which is required.

[& Source

Y

B I U =

_r

Save

Enter a brief description about the template.

Resat

1

Click the Form Builder tab that allows you to set properties for the template. Available
components are displayed on the left pane.

General Form Buider

5.

Input Text

» Label

Text Area

=l Editor

Select Box

Radio

x| Upload

ChackBax

Input field
Label

Textarea field Textarea vaue

Select field  Option 1

Upload field E

Reset

'R,
'R

R

'R .

2 M
2

7 |

i |

Click the desired components on the left pane. The selected components will be displayed

on the right pane.
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Click * corresponding to the component to move this component up; or click # to move the

component down.

Click " corresponding to the component to edit properties of that component. The form to
edit properties appears like the illustration below:

Field L::lbs.-l|-|—,ﬁE

| #— Enter the label

Width

Height
Default Value

Guidelines for
User

Details:

Table 4.35.

Rules: [C] Required

Field Description

Field Label The label of the field.
Width The width of the field width.

Rules: || Required If the checkbox is marked, the asterisk (* )
will appear beside the textbox, indicating that
it is required to enter values in this field.

Height The height of the field.

Default Value

Display the default value.

Guidelines for User

Display instructions about this component.

After editing the properties of the components, the components look like the below illustration.

Tide
Place

Summary Textarea value

Upload field | Browse_ |-t

* 4% DWW
% @m
% @2m

£y @@

* To delete the component, click @ corresponding to the component.

* Click ¢ again to hide the form to edit the properties.
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8. Click Save to accept creating a new template, or Reset to edit this template again before
saving.

« A message will inform that you have created the template successfully.

 After the template has been created, you will see itin the content template list when creating
a content.

4.11. Manage Category Navigation

Category Navigation portlet and Parameterized Content List Viewer portlets get rid of long
URLs when you view a content and enable users to see published documents or web contents in
specific categories in one page. Thanks to the symbolic link, no matter where the object physically
resides, the database can retrieve it. In addition, the relations amongst shortcuts can be managed.
Now, you can view documents or web content in the Parameterized Content List Viewer easily.

Access the Category Navigation portlet

1. Go to News on the Navigation bar.

B by Top News B
Defanse

Vision

Immunity

Healing Worried about a straying spouse? Go Invisble to find out for sure
(Mote: background check required

Invisibility
Mavement

Natural Elements

« The left pane lists all the categories containing documents or web contents.
< The right pane displays the documents selected in the left pane.

2. Select a category that you want to view on the left. The selected category will be shown on
the right (only documents or web content published are shown).
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&] f}
Sepreby, Vision 5]
Defense
ﬁ— The current category e R —

Immunity s
Healing Made popular by the orginal Superman, X-Ray Vision lets you see what
others are hidng. By behg aware of your surroundings, you can avoid
Invisibility dangerous situations - of Just have a Ittle fun with your friends.
Movement

Natural Elements
n Hight Visior
w ¥ ver be f & wer. Simiar to the advanced infrared
=chnology used by miltar exactly what s around you - sing i
ght source that coud reveal your pos

Configure Category Navigation

Administrators can edit the Category Navigation portlet as follows:
1. Open News page on the Navigation bar.

2. Hover your cursor over Edit --> Page --> Layout

The page for you to edit the Category Navigation portlet will appear.

I @ content L [ w Page Editor B[ x
TConTent st Hews

Applications Containers

Click

Administration

— | application Registry
Applcation Registry

New Account

Organization Management
Jrganeation Managament

Contents
Dashboard :
i View Page properties | Switch View Mw?;

3. Click # to open a form with the Edit Mode tab, allowing you to edit the portlet.
Portlet Settings Select Icon Decoration Themes Access Permission

Contents Selection 0
= (i. L

Mode @ By Folder ©) By Contents =

. (B

Folder Path  acme * @ﬂ— Click to select the folder path "

Order by OrderByDatePublished  +

m

@) Descendant @ Ascendant

Display Settings
Header Browse by Automatic Detection @

Template  AcmePowersCategoryTree.gtmpl -
Paginator  UlPaginatorDefault gtmpl

Items per Page 1p *

Show Title Show Image Show Summary

Close
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4. Click * to select the folder path which restores contents you want do display.

5. Edit some fields in the Display Settings part as you want. See more details in the Content
List Preferences [51] section.

6. Click the Advanced link to set up some properties for the portlet. See more details here.
7. Click Save to accept saving the configuration for the Category Navigation portlet.

8. Click Close to quit the form.

9. Click & on the Page Editor form to finish editing the Category Navigation portlet.

@ Note
In the Edit Mode tab, some options are disabled.

4.12. Manage SEO

SEO (Search Engine Optimization) allows you to improve the visibility of your webpages and web
content in the major search engines (Google, Yahoo, MSN, Live) via the search results. The higher
your website position is in the search engine results page, the more visitors access it. Therefore, it
is very important for you to maximize your webpages and contents' position in the search engines.

In eXo Platform, the SEO Management feature is featured to meet this target. By using SEO
Management, you can easily manage SEO data of web pages and web content and optimize
your website for search engines.

Manage the SEO data

1. Open a page or a content that you want to edit the SEO data.

2. Open the SEO Management form by hovering your cursor over Edit --> Page --> SEO on
the Administration bar.

Desktop Edit
Click
Content -
Page ] -,
: La;uutl : john Logout
Questions? -
+ Add Page

Depending on your SEO management for a page or a content, the content of the SEO
Management form will be different.

« The SEO Management form for a content is as follows.
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SEQ Management 4

Description:

Keywords:

Save Cancel

* The SEO Management form for a page is as follows.
SEO Management x

Description:

Keywords:  gXg, PLE 3.5

Robots: INDEX » FOLLOW -
Sitemap: Wisible in sitemap
Frequency: Always -

Priority: 1.0

Save Cancel

Details:
Table 4.36.

Field Description

Description The description of your page/content. This
description will be seen in the results list of
search engines.

Keywords By using these keywords, other users
can find out your page/content via search
engines.

Robots Search engines can access the whole
directories on a website, or individual pages,
or individual links on a page and list your
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Field Description

page/content or not, it depends on your
options:

¢ INDEX: Allow search engines to index
your page/content on the search engine
results page.

« NOINDEX: Restrict search engines from
indexing your page/content on the search
engine results page. Use this option if you
want to keep your page private.

e FOLLOW: Allow search engines to follow
links from your page to find other pages.

« NOFOLLOW: Restrict search engines
from following links from your page to find
other pages. Use this option if you want to
prevent spam links in comments of blogs,
forums and others.

Sitemap Allow you to see pages of the sites in the
tree-like structure.

Frequency Show how often pages are updated on
the site. Also, setting your frequency levels
tells the search engines which pages
should be crawled over other pages. The
frequency levels include: Always, Hourly,
Daily, Weekly, Monthly, Yearly and Never.
If you set "Never" for the frequency level,
meaning that this page never gets updated,
so search engines will move onto other
pages that get updated more frequently.

Priority Allow search engines to search the page with
the higher priority level first. The acceptable
value in this field is from 0 to 1. In which, O is
the lowest priority level and 1 is the highest.

3. Fill out all the fields in the form.

4. Click Save to finish creating SEO data.
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4.13. Manage contents list viewer by query

The Contents By Query portlet allows you to collect and display data throughout a workspace
by using a query instead of selecting items by a folder or by contents.

To use this portlet, first you need to add the Contents By Query portlet to a specific page as
follows:

1. Drag and drop the Contents By Query portlet from the Page Editor --> Applications -->
Contents to the main pane. You can do this step while creating a new page or editing an
existing page or editing the layout of a portal.

= Page Editor [l = JEs)

= Content Explorer
A @ Content Explorer
o
: Contents By Query \‘ }
Drag & Drop

. Controlier
. Dashboard
| ECM
|
. Form Generator Portlet 2

S
&8 View Page properties

- 4

E‘ Page Creation Wizard: Re-arange the Page Layout and add Portlets to the Page.

2. Edit the Contents By Query portlet by hovering your cursor over it, then click ¢ to edit the
portlet.
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Page Creation Wizard: Re-arrange the Page Layout and add Portlets to the Page.

The form with the Edit Mode tab appears.

Edit Mode Window Settings Select Icon Decoration Themes Access Permission

— Contents Selection

Mode @ gy Folder © By Contents @
Folder Path = (3 @
Order by OrderByDatePublished
@ pescendant ) Ascendant
—Display Settings
Header Automatic @

Detection

Template UlCortentLlistPresentationDefault gtmpl

Paginator UlPaginatorDefault atmpl

Items per Page 1p *

Close

3. Enter avalid query into the by query field to get data that you want to display.
4. Select a workspace where you want to get data.

5. Click Save to complete adding the Contents By Query portlet.

6. Click =/ to quit the Page Editor page and see the displayed data.

Content List
Preferences
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Advanced Actions

5.1. Manage Site Resources in one place

You can easily manage all the site resources in Content Explorer.

*Ei&shh'lmﬂ'rﬂ'lt

Chose in General drive. All of your created sites and their resources
will be listed in the left panel.
bt s, Form Busider
) daxo - | a|
Pubibcabon ‘Collaboration Eystem
g AddFoke | [ 2 i Docoment |, Upkood | @
e —— = Document thle Crested dabe Hugthar Last User ‘Btatus
e LU ___gi:..] i ApolcationDes Ilalll.'l'.l.tlml:'hl
Bl & coicgoies 1210410 E:00 P
3 B cus 10 E00 P
E) socumens L2100 G0 P
B Er s 12110710 6:00 P
Q. o ks 1IN0 E:00 P
L megas L2 B PM
M web coniens L2110 600 P

All sites contain typical folders that are site resources:

L css 5/20/10 11:10 AM
" documents 5/20/10 11:10 AM
& js 5/20/10 11:10 AM
& links 5/20/10 11:10 AM
2 medias 5/20/10 11:10 AM
55 web contents 5/20/10 11:10 AM

5.1.1. CSS Folder

CSS is one of the default files of a site. This folder contains CSS data that is used to present data
in a site and increase that site's content accessibility.
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5.1.2. Document Folder

This folder contains all documents used in a site. When you want to add a new document for a
site, you can also put them in another folder, but it is recommended to use this one to manage
everything easily and conveniently.

[=]= "~ documents
‘#] | Conditions and Requirements
t, How to join us

-0 | \Where we are

5.1.3. JS Folder

This is one of the default files of a site. This file contains Java Script data that is used to make
a site more animated and more dynamic.

5.1.4. Links Folder

This file contains all links used in a site.

5.1.5. Media Folder

This folder contains all documents related to videos, images and sounds. It is divided into three
sub folders:
|§|- £ &) medias
L audio
images

- ® videos

audio:
This folder contains sound data used in a site.

images:
This folder contains images used in a site.

videos:
This folder contains videos used in a site.

5.1.6. Web Content Folders

This folder contains all web content used in sites. It is recommended to put all the web contents
files here, to manage them more easily, or in case you want to reuse them in another site.
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EEI- |Jweb contents
|£| L 2010
IEI i Events
IEI .| NewEvents
IEI .| News
|é|- " site artifacts

-@ Contact Form Confirmation

[ AcME Footer
--[E&] AcME Introduce

- [E&] ACME Logo
--[E] AcME Navigation

' -ll_l'tljj Mewsletter Header

- [&F] AcME searchbox

55| ACME Signin

5.2. Content Administration

This page is used to manage all workspaces, drives, node types, metadata, templates, queries,

and more. Only administrators can access the Content Administration page.

bar.

John Smith

Users »

Applications
Sites Explorer | Content ’

Portal »

Content Administration |

Administration »

IDE
The Content Administration page will appear.
Hanage ECM Main Functions Manage Categories
Categories & Tags HName Workspace Home Path Permissions
£ manaoe Categories Sysem dma-system fexosecm [axoitaxonomyTress  oray;_system remave

/sites content flive facme

% Manage Tags acme collaboration Fczitegories foame ~.BrtYI__SyStem remave
. Jsites content flive facme L
Contont Proseriation events collaboration o ~-@TY;__SyStem remaove
N . [sites content flive /detault .
P—— default collaboration s el ...erty;_system remove
Jsi i
intranst collaboration fsitos contont Mve fintranct w.erty;__system remave

- [categories fintranet
Advanced Configuration o

Add Category Tree

Action

o o = = o

Hover your cursor over # --> Content --> Content Administration on the Administration
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This page enables you to access:

» Categories & Tags: Manage categories and tags.

Content Presentation: Manage template, metadata, views, and drives.

Content Types: Manage namespace registry, and nodetype.

« Advanced Configuration: Manage queries, scripts, and create an action type.
5.2.1. Categories and Tags

5.2.1.1. Manage tags

The Manage Tags function enables you to manage tag styles. The tag styles will change,
depending on the number of documents in a tag.

Go to Categories & Tags --> Manage Tags.

Manage ECM Main Functions Manage Tags
Categories & Tags Tag Manager Tag Permission Manager
i Manage Categories Style Name Document Range Tag Style Action
¥ Manage Tags font-size: 12px; font-weight; bold;
normal 0.2 color: #6b6beb; font-family: & B
verdana; text-decoration:none;
Content Presentation font-size: 13px; fornt-weight: bold;
interesting 2.5 color: #5a660e; font-famiy: verdana; Z B
PR text-decoration: none;
Content Types

font-size: lsfux; f'Ont-weIUHl: bold; _

dvanced Confiauratio attractive 5.7 color: blue; font-family: Arial; s i
Advanced Configuratior text-decoration:none;

font-size: 18px; font-weight: bold; .

hot 7..10 color: #f9000; font-family; Arial; & M
text-decoration: none;

font-size: 20px; font-weight: bold;

hottest 10.= color: red; font-family:Arial; A |
text-decoration: none,;

Add a newtag =

Edit Delete

Add atag style

1. Click the Add Style button. The Edit Tag Style Configuration form will appear.

Edit Tag Style Configuration x
Style Name  ngrmal *
Document Range 0,2 o
HTML Style |font-size: 12px; font-weight: bold; color: #6bébéh; font-family: verdana; #

text-decoration:none;

Update Cancel
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Details:
Table 5.1.
Field Description
Asterisk (¥) This mark next to each field means that it is
required to input values.
Style Name Give the tag name which cannot be edited.
Document Range Give the number of document assigned to a
tag.
HTML Style Include font-size, font-weight, color, font-
family, text-decoration.

2. Input values in the fields: Style Name, Document Range, HTML Style.

3. Click Update to accept adding a new tag style.

5.2.1.1.2. Edit a tag style

The Tag Manager tab enables you to edit the existing tags.

Edit an existing tag

1. Click the penicon corresponding to the tag name which you want to edit in the Action column
to edit the tag style configuration. The Edit Tag Style Configuration form appears which is
similar to that of adding a tag style.

2. Change values in the fields, including Document Range and HTML Style, except Style
Name.

3. Click Update to save new changes.
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5.2.1.1.3. Delete a tag style

To delete one tag style, simply click the corresponding Delete icon and select OK in the
confirmation to accept your deletion.

5.2.1.1.4. Tag Permission Manager

The Tag Permission Manager tab helps you set permissions regarding to editing and deleting
public tags.

Manage Tags

Tag Manager Tag Permission Manager

Memberships Action
=:/platform/administrators 0]
Add Permission

Memberships: * (&) 4— Select membership

Save

Set Permission To Tag Management

1 Click & beside the Memberships field to select memberships to add a permission to those
memberships. The Select Membership form will appear.

Select Membership x

#4F developers

Select Group Select Membership
o~
' v member
B Iﬂ', developers b author !
: ’ . | _
- s organization editor 3
é b manager
- g platform
2 » redactor
& gis sandbox
e v wvalidator
& spaces - i

2. Select a group on the left and the corresponding membership on the right. The selected
membership will appear in the Memberships field.

3. Click Save to accept adding a permission for the membership to the Memberships column.
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Tag Manager Tag Permission Manager
Memberships Action
*/platform /administrators E
author:/developers ﬂ

Add Permission

Memberships

(2]

Save

You can also delete memberships that have permissions by clicking regarding to that
membership, then click OK in the confirmation message.

5.2.1.2. Manage categories

A category can be understood as a classification practice and science. Itis used to sort documents,
aiming at facilitating searches. The category management includes adding, editing and deleting
a category tree.

Go to Categories & Tags --> Manage Categories.

Manage Categories

Name Workspace Home Path Permissions Action

system dme-cystem [exossem [oxotaxenamyTIess oy, oystem remove s B
acme collaboration ;z:s:g:_r::?:‘:: facme ...erty;__system remove & W
sverts collaboration o arty;_systam ramove ¢ A
default collaboration ::::f:g:; ‘": r’:;e‘r':j {d'fa [ ...8rty;__system remove & o
intranet collaboration PR e T ..erty;_ system remove & |

fcategories fintranet

5.2.1.3. Add a category tree

1. Click the Add Category Tree button to add a new category. The Add Category Tree form
will appear.

Add Category Tree o

Specify the category name, workspace and home path.
Name  platform ¥

Workspace dms-system -

Home Fath ] =)

Reset i— Click to next step

Close

2. Enter the category tree name in the Name field which is required.

3. Select the workspace you want to work with.
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4.

5.

Select the home path by clicking & . The Select Home Path form will appear.

Select Home Path x

Workspace |dms-system

Roaot Path

Name Add

1.
i || exoiecm @

- exoiecmn

* Click @ next to Root Path if you want to select the root path or;

« Click the arrow icon to go to the up level path and click the plus sign to expand the folder
in the left pane.

Click @ corresponding to the path that you want to select as a home path.

Click Reset if you want to reset values that have just been selected or Next to select
permissions for a category tree.

Add Category Tree x
-
Set permission for the category tree.
User or Read Add Node Set Remove Action
Group Property

any true true true false &

Add permissions to this node

m

User or Group *£ & g‘
rRead [}
Add Node ]
Set Property D
Remove D
Previous Save Reset Next

Close -

i. Click & to select a user or & to select memberships or & to select everyone to set
permissions. The user or membership that you have just selected will be displayed in the
User or Group field.

ii. Check at least one of these below options to set rights for the selected user to membership:

Table 5.2.

Description

Read Right Select the Read right or not.
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Field Description

Add Note Right Select the Add Node right or not.
Set Property Right Select the Set Property right or not.
Remove Right Select the Remove right or not.

6. Click Save to save all values, or Reset to change values that have just been set. After clicking
Save, click Next to go to the next step.

Add Category Tree %

Add an action to the category tree pLi

Name B

Lifecyele |Content Addition -~
Content Removal

Property Addition E M
Property Removal

Property Modffication ad b

Is Deep
Mode Types @ Q

Home Path  dms-system: s I omyTrees/Plath «

Target Workspace  system -

Target Path # Q m
Q

Affected Node  ntfile
Types

exoartice

exo:podcast

exo:sample
rma:filePlan
kfx:document

7. Enter the name for an action of the category tree in the Name field which is required.

8. Selectvalues for Lifecycle, Node Types, Target Workspace, Target Path, Affected Node
Types which are required.

9. Click Save to save all values, then select Next to go to the next step.

5.2.1.4. Edit a category tree

1. click ¢ corresponding to the category tree you want to edit.
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Edit Category Tree @
Edit the taxonomy tree by adding, copying, cutting and selecting p»
=)
@Q System System @_-l |j
2. . . . .
Click *' in the Add column to add more category trees. The Edit Category Tree form will
appear.
Edit Category Tree @
Parent fexoecm/exo: yTrees/ [Systi
Category Name  yacation| |*
v

3. Enter a category name in the Category Name field which is required.
4. Click Save to save the category name.

5. Click Previous to return to the previous steps.

6. Click Save to save all changes, or Previous or Next if you want to edit more.

5.2.2. Content Presentation

5.2.2.1. Manage a template

When creating a node in eXo Platform, you must set its properties. Thus, each node needs to
have a form to enter data for their properties (called the Dialog template), and display the existing
values (called the View template). The template management allows users to view, delete and
modify the predefined templates or to add a new template.
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Manage ECM Main Functions Manage Templates
Cat & Tags Maximum Pag 0 - Totalpages: 4 |® || ¢ |1 |2 3|/ 4||»||»
Content Presentation Template Name Action

s addMetadstalction =]
|l Manage Templates
EX0 BNNSURNCEMEN o
% Manage Metadata
& Manage View CZEEl -
4 Manage Orives e ————" -
exa:businessProcessModel fr
Content Typ ex0:comments 5]
Advanced Configuration etca:conkect, s L]
exocreateRSSFeedAction &
exoicssFile 1
exoienableversioning |

Totalpages: 4 |® |« |1 |2 3| 4| »||»

Add a new template

1. Click Content Presentation --> Manage Templates.

2. Click the Add button in the Manage Templates form to open the Template Form.
Template Form b 4

Template Dialog View CS5

Name :app:applicationregistry -

Label “

is Document
Template

Permission # E;‘:

Save Refresh Cancel

3. Select the template type from the Name drop-down menu.
4. Specify a name for the template in the Label field. It is required.

5. Select the is Document Template checkbox if you want your created template to become
a template for a document.

o

Click * next to the Permission field to open the Select Permission dialog. It is required.

« Select the group from the left pane and the membership from the right pane. Or,

You can set permissions for everyone by clicking * nextto Any Permission.
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Select Permission x

>

Any Permission (=

Select Group Select Membership
t.

o Development

m

s Organization
s Platform
s sandbox

- i Spaces -

7. Optionally, select the Dialog tab and enter the value in the Dialog Content field.
8. Optionally, select the View tab and enter the value in the View Content field.

9. Optionally, select the CSS tab and enter the value in the CSS Content field.

10. Click Save to create the template.

Edit a template

1. Click Content Presentation --> Manage Templates.

2. Click ¢ in the Action column, corresponding to the template you want to edit.

3. Make changes on the values of each tab, including:

@ Note
You cannot delete the default dialog. You must create a new one before you
can delete the current default dialog.

< In the Template tab, you can edit the label of the template.

 In the Dialog tab, you can do the followings:

Add a dialog

i. Input content for this dialog in the Content field.
ii. Input the name for this dialog that is required.
iii. Select permissions for a group that can use this dialog that is required.

Edit an existing dialog
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i. Click ¢ in the dialog row you want to edit.
ii. Edit the dialog properties.

iii. Click Save to accept all changes in the Dialog tab.

Delete an existing dialog:

i. Click @ in the dialog row you want to edit.
ii. Click OK to accept your deletion.

In the View tab, you can do the followings:

Add a view

i. Enter content into the Content field.
ii. Input name for this view that is required.

iii. Select permissions for a group that can use this view that is required.

Edit an existing view

i. Click ¢ in the Actions column, corresponding to the view you want to edit.
ii. Edit the view properties.

iii. Click Save to accept all changes in the View tab.

Delete an existing view
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i. Click ' in the Actions column, corresponding to the view you want to delete.

ii. Click OK to accept your deletion.

iii. Click Save to accept all changes.

Delete a template

1.

2. Click OK in the confirmation message to accept your deletion.

5.2.2.2. Manage metadata

Click I corresponding to the template you want to remove in the Manage Templates page.

Metadata is generally defined as "data about data". Metadata is information which describes,
or supplements the central data. In the Manage Metadata tab, you can manage nodes in the
metadata format in the eXo Platform system. The metadata may be considered as information
used to describe the data. When data are provided to end-users, the metadata allows users to
understand about information in more details. All metadata nodes can combine with other nodes

to create a new node (add mix).

View metadata

1. Click Content Presentation --> Manage Metadata.

Manage ECH Hain Functions Manage Metadata

ies & Tags Maximum Page Size: 10 -

content Presentation Icon Metadata Name Internal Use

- derelementSet
Manage Templates

rma:cutoffable
rma;destroyable
Content Types rma:holdable
rma:record
Advanced Configuration airec

rma:transferable

= RN R < RS < B ¢

rma:vitalRecord

2. Click @ corresponding to the metadata you want to view.

The Metadata Information form will open.

Mixin Type

(R8s RS s Y <[RS <

Template's Actions
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Metadata Information
| Metadatainformation
Metadata Hame Is Mixin Type
@dc:elememﬁet v
| Elements
Element Name

deciresourceType
dc:coverage
dec:creator
dec:description
dc:language
de:publisher
deisubject
decicontributor
dcisource
deirights

detitle

B ERRBEREEREEEE

Type

String
String
String
String
String
String
String
String
String
String

String

X false

Description
Description
Description
Description
Description
Description
Description
Description
Description
Description
Description

Description

Edit metadata

1. Click ¢ inthe Template's Actions column, corresponding to the metadata you want to edit.

The Edit Metadata's Template form will open.

2. Change the required properties of the metadata.

3. Click Apply to save all metadata changes.

Delete metadata

1.

Click @ corresponding to the metadata you want to delete.

2. Click OK in the confirmation message to accept your deletion.

5.2.2.3. Manage views

The Manage View function is used to control view ways of a user. It has two tabs: View and

ECM Templates
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To open the Manage View function, click Content Presentation --> Manage View. The Manage
View form displays.

Manage View

Views ECM Templates

Maximum Page Size: 10 =

Name Permissions Action Tab Base Version Action

admin-view *:/platform/administrators [ Admin ] 1 (o] o
authoring-view =:/platform/web-contributors [Publication 11 Collaboration o
cover-flow *:/platform/users [ CoverFlow ] a o
icon-view =:/platform/users [ Icons ] S| o
list-view =:/platform/users [ List] d & ®’
simple-view = /platformfusers [ Actions ] [ Collaboration ] 1 o
timeline-view *:/platform/users [ Timeline ] : 1]
wem-category-view =:/platform/web-contributors [ Publication ] [ Collaboration Z il
WEm-view *:/platform/web-contributors F?‘;:g::s"’]" HECIRL S a

Add View

5.2.2.3.1. Views tab

In this tab, you can add, edit, delete, and preview views.

Add a view

1. Click the Add View button located at the bottom of the Manage View form.

The Add View form will open.

Add View x
View Form
Name  Member_View #
Permission  author:/organization Nt
Tabs
Templates  List\iew -
Save Reset Cancel Add Tab

2. Specify the view name in the Name field that must be unique, and only contains standard
alphanumeric characters. It is required.

3. Set permissions for the view by clicking the plus icon. It is required.
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Select Permission x

>

Any Permission (=

Select Group Select Membership
t.

I‘} Development

m

:‘} Crganization
:‘} Platform
& sandbox

- ks Spaces -

* Click * next to Any Permission to assign permission to every one.
* Or select a group from the left pane and the membership from the right pane.
Click the Templates field and select a template from the drop-down menu for this view.

Click the Add Tab button to create a functional tab on this view. It is required.

Add View x
The tab name

-

Tab Form

Name in | =

m

Add Category
Add Document
Add Folder
Add Translation
Add Symlink <4—— Specify functions on the tab
Comment

Navigation by Content
deleteNode

Edit Document

Export Node

Import Node

Manage Actions

]DHHDDDDDDHHHE

Momame Acdibina

i. Enter the name for the tab in the Name field.

ii. Specify functions to add to the tab.

iii. Click Save to finish creating a tab;

Or click Reset to clear the Tab form;

Or click Back to return to the View Form tab of the Add View form.

The newly created tab is displayed on the Tabs field.
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Add View

View Form

Name st View

Permission =

Tabs admin[f{]—— Delete the tab

Templates  List View

W=

v @O

( Save ) ( Reset ) ( Cancel ) ( Add Tab )

6. Click Save to apply all settings and close the form.

Edit a View

1. Click ¢ inthe Action column, corresponding to the view you want to edit.

Add View

View Form

Name st View

Permission =

Tabs Adminl\ilzg_ Delete the tab

Templates  List View

W=

v @O

( Save ) ( Reset ) ( Cancel ) ( Add Tab )

2. Edit the view properties.

3. Optionally, click the Add Tab button to open the Tab Form tab that allows you to add more

Tabs to the View.

4. Optionally, click an added Tab to add or remove functions on it. Note that you cannot change

the tab name.

5. Click Save to apply all changes in the View tab.
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Delete a view

1. Click @ corresponding to the view you want to delete in the Manage View page.

2. Click OK to delete the view in the confirmation message.

Preview a view

1. click @ in the Action column of the view you want to preview.

The View form will open.

View

View Form
Name  admin-view

Permission = fplatform/administrators

Tabs [Collaboration ]
[ Actions ]
[Info]

[Admin ]

-

Templates | ListView

Enable Version

Close

2. Click Close to exit the View form.

5.2.2.3.2. ECM Templates tab

Add a new ECM Template

1. Select the ECM Templates tab.
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2.

6.

Manage View

Views ECM Templates

Maximum Page Size: 0 -
Name Value Base Version Action

Jexo:ecm/views/templates

Sl fecm-explorer/ContentView

Jexo:ecm/views/templates

EEIRED Jecm-explorer/CoverFlow
fexo:ecm/views/templates
T Jecm-explorer/lconView
- : 'l
ListView Jexo:ecm/views/templates

Jecm-explorer/ListView

Jexo:ecm/views/templates

SlideShow\iew fecm-explorer/SlideShowView

/exoiecm/views/templates

SLELANED Jecm-explorer/SystemView

Jexoiecm/views/templates

TS fecm-explorer/ThumbnailsView

Jexoieem/views/templates

TimelineView Jecm-explorer/TimelineView

Click the Add button to open the Add ECM Template form.

Add ECM Template

Content =

Name #

Input the content of the template in the Content field.
Input a name for the template in the Name field.
Select a type for the template in the Template Type field.

Click Save to accept adding a new template, or Reset to change values.

Edit a template

1.

2.

3.

Click ¢ next to the template you want to edit.
Change the current template's properties.

Click Save to accept all changes.

m

B o = o =B B s =
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Delete a template

L click @ corresponding with the template you want to delete. A confirmation message will

appear.

2. Click OK to accept deleting this template.

5.2.2.4. Manage drives

The function supports you to manage drives in the Sites Explorer. It allows adding, editing and
deleting drives.

Go to Content Presentation --> Manage Drives.
Manage Drives

Maximum Page Size: 10 =

Icon Name ‘Workspace Home Path Permissions View Action =
/sites content flive .
acme-category collaboration ;acmel- i :_""f..hﬁo"" wem-category-view s
acme L =
. - /web-contributors,*:  admin-view,
R LTl / /platform authoring-view Z @
Jadministrators :
[sites content flive I
default-category collaboration ;‘ddﬂ.‘, i J /platform 5 wcm-category-view A §
timeline-view,
] Groups collaboration fGroups${aroupld;  =:${groupld} list-view, icon-view, & i
cover-flow
Jsites content flive -
intr gory llat i ﬁhﬂ:;t Jcategonies fa'mm wem-category-view ¢ B
“ifplatiorm
Managed Sites collaboration /sites content flive :::gm"ws' d admin-view, wem-view Z B
/web-contributors
Personal Documents  collaboration fUsers j${userld} =:/platform/users St“';‘:_'cm“"'

Add a new drive . Edit Delete

5.2.2.4.1. Add a new drive

1. Click the Add Drive button in the Manage Drives page to open the Add Drive form.
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Add Drive x
-
Drive Apply Views F
Name #
Workspace  gystem -
Home Path =)

‘Workspace lcon

Permissions # %
Show Referenced [
Documents

Show []
Non-document
Nodes

Show Sidebar [
Show Hidden Nodes []

+

m

Allow Folder PEg=ils
Creation | Unstructured folder [

exo:webFolder

exolinkFolder

1

2. Input a name for the new drive in the Name field that is required.

3. Select a workspace for the drive from the drop-down menu by clicking the Workspace entry.

sstem
portal-system
portal-work
warp-system
pc-system
collaboration
backup
dms-gystem
wom-system
social
knowledge
dev-monit

4. select the home path for the drive by clicking ® beside the Home Path entry.
Select Home Path %
Workspace | system
Root Path @
Hame Add
& -
...‘_‘jmsymm [ jerisystem @
5.

Browse an icon for the workspace by clicking *' beside the Workspace Icon entry.

Select an icon by clicking @ corresponding to your desired icon file.
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Select Icon x
jcr:system
Workspace system -
¢ Name Add =
: Child not found!
| exo:namespaces
---,_.jn:r:ncdetypes
L exoiecm
L exorworkflow

Select permissions for groups that have access rights to this drive by clicking % peside the

Permissions entry.

Show Referenced Document

Allow viewing preference documents.

Show Non-document Nodes

Allow viewing non-documents.

Show Sidebar
Allow showing the sidebar.

Show Hidden Node

Allow showing the hidden nodes.

Manage ECH Main Functions Namespace Registry

Categories & Tags Maximum Page Size: 10 =
Content Presentation Prefix
app
Con pes
ca
Namespace Registry ul
de
¥ Manage Node Type
axn
axoide
Advanced Configuration
Advanced Configuratior tn
fr_old
Fwd
atn

Select or deselect the various checkboxes to hide or show the drive elements respectively.

Select the document type that will be created in this drive.

Select the Apply Views tab and select the view types you want to be available in the drive.

1 2 3|4 »

Namespace URT
hitp:/fwww.gatein.org/jcrfapplication-registry/ 1.0/

w.bull.com/fr/aladinng/cia/1.0

w.exoplatform.com/jer/emis/1.0

rl.arg/dc/elements/1.1/
s/ fwww.exoplatform.com/jer/exa/1.0

hitp:/fexnplatform.org/ide/1. 1.x

ttp:/Swww. w3 crg/ 2008/ xpath-functions
hitp:/ fwwiw. w3000/ 2004/ 10/ xpath-functions

hti w.exoplatform. com/jc

hitp:/www.gatein.org/jer/ gatein/1

Total pages: 4 % || ¢

Register

10. Click Save to complete creating the new drive, or Refresh to clear the form.
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5.2.2.4.2. Edit adrive

1. Click ¢ corresponding to the drive you want to edit. The Edit Drive form will appear.

Edit Drive %
Drive Apply Views 5
Name  acme-category "
Workspace collaboration hd
Home Path  fsites content/live facme fcategories acme o
‘Workspace Icon @
Permissions = fplatform/web-contributors ‘o T 3

Show Referenced
Dacuments

Show

Non-document
MNodes

Show Sidebar
Show Hidden Modes

Allow Folder |expisFolder
Creation
exo:webFolder
exolinkFolder

< [

2. Edit the properties as required.

3. Click Save to commit the changes.

5.2.2.4.3. Delete a drive

L Click T that corresponds to the drive you want to delete.

2. Click OK to delete the drive in the confirmation message.
5.2.3. Content Types

5.2.3.1. Namespace registry

The namespace is a prefix in the node type name. It enables you to create node types without
fearing any conflict with existing node types. The registry helps you manage the namespaces
used in the system.

Select Content Types --> Namespace Registry to open the Namespace Registry form.
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Manage ECM Main Functions MNamespace Registry
Categories & Tags b Maximum Page Size: 10 = Totalpages: 4 [« |[¢|[1][2][3][4] [
Content Presentation v Prefix Mamespace URL
app hittp/ gatean. egistry/1.0/0
LR T e it/ bull.com/Fe/aladinng/cia/1.0
Firm=====| e i et s
@ Manage Node Type de hittp/fpurlorg/defelements/1.1/
oo g/ mww.exoplatform. com/jcr/exal 1.0
exvide hitpfesaplatiorm.arg/ida/1.1.x/
Advanced Configuration 4 rs o . Ea——
fn_old hittp//www.w3.0rg/2004/10/xpath-functions
4 Fwd hittgs/fwwwe. exoplatform.com/jerf Fwd/ 1.1/
on ttp//www.gatein. org/r/gatein/ 1.0/
Total pages: 4 | |L l‘ [2][3][4](+ (=
[ Register |

Register a namespace

1. Click the Register button on the Namespace Registry form to register a new namespace.

Register New Namespace @
Namespace Prefix *
URI *

sa

2. Enter the value for the Namespace Prefix field that is required.

3. Enter the value for the URI field which must be unique and required.

5.2.3.2. Manage node types

This function is used to control all node types in eXo Platform.

Manage ECM Main Functions HManage Node Type
Categories & Tags v Node Type Name % Q
Content Presentation v Total pages: 38 |3 E' I IE |E‘ Zl E |E ‘Z' E
Content Types =
Tcon Hode Type Mixin Type Orderable Child Nodes  Description Action
1 Namespace Registry
‘ B app:application X faise X false nathing
,
] D app:applicationregistry X false ¥ true rathing @
B PR—— ®  false v tue nathing
Advanced Configuration  » B o X false X false nothing
(] app:gadgetdefinition X false X rfalse nothing e}
]
B app:gadgetregistry X false X false nothing ie]
E app:localgadgetdata X false K false nathing
B app:remotegadgetdata X false X false nothing o
B emis:document v true X false nathing a
(] cmis:folder v true X false nothing (=]

Total pages: 38 [« |[«|[1[2][a][4]5/[6][+]|[»

(_add | ( import | [ Export |
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5.2.3.3. View node types

1. Click that corresponds to the node to be reviewed. The View Node Type Information form
will appear.

View Node Type Information %

Node Type

Name Space |app -]

Node Type Name  application *

Is Mixin Type |fzlse -]

Orderable Child [z -]
Nodes

Primary Item Name

SuperTypes  gin:protectedresource, mix:referenceable, gtnic *

Property Definitions [jerprimaryType | [
[ app:creationdate |
[ app:laztmodificationdate ]
[ gtn:edit-permizsions |
[ gtn:description ]
[gtnname ]

[ gtn:access-permissions ] o8

2. Click Close to exit this form.

Add a node type

1. Open the Add/Edit Node Type Definitions form by clicking the Add button on the Manage
Node Type page.

Add/Edit Node Type Definitions [x

Mode Type Property Child Node

Mame Space -

Mode Type Name B

Is Mixin Type false -

Orderable Child  fajse -
Nodes

Primary Item Name
Super Types * @
Froperty Definitions

Child Node
Definitions

( Save ) ( Save as Draft ) ( Cancel )

2. Select a namespace for the node.

3. Enter a name in the Node Type Name field. This field is mandatory and its value must be
unigue.
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4. Select a value for the Is Mixin Type field.

e True: This node is Mixin type.
« False: This node is not Mixin type.

5. Select a value for the Orderable Child Nodes field.

¢ True: Child nodes are ordered.
 False: Child nodes are not ordered.
6. Enter a value for the Primary Item Name field.
7. Super Types: Click the plus icon to add more parent types.
8. Property Definitions: List all definition names of the Property tab.
9. Child Node Definitions: List all definition names of the Child Node tab.
10. Click Save to accept adding a new node type, or Save as Draft to save this node type as draft.

Export Node Types

1. Openthe Export Node Types form by clicking the Export button at the bottom of the Manage
Node Type page.

Export Node Types b4
socrelationshipdefinition i i
ntfolder v
exalinkable v
exo:trashFolder )
nt:childNodeDefinition )
exo:tagHome i
exo.answerHome )
exoarticle v
exo:portalFolder v
rma:destroyahle v

Export Cancel Uncheck all

2. Click Uncheck all if you do not want to export all node types. After clicking Uncheck all, this
button becomes the Check all button.

3. Select nodes that you want to export by ticking the checkboxes.
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4. Click the Export button in this form.

5. Select the location in your device to save the exported node.

Import Node Types

1. Openthelmport Node Type From XML File form by clicking the Import button at the bottom
of the Manage Node Type page.

Import Node Type From XML File %

File Name Browse
( Upload ) ( Cancel )

2. Click the Browse... button to upload a file.

3. Click the Upload button.

(]

4. Tick the checkboxes corresponding to the nodes that you want to import.

5. Click the Import button to complete importing a node type.
5.2.4. Advanced Configuration

5.2.4.1. Manage queries

The function enables you to manage queries. It allows adding, editing and deleting queries.
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Go to Advanced Configuration --> Manage Queries.

Manage Queries

Name Type Statement Permissions Actions

Jfelement(* exo:artide)
[not{@jcr:manTypes =
all artides xpath ‘exo:irestorelocation’]] order =:/platformfusers & B
by @exo:dateCreated
descending

/=[(@jcr:primaryType =
‘axo:article’ or
@jer:pimaryType = 'nt:file’)
and
Created Documents xpath @exoiowner="${Userld}$ =:/platform/users A |
and not{@jcr:mixinTypes =
‘exo:restorelocation’])] order
by @exo:dateCreated
descending

/felement(* exo:artidle)

[(@exo:dateCreated <

xs:dateTime('${Date}$")) and X
CreatedDocumentDayBefore xpath not{@jcr:mixinTypes = =:/platformfusers & 0

‘exo:restorelocation’)] order

by @exo:dateCreated

descending

Add.a new query

Add a new query

1. Openthe Add Query form by clicking the Add Query button in the Manage Queries page.

Add Query b 4
Query Name &
Query Type  xPath -
Satement |fig:root/Documents/Live//element(=, gxg:artide) )

m

Enable Cache |
Results -

2. Enter a query name into the Query Name field.

3. Select the query type from the drop-down Query Type menu.

« xpath (XML Path Language) is a language for selecting nodes. For example, /j cr: r oot /
Docunent s/ Li ve.

« SQL (Structured Query Language) is a database computer language.

4. Enter the statement for the query that must be unique.
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5. Check or uncheck the Enable Cache Results option. If you tick this checkbox, for the first
time you use this query to search, the result will be cached. For the second time you search
using this query, it will show the cached results. After 45 minutes, the cache will be removed.

For example, you have the query Test with statement//el enent (*, nt:file).Inthe File
Explorer, you have a nt : fi | e document named Fi | e1. When you execute the query Test,
only document Fi | el will be shown. After that, create a nt: fil e document named Fi | e2
and execute query Test , only document Fi | e2 document will be listed. After 45 minutes, the
cache will be removed. When you execute the query Test , the documents Fi | el and Fi | e2
will be listed.

Select permissions for a group that can use this query by clicking =

7. Click Save to finish adding a new query.

Edit a query

1. cClick ¢ corresponding to the query you want to edit. The Edit Query form will appear.
2. Edit the properties of the selected query.

3. Click Save to accept all changes.

Delete a query

1 Click I corresponding to the query you want to delete. A confirmation message will appear.

2. Click OK to accept deleting this query, or Cancel to discard this action.

5.2.4.2. Manage Scripts

The function enables users to manage all script codes in the eXo Platform and Browser Content
system.

Go to Advanced Configuration --> Manage Scripts.
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Manage Scripts

ECM Scripts
Select Category: getion hd
Name
AddMetadataScript.groovy

AddTaxonomyActionScript.groovy
AddToFavoriteSoript.groovy
AutoVersioningScript.groovy
EnableVersioningScript.groovy
GetMailScnipt.groovy
PopulateToHomePageMenu.groovy
ProcessRecordsScript.groovy
PublishingRequestScript.groovy

RS55cnpt.groovy

Add a new script in ECM

1. Click the Add button in the Manage Script page to open the Add/Edit Script form.

Path Base Version Actions
..ctionfAddMetadataScript.groovy

..AddTaxonomyActionScript.groovy

...ionfAddToFaveriteScript.groovy

..onfAutoVersioningScript.groovy

.../EnableVersioningScript.groovy

...erjaction/GetMailScript.groovy

.../PopulateToHomePageMenu.groovy

...on/ProcessRecordsScript.groovy

...PublishingRegquestScript.groovy

...plorer/action/R5S5cript.groovy

Total pages: 2

Add a new script | add

Add/Edit Script

Script Contents

Script Name B

Save Refresh Cancel

2. Enter a value for the Script Content field.

3. Enter a script name for the Script Name field.

« The script name must be unique

« The name must not contain special characters, such as !|,@,#,%$,%,&,%,(,).

4. Click Save to accept adding the new script.

*®

B 80 5 86 50 8 8 8 3 3
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Edit an ECM script

1. In the ECM Scripts tab, click ¢ corresponding to the script that you want to edit. The Add/
Edit script form will appear.

Add/Edit Script x

Script Contents |/= ~ B -
* Copyright {C) 2003-2007 eXg Platform SAS.

*This program is free software; you can redistribute it and/or

* modify it under the terms of the GNU Affero General Public License
* as published by the Free Software Foundation; either version 3

* of the License, or (at your option) any later version,

m

*This program is distributed in the hope that it will be useful,

* but WITHOUT ANY WARRANTY; without even the implied warranty of
*MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
* GNU General Public License for more details.

*You should have received a copy of the GNU General Public License
* along with this program; if not, see <http:/fwww.gnu.orgflicenses/=.
=

import java.ytil.Map;

m

import javax.jor.Session;
import jayax. jor.Node;

import org.exoplatform. services, gms. scripts. CmsSaipt

import org.gxoplatform. services. jor. Repositoryaervice;

import org.exoplatform. services. jor. core. ManageableRepository; -
import org.exoplatform. services. jor.ext.app. i i ice;

import org.exaplatform.services. jor. ext.common. SessionProvider;

is Enabled Version []

ScriptMame  AddMetadataScript.groovy &

Save Refresh Cancel

2. Edit the properties in this form.

3. Click Save to save all changes.

Delete an ECM script

Inthe ECM Scripts tab, click I on the script that you want to delete. A confirmation message
will appear.

2. Click OK to accept your deletion, or Cancel to discard this action.

5.2.4.3. Create an action type

This function allows you to manage all action nodes in the eXo Platform.

1. Select Advanced Configuration --> Create Action Type.
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Manage ECM Main Functions

Create Action Type

Categories & Tags Maximum Page Size: 10 v
ontent Presentation e Extends Action Type
exo:action [rt:base]

Content Types

exo:addMetadatalction [exo:action] [exo:scriptction] [nk:base]

Advanoed ConTauration exo:addToFavoriteAction [exo:action] [exo:scriptaction] [nt:base]

exo:autoVersioning [exo:action] [exo:scriptdction] [nt:base]
Manage Quenas exo:createRSSFeedAcdtion [exo:action] [exo:scriptaction] [nt:base]

i Manage Soripts exo:enableVersioning [exn:action] [exo:scriptAction] [nt:base]

exosfolkscnomyAtion [exa:action] [sxo:scripthction] [nt:base]

) Manage Locks exo:getMailaction [exo:action] [exo:scriptAction] [nt:base]
exo:populateToMenu [exo:action] [exo:scriptiction] [nk:base]
exo:processRecordaction [exo:action] [exo:scriptaction] [nt:base]

alpages: 2 # | ¢/ 1 |2 »
Add
Action Type x
Extend Action Type  exo:scriptAction -
MName {starts with *
"ex0)
is Action Move |:|

Execute  escm-explorer/action/RSSScript groovy -
Variables +

Save Cancel

3. Select the action type.
4. Input a name for the action.
5. Check/uncheck the is Action Move option. The action will have exo:move property or not.

6. Select an "execute" for the Execute field.

Click * next to Variables field to add more values for the action.

Click @ to delete a value.

8. Click Save to accept adding a new action type.

5.2.4.4. Manage locks

All locked nodes are listed and managed by administrators in the Content Administration page.
There are two ways that help administrators lock nodes: unlock nodes in the right-click menu in
Sites Explorer or unlock nodes in the Content Administration page.

Unlock a node

1. Select Advanced Configuration --> Manage Locks on the Manage ECM Main Functions
pane on the left. The locked nodes will be listed on the right pane.
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Manage ECM Main Functions Manage Locks

tegories & Tags Locked Node Manage Lock

Content Presentation Node Path User Lock Action
Content Types
Advanced Configuration

i’ Manage Quenes
Manage Scripts

45 Create Action Type

|y Manage Locks

2 In the Locked Node tab on the right pane, administrators can unlock nodes by clicking ='
corresponding to nodes which need to be unlocked. The unlocked nodes will disappear from
the locked nodes list.

Administrators can manage and add the unlock permission for another group and users in
the Manage Lock tab.

3. Select the group on the Select Group pane and the corresponding membership on the
Select Membership pane. The selected group will be listed in the Groups Or Users column.

However, administrators can also click * if you want to allow any users to unlock nodes.

|| Manage UnLocks

Locked Node Manage Lock

Groups Or Users Action

# fplatform fadministrators j
@ developers

Any Permission =+

Select Group Select Membership
» -
3 * member
= o, Development » author
- 4 Organization | + editor
. ' * manager
& s Plarform
v redactor
& Sandbox
LT v wvalidaror
+ - s Spaces '

4. In case you, as an administrator, want to remove the "Unlock" permission of groups, click

corresponding to the group to remove them form the "Unlock" permission list, except the
group *: / pl at f or mf adni ni strator and r oot .
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Next Steps

This user guide has provided a thorough explanation of features and terminologies within eXo
Platform. Now that you know how to create, manage and publish web content and administer
a website based on eXo Platform, you may have more questions or want to get involved. The
following links can connect you with resources to learn more and contribute to the open source
development process.

* Learn more about eXo Platform 3.0 [http://www.exoplatform.com/company/public/website/
platform]

» Video demos, tutorial and more in the eXo Resource Center [http://www.exoplatform.com/
company/public/website/resource-center]

« Access another eXo documents in the eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/
Main/WebHome/]

» Ask question about eXo Content in the Forum [http://forums.exoplatform.org/portal/public/
classic/forum]
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Appendix A. Revision History

Revision History
Revision 1-2.3 Wed Dec 15 2010

Exported company-specific content to separate files.

Revision 1-2.1.1 Fri Nov 19 2010
Updated docbook source to WCM 2.1.1
Revision 1-2.0 Mon Oct 25 2010

Completed docbook conversion.
Revision 1-0 Tue Sep 28 2010
Initial creation of book by publican

ScottMumford<snunf or d@ edhat .

ScottMumford<snunf or d@ edhat .

ScottMumford<snunf or d@ edhat
LauraBailey, TomWells,
EslpethThorne,

RebeccaNewton, JaredMorgan

ScottMumford<snunf or d@ edhat .
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